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Disclaimer:
1. The manufacturer and/or its agents take no responsibility for any
damage, financial loss or injury caused to any equipment, property or
persons resulting from the correct or incorrect use of the Inner Range
system and its peripherals. The purchaser assumes all responsibility in
the use of the Inner Range system and its peripherals.
2. Whilst every effort has been made to ensure the accuracy of this
manual, Inner Range Pty Ltd assumes no responsibility or liability for
any errors or omissions. Due to ongoing development the contents of
this manual are subject to change without notice.
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Protect Your Insight Professional Software Investment
with an Inner Range
Software Maintenance Agreement
For a modest annual fee you will receive:
•
•

Unlimited telephone and e-mail Customer Support by our Insight Help Desk.
Free software upgrade releases of Insight Professional for the software modules for
which you are licensed.
Get the most from your Insight Professional Security Management Software!

Complete and return the Application form contained in your Insight Professional pack or
download the form from:
http://www.innerrange.com/downloads/MaintenanceAgreement.pdf

Did you know that Inner Range operates customer training courses throughout Australia
and New Zealand?
Details of our Insight Professional System Administration courses are listed on our Training
Website at http://training.innerrange.com/index.cfm
Enrol on-line or contact Inner Range on (03) 9753 3488 or via email to:
admin@innerrange.com
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Getting Started Guide
This section gives you the minimum information needed to get Insight running quickly. For more
information, refer to the rest of the manual. Whilst using Insight, pressing the F1 key will open
electronic help.
You Will Need
1. A workstation with Windows 2000*, Windows 2000 Server*, Windows XP Pro, Windows
2003 Server, Windows Vista Business or Windows Vista Ultimate installed and
satisfying the minimum hardware requirements (Intel P4 2 GHz processor, 512 MB
RAM (1GB with Windows Vista), CD-ROM, 500 MB of free hard disk space [see note 3],
XVGA monitor at 1024x768 24-bit colour and Mouse or similar device).
2. A spare USB port on the Insight Server computer (not needed for Insight Lite).
3. Version 5 firmware upgrade kits for all version 4 panels you intend to manage with
Insight.
Notes:
1) By default, Insight uses the Microsoft SQL Express database engine, which
limits the database to 4 GB of data. Users upgrading from Insight 3.1 or earlier
may wish to upgrade to SQL Server, which is required where the review data
exceeds 4-5 million events per year. Contact the manufacturer for hardware
specifications when the recommended number of review events will be
exceeded.
2) Recommended hardware requirements: Intel Core 2 Duo (or quad core)
processor @2.4GHz, 3GB RAM, Gigabit Ethernet adapter, DVD Reader/Writer,
50GB of free hard disk space [see note 3], 22” WSXGA+ (1680 x 1050) monitor
24-bit colour and Mouse or similar device.
3) Whilst the installation itself only takes around 500MB of hard disk space, the
SQL Express database can grow to 4GB over time with the storage of your
panels’ review data. If up to 4 or 5 million Review events are expected over a
12 month period, SQL Express is required to host the Insight database, in
which case 5GB of free hard disk space is recommended. The 4GB database
will allow room for at least 6 million review events, but note that a moderate to
busy site could easily generate that number of events every year. For large /
busy sites, (more than 6 million review events per year) you may need to
purchase the full version of SQL Server 2005. To ease the CPU load on both
the SQL database and Insight Server, these can be located on separate
computers.
4) * Windows 2000 platforms are not recommended for new installations. Support
for these operating systems from Microsoft is being phased out and future
releases of Insight may not be able to support them.
Tip
Users upgrading from Insight V3.1 may wish to take advantage of the inclusion of SQL Express
2005 and upgrade their Insight database platform from MSDE SQL. Instructions for this are
found in Appendix B on page 157.
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Step 1: Install Insight Lite

- or -

1. Locate the Insight Lite install
program and open it.
2. Follow the on-screen prompts.
3. Click Finish.
4. Restart your computer if you
are asked to do so.

2

Step 1: Install Insight Professional
1. DO NOT plug in the USB security key
until you are instructed to do so.
2. Locate the Insight Professional install
program and open it.
3. Follow the on-screen prompts. Only
choose “Client and Server” on the
computer that will be the Insight
Server. For all other workstations,
choose “Client Only”. Be patient,
installation might seem to pause for
up to 5 minutes.
4. Click Finish.
5. Plug in the security key (server only).
6. Restart your computer if prompted.

Step 2 (Option 1): Enrolling a Version 4 Panel
If your panel is already version 5, skip to “Option 2: Enrolling a Version 5 Panel”. (You can
determine the version by pressing MENU-2 on any Elite terminal.) If you DON’T want to
preserve panel programming then perform steps 6 and 7 and then proceed to “Option 2:
Enrolling a Version 5 Panel”. If you DO want to preserve existing panel programming, then:

LK8

1. Configure a PCDirect comms task in the panel. SET THE
BAUD RATE TO 9600.
heat-sink
2. Start Insight Launch Pad (page 19), then click the Enrol
LK2
Panel icon.
3. Log in as installer (the default password is installer).
4. Enter the details of your panel (page 29). Make sure you
set the protocol to PCDirect.
RAM
5. Click Enrol Now. Insight reads the panel’s programming.
6. Upgrade your panel to the latest production firmware
Pin 1
version. (Must be version 5 or later) Detailed instructions
are available from Inner Range (document part number
635101; this document is included in the Insight
FLASH /
Professional box). Important: ensure jumpers LK8 and
EPROM
LK9 are set correctly as per the diagram. Don’t forget
to jumper LK2 according to your RAM size (top two pins
Pin 1
for 128k and 512k, bottom two pins for 32k).
7. Note the current Memory configuration in the panel (Use
MENU, 2 while logged off to view the “Ram:” details), then Default the panel from a
terminal (menu 7-5-2) using this memory configuration. i.e. The memory configuration
that was uploaded in step 5.
8. Use Insight Launch Pad to start Insight Edit (page 20).
9. Locate the panel in the Insight Toolbar (page 23).
10. Right-click the panel and choose “Use Insight comms task” in the menu that appears.
11. Tick the box that says “I have activated the Insight Comms Task in the Control Module”,
then click OK.
12. Right-click the panel, choose “Entire Panel” in the menu that appears, then choose
“Mark For Download”. The panel turns red, indicating there are records waiting to be
written to the panel.
13. Go to “Step 3: Connecting the Panel”.

LK9
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Step 2 (Option 2): Enrolling a Version 5 Panel
1.
2.
3.
4.
5.

Configure an Insight comms task in the panel (page 155). It must be comms task 1.
Start Insight Launch Pad (page 19), then click the Enrol Panels icon.
Log in as installer (the default password is installer).
Enter the details of your panel (page 28). Make sure the protocol is set to Insight.
Click Enrol Now.

3

Step 3: Connecting the Panel

4

Step 4: Make Programming Changes

5

Step 5: Examine Review

6
7
8

1. Make sure comms task 1 in the panel is configured as Insight and set to Active (page
155).
2. Use Insight Launch Pad to start Insight Edit (page 19).
3. Locate the panel in the Insight Toolbar (page 23).
4. Right-click the panel and choose “auto connect” (page 37). The panel icon turns green.
(If you upgraded from version 4 firmware and elected to preserve panel programming,
then the panel turns blue while Insight writes the information back to the panel). If you
cannot connect, refer to troubleshooting on page 30.
5. Set the panel date and time (page 39).
6. If you upgraded from version 4 or earlier firmware, you must update the panel
information. Right-click the panel and choose “Properties...”, then click on the “Update
Info” button at the bottom of the panel properties window.

1. You can make programming changes (including allocating cards to cardholders) with
Insight Edit (page 41). If you purchased Insight Card Pool, then you can issue cards via
Card Pool Manager (page 77).
2. If you make edits while the panel is not connected, the panel turns red in the Insight
Toolbar (page 46). Changes will be sent to the panel when it is next connected (page
37).

1. Review is automatically downloaded whenever a panel is connected (page 33), to see
the review use Insight Review (page 67).
2. To see review, open a new review window (page 85) and click the Go button (page 85).
3. The default filter shows review events that were generated in the last 24 hours. If you
forgot to set the panel date and time, no review will be visible. If you want to see all
review, change the filter to “All Review” (page 86), or select filters that suit your
requirements (page 86).
Step 6: Register Insight Professional
1. Insight Professional must be registered within 30 days of installation (page 111). Insight
Lite doesn’t require registration, but is only licenced for use by Certified Inner Range
technicians.

Step 7: Create Operators and Tenants
1. For Insight Professional installations, you can create operators with reduced privileges.
Normally, you would restrict editing rights to only configure cardholders and run review.
Operators are managed in Insight Operators (page 113).
2. For sites with multiple tenants, you assign operators and field hardware to different
tenancies. Tenancies are managed in Insight Operators (page 113).
Step 8: Further Reading
This concludes the Getting Started Guide. Refer to the following pages to unlock the power of
Insight in more detail. Don’t forget - pressing F1 will open context sensitive help at any time
within Insight. Thank you for using Insight!
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Introducing Insight
Insight consists of ten modules. Each module is a separate program that helps you manage an
aspect of your Inner Range installation. The ten modules are (in the order you will probably use
them):
Icon

s

Module

Description

Launch Pad

Launch Pad is a central springboard that lets you
quickly navigate to the other Insight modules.

Insight Edit

Insight Edit lets you inspect and modify the
programming of your Inner Range system, including
virtual panels.

Insight Review

Insight Review lets you examine live and archived
panel review, generate simple reports and manage
alarms.

Licence Manager

Licence Manager activates paid features (not required
for Insight Lite).

Card Pool

Card Pool lets you manage direct entry and site code
card pools. Requires separate licence.

Insight Operators

Insight Operators lets you manage access rights and
privileges of personnel who can logon to the Insight
front-end.

Insight Archiver (SQL)

Insight Archiver provides a one-click backup solution
for your Insight security database.

Advanced Reports

Advanced Reports lets you create complicated reports
including muster reports. Requires separate licence.

Insight Schematic

Insight Schematic allows operators to monitor the
status of an installation via graphical floor plans and
site maps.

Insight Photo ID

Insight Photo ID lets you design and print personnel ID
badges. Requires separate licence.

Paid Feature
Licence Manager, Insight Operators and Insight Schematic are part of Insight Professional.
Card Pool, Advanced Reports and Insight Photo ID are separately licenced modules.

Warning
Insight is compatible with version 5 panel firmware. You can enrol version 4 panels, but they
must be upgraded to version 5 after enrolment before they can be managed in Insight. For
upgrade procedure see page 12.
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Product Highlights
Connectivity
Insight is a true multi-panel, multi-workstation system.
Insight uses Octane™ compression for fast upload/download, even over slow links.
Supports direct serial, Ethernet and internal modem connections. Future releases will
add support for external modems.
Supports multiple paths with automatic switching to redundant paths on link failure.
Editing
Changes to module programming take effect immediately, without a LAN secure.
The LAN status of modules, zones and auxiliaries is displayed.
Selectively show or hide items based on:
o Name
o LAN status (secured, missing, unexpected, not installed)
o Programming status (blank, programmed, queued for upload/download)
You can have multiple forms open at the same time.
Single-click hyper-linking between forms (“help-9 / help-0” functionality).
On-line data comparison between the front-end database and any panel.
Automatic detection of edits made at any Elite Terminal.
Virtuality
Virtual users and virtual panels lets you share common users easily between multiple
panels.
Reports
Comprehensive reporting including muster reporting, time on site, activity reports and
system programming reports.
Fully flexible report designer enables creation of custom report layouts and content.
Management
Perform full or partial uploads and downloads.
Upload individual records.
Full support for offline editing.
Control
Remotely control areas, area lists, auxiliaries, auxiliary lists, doors, door lists, floors,
floor lists, home auxiliaries and zone inputs.
DVR Integration
Control DVRs and cameras including live digital video feeds and remote camera
control.
Online Help
Comprehensive context sensitive help. Press F1 for help on any screen!
Helpful tips are shown when each module starts. These can be turned off if required.

Registering Insight Professional
Insight Professional must be registered within 30 days of installation. See page 111 for more
information.
Tip
A searchable colour version of this manual is available in electronic form. Click Start→ All
®
Programs→ Insight→ Insight User Guide (requires free Adobe Reader software:
http://www.adobe.com).
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Insight Professional (Demo Edition)
Insight Professional is available in a demonstration edition. This version is identical to Insight
Professional, with five exceptions:
Operator passwords are bypassed.
Only the first five items of each type are visible (doors, areas, users, maps etc.)
You are logged off every two hours.
A different USB security key is used.
Licence Manager is not available.
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Launch Pad
Launch Pad is the “command centre” of Insight. It’s a module that lets you quickly navigate to all
other modules. When you close Launch Pad, it moves to the system tray for easy access (next
to your clock in the Windows task bar).
Launch pad also lets you specify key Insight settings such as when Operators need to log on.

Wallpaper

Launch Buttons
Tip Window

•
•
•

The launch buttons let you launch other modules with one button click.
The tip window provides information about each module. Point your mouse over a
launch button for a description of that module.
The wallpaper improves the aesthetics of Launch Pad. You can select from a library of
default wallpapers, or choose your own.

Starting Launch Pad
You can start launch pad in two different ways:
1. Click the start button and choose Programs → Inner Range → Insight → Insight
Launch Pad
2. When you start your computer, Launch Pad appears automatically in the system tray
(next to your computer clock). Click the icon.
Tip
If Launch Pad is running, you can access it from the system tray. Click the Insight icon to open
it. (On Windows XP, you may need to click the 3 button to display all icons.)

19

Launching a Module
You can start a module in one of four ways. Choose the one that is most
convenient for you.
1. Click the module icon with the mouse.
2. Right-click the launch pad icon in the system tray, and in the popup menu that appears click the name of the module you want to
launch.
3. In any module, click the Launch menu, and then click the module you want.
4. Hold down the control key, and then click the number key that corresponds to that
module. (See the Launch menu for the number assignment of each module.)
You may need to log in to the module with an operator name and password.
Tip
You can run multiple different modules simultaneously - you don’t have to quit a module before
starting another module. If a module is already open, then attempting to launch another copy
switches to the open module instead.

Logging In
You have to log on as an operator before you can use any module.
When you start a module, you are prompted to enter your operator
name and password.
1. Enter admin as the operator name.
2. Enter admin as the password.
3. Click Log On.
Tip
Insight ships with two default operators: admin and installer. You can edit these operators and
create new operators with the Operators module (professional version only).

Changing Launch Pad Preferences
You can customise aspects of Launch Pad.
1. On the Edit menu, click Preferences.
2. Make your changes.
3. Click Save or Apply.
The settings are:
•
•

Play Sounds: clear this check box if you do not want to hear a beep as the mouse
moves over a launch button.
Wallpaper: change the appearance of Launch Pad. Choose from a library of built-in
wallpapers, or choose your own. You can also fade the wallpaper to make it less
obtrusive.

Tip
Settings are saved per operator. If you log on to launch pad, your previously saved settings are
restored. When launch pad starts, no operator is logged in. You can still change preferences,
which will be restored the next time launch pad is started.
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Changing Client Settings
You can change Insight settings for your workstation. These
settings apply universally to all modules on the workstation.
1. On the Tools menu, click Insight Client Settings
2. Make your changes.
3. Click Save or Apply.
The settings are:
•

•
•

Server
o Server Address (not available in Lite):
specifies which computer is running the
Insight Database Server. If Insight is installed on a single computer, or if this
computer is the server in a multi-computer installation, then select “This
Computer”. If this computer is not the server in a multi-computer installation,
click “another computer” and enter the name or IP address of the server
computer.
Logging
o Specifies diagnostic logging options. Do not modify these settings unless
instructed by an Inner Range technician.
Client
o Client Options: tick this option if you want Launch Pad to appear whenever an
Insight module is closed.
o Password Caching: specifies when Operators must enter their password. If
caching is enabled, then Operators do not need to enter their name and
password until they quit a module, at which point the cache is cleared. If
caching is disabled, then Operators must enter their password every time a
module is started.

Tip
Press F1 at any time to get content sensitive help.
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The Insight Toolbar
The Insight Toolbar is the management centre of Insight. The toolbar is where you create and
manage sites, enrol panels, control field devices and perform panel programming and
maintenance. The Insight Toolbar is available in all modules.
Use the Insight Toolbar to:
•
•
•
•
•
•
•

Enrol panels
Connect and disconnect panels
Create master sites and sub-sites
Copy or move panels between sites
Import, export and duplicate panels
Perform selective upload and download
Remotely control hardware and modules

Master Site

Gripper

Panel

Sub-Sites
Site Tree

Tabs

•
•
•

The Site Tree displays all the sites and panels being managed by Insight.
The gripper lets you undock (float) the toolbar, move it around, or dock (anchor) it.
Use the tabs to select different modes of the Insight Toolbar (page 39).
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Working With Sites
When using Insight, you organise your panels into
collections called sites. A site is a “container” for adding
panels, virtual panels and DVRs. When you create a
site, you specify a name and some contact details.
Tip
Sites don’t have to correspond to actual, physical sites.
You may wish to have a new site per customer, or you
may want to group your panels by geographic area, or
you may choose to store all of your panels in one site.
Tip
When Insight is installed, it creates a single site called
“Default Site”. If you want, you can delete this site or rename it to something else.

¤

Previous Software
In PCDirect and WinDirect, sites are called clients. Sites are more powerful, because:
• One site can hold more than one panel.
• Sites can be contained within other sites, forming a ‘hierarchy’.
Master Sites and Sub-Sites
If a site is contained within another site, it is called a sub-site. Sites that are not contained by
other sites are called master sites.

s

Paid Feature
You cannot create sub-sites in Insight Lite.

To Create A New Master Site
1. Right click the blank white area below the bottom of the Sites Tree, and choose “New
Master Site…” in the menu that appears. (Tip: you may have to scroll to the bottom of
the Site Tree to find the blank area.)
2. Enter a unique name for the site.
3. Click OK.
To Create A New Sub-Site (licenced versions)
1. Right click an existing site and choose “New Sub-Site…” in the menu that appears.
2. Enter a unique name for the site.
3. Click OK.
Operator Permissions
To create a new master site, you must have the create permission for sites. To create a new
sub-site, you must have the create permission for sites and the change permission on the
parent site.
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To Edit Or Rename An Existing Site
1. Right click the site and choose “Properties…” in the menu that appears.
2. Edit the details of the site.
3. Click OK.
Operator Permissions
To edit or rename a site, you must have the change permission on that site.

To Move A Sub-Site (paid versions)
1. Click the site you want to move, and keep the mouse button down.
2. Drag the site into its new location.
3. Release the mouse button
Panels are moved with the site.
Operator Permissions
To move a sub-site, you must have delete permission on the site being moved and change
permission on both the old and new parent sites.
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Working With Panels
You cannot work with a panel until it has been created in Insight. There are three methods of
creating panels:
1. Enrolling: this is the normal method. The panel is physically connected, and is fully
uploaded into Insight.
2. Importing: with this method, the operator specifies a template file that is loaded into
Insight. The panel is connected later on for full or partial download from the template.
3. Copying: the programming of an existing panel can be duplicated, creating a new
panel. The programming of the new panel can then be fully or partially downloaded later
on.
Tip
Insight ships with a number of “empty panel” templates, including Standard, Enlarged, Access,
Access 2, Alarms, Apartments, Extra Door and Special. You can use these templates as a basis
for panel programming without enrolling an empty panel.
Note
Panel connections are always made through Insight Server. For direct serial connections, the
panel must be connected to the server computer. For dial-up connections, the PC modem must
be connected to the server computer.

s

Paid Feature
By default, you can only manage one panel with Insight Professional . If you want to manage
multiple panels with Insight Professional, you must purchase a multi-panel licence.

Enrolling Panels
Enrolling a panel makes the panel available in Insight, and
also uploads (reads) all of the existing programming and
users from the panel. To upload a panel:
•
•
•

The panel must be powered on.
Insight must be able to communicate with the panel
(via direct serial, dial-up or TCP/IP).
A comms task must be configured in the appropriate
format. For PCDirect, consult your programming
manual. For Insight, see page 155.

To enrol a panel:
1. In the Insight Toolbar, decide which site will contain
the panel. If necessary, create a new master site or
sub-site.
2. Right click on the site that will contain the panel, and choose “Enrol Panel…” in the
menu that appears.
3. The Enrol Panel window appears. Enter the correct information for the panel being
enrolled (see following pages).
4. Click the Enrol Now button. A new window appears, showing enrolment progress.
Note
Some of the settings on the enrolment screen must match the equivalent settings in Insight, or
enrolment will fail. For your convenience, these fields are marked with a small Control Module
icon ( ) in Insight. Double-check that these settings match the settings in the panel.
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Note
You can only enrol panels from the Insight Server computer. You cannot enrol panels from an
Insight Client computer.

Operator Permissions
To enrol a panel, you must have the create permission for panels and the change permission
on the containing site. The permissions for the new panel are copied from the defaults tab of
each Operator Type.

¤

Previous Software
Uploading a panel in WinDirect and PCDirect was a very time consuming task. Insight uses
Octane™ compression to upload the panel many times faster. Depending on panel contents
and transfer conditions, Insight can upload up to 600% faster than PCDirect / WinDirect.

If you are enrolling a version 5 panel:
Name:
Panel ID:

Serial Number:

IP Door Controller:
Add To Site:

Enter the 8 digit panel identification number. This number
must match the panel ID specified in the Insight comms
task.
Enter the panel serial number (press MENU-2 on any
terminal). You must enter the number exactly as it appears,
including leading zeros.
Tick this box if you are enrolling an IP Door Controller.
Shows the site that will contain the newly enrolled panel.

Encryption Key:

Enter the encryption key for this panel (exactly 32 digits).
This number must match the Insight A & Insight B fields
specified in the Insight comms task. Leaving this field blank
is equivalent to selecting all zeros.

Connection:

Specify the connection method you will use to enrol the
panel.
• Ethernet→Panel Ethernet UART: select this option
if you wish to use your computer’s TCP/IP network
and/or the Internet, and the panel is fitted with a
TCP/IP Ethernet UART board.

Settings:

Panel Server:
Protocol:
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Enter a name for the panel.

•

Serial Port→Panel UART: select this option if you
are using a direct serial connection between Insight
Server and the panel, or if you are using a serial to
TCP/IP protocol converter (e.g. Lantronix).

•

PC Modem→Panel External Modem: choose this
option if you wish to use a modem on the Insight
Server computer to dial an external modem on the
panel.

•

PC Modem→Panel Internal Modem: choose this
option if you wish to use a modem on the Insight
Server computer to dial the internal modem on the
panel.

Specify any additional connection parameters here.
Settings such as baud rate and IP address must match
those of the panel.
Do not change this setting from ‘LOCAL’.
Set this to Insight. Make sure comms task 1 is configured

as Insight (page 155).
Installer PIN:

This field is disabled when you select the Insight protocol.

If you are enrolling a version 4 panel:
Name:
Panel ID:

Serial Number:

IP Door Controller:
Add To Site:
Encryption Key:

Connection:

Settings:
Panel Server:
Protocol:
Installer PIN:

Enter a name for the panel.
Enter a unique, non-zero number in this field. The first two
digits should be 00. Later on, when the panel is upgraded to
version 5, you must configure the Insight comms task with
this value.
Enter the panel serial number (press MENU-2 on any
terminal). You must enter the number exactly as it appears,
including leading zeros.
Leave this field un-ticked.
Shows the site that will contain the newly enrolled panel.
Enter the encryption key for this panel (exactly 32 digits).
Later on, when the panel is upgraded to version 5, you
must configure the Insight comms task with this value.
Leaving this field blank is equivalent to selecting all zeros.
Specify the connection method you will use to enrol the
panel.
• Ethernet→Panel Ethernet UART: you cannot select
this option when enrolling a version 4 panel.
•

Serial Port→Panel UART: select this option if you
are using a direct serial connection between Insight
Server and the panel, or if you are using a serial to
TCP/IP protocol converter (e.g. Lantronix).

•

PC Modem→Panel External Modem: choose this
option if you wish to use a modem on the Insight
Server computer to dial an external modem on the
panel.

•

PC Modem→Panel Internal Modem: choose this
option if you wish to use a modem on the Insight
Server computer to dial an internal modem on the
panel.

Specify any additional connection parameters here.
Settings such as baud rate must match those of the panel.
Do not change this setting from ‘LOCAL’.
Set this to PCDirect. Make sure there is a PCDirect comms
task configured in the panel.
The PIN number of User 1 in the panel.

Warning
Although you can enrol version 4 panels, you cannot manage them with Insight until they are
upgraded to version 5. See page 12.

29

#

Troubleshooting
If you receive a message to say that the upload failed, review the following checklists.
If you are using the Insight protocol to enrol the panel:
•

•
•
•
•
•
•
•
•
•
•

If you upgraded the panel from version 4:
o Was your firmware upgrade successful? (Press MENU-2 on any Elite Terminal,
and confirm that the version is 5.xx)
o Did you remember to default the panel?
The Insight comms task must be Comms Task 1.
Check the configuration of your Insight comms task matches with the Insight software:
o Panel ID (which must be unique and non-zero)
o Connection method and parameters (including baud rate etc.)
Check you have entered the panel serial number correctly (including leading zeros)
If you’re enrolling an IP Door Controller, make sure you ticked the IP Door Controller
option. If you’re enrolling a regular Control Module, leave the option cleared.
If you are using Serial Port → Panel UART, make sure you have specified the correct
serial port on your PC, and that no other programs are using this port.
If you are using Serial Port → Panel UART, and you are using a USB serial port, try
using a legacy (physical) serial port, if possible.
Make sure you have given Insight the correct protocol information. In particular, check
that:
o The protocol is set to ‘Insight’.
Make sure the other Insight options are correct (page 155).
Try stopping and starting the Insight comms task.
Try restarting your computer.

If you are using the PCDirect protocol to enrol the panel:
•
•

•
•
•
•
•
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Make sure your panel ID is unique. Even though PCDirect doesn’t use it, Insight still
checks this number because it will be used later on.
Make sure you have given Insight the correct protocol information. In particular, check
that:
o The protocol is set to ‘PCDirect’.
o You have entered the correct installer PIN.
Check the configuration of your PCDirect comms task matches with the Insight
software:
o Connection method and parameters (including baud rate etc.)
If you are using Serial Port → Panel UART, make sure you have specified the correct
serial port on your PC, and that no other programs are using this port.
If you are using Serial Port → Panel UART, and you are using a USB serial port, try
using a legacy (physical) serial port, if possible.
Try stopping and starting the PCDirect comms task.
Try restarting your computer.

Creating Panels From Templates
You can create a panel from a template. Templates can be
blank panel configurations from Inner Range, or any panel
that you’ve exported previously. Once you’ve created the new
panel you can download it into a physical panel at a later date.
To create a panel from a template:
1. In the Insight Toolbar, decide which site will contain
the panel. If necessary, create a new master site or
sub-site.
2. Right click on the site that will contain the panel, and
choose “New Panel From Template…” in the menu that appears.
3. The Create New Panel window appears. Enter the correct information for the panel
being created.
4. Click OK.
A progress window appears while the panel is being imported.
Note
The new panel will be created with the name, ID and serial number you specify. After creating
the panel, you must manually set up protocol parameters and connection paths. In the Insight
Toolbar, right click the new panel and select “Properties…” from the menu that appears, then
click the Protocol and Ports tabs.
Tip
Insight ships with a number of “empty panel” templates, including Standard, Enlarged, Access,
Access 2, Alarms, Apartments, Extra Door and Special. You can use these templates as a basis
for panel programming without enrolling an empty panel.
Operator Permissions
To import a panel, you must have the create permission for panels and the change permission
on the containing site. The permissions for the new panel are copied from the defaults tab of
each Operator Type.

Field Descriptions:
File Name:
IP Door Controller:
Panel Name:

Click the ... button and navigate to the template file you
wish to import.
Tick this option if you will be connecting to an IP Door
Controller instead of a regular Control Module.
Enter a name for the new panel.

Panel ID:

Enter the panel identification number. This number must
match the panel ID specified in the Insight comms task. If
you do not know the panel ID (for example, the panel has
not yet been delivered), enter any unique number here, and
change it later on.

Serial Number:

Enter the panel serial number (press MENU-2 on any
terminal). You must enter the number exactly as it appears,
including leading zeros. If you do not know the panel serial
number, enter any number here, then change it later on.
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Duplicating Panels
You can duplicate a panel that you have already enrolled, and
then download the duplicate panel into a physical panel at a
later date.
To duplicate a panel:
1. In the Insight Toolbar, decide which site will contain
the duplicate panel. If necessary, create a new master
site or sub-site.
2. Hold down the Control key on the keyboard.
3. Click on the panel you want to duplicate, but do not release the mouse button.
4. Drag the panel onto the site that will contain the duplicate. A plus sign appears.
5. Release the mouse button. (You can release the Control key as well.)
6. The Copy Panel window appears. Enter the correct information for the panel being
created.
7. Click OK.
The new panel is created.
Note
The new panel will be created with the name, ID and serial number you specify. After creating
the panel, you must manually set up protocol parameters and connection paths. In the Insight
Toolbar, right click the new panel and select “Properties…” from the menu that appears, then
click the Protocol and Ports tabs.
Operator Permissions
To duplicate a panel, you must have the create permission for panels, the inspect permission
on the panel being copied, and the change permission on the site that will contain the copy.

Field Descriptions:
Panel Name:
Panel ID:

Serial Number:

Enter a name for the duplicate panel.
Enter the panel identification number. This number must
match the panel ID specified in the Insight comms task. If
you do not know the panel ID (for example, the panel has not
yet been delivered), enter any unique number here, and
change it later on.
Enter the panel serial number (press MENU-2 on any
terminal). You must enter the number exactly as it appears,
including leading zeros. If you do not know the panel serial
number, enter any number here, then change it later on.

Moving Panels
You can move a panel from one site to another site.
To move a panel:
1. In the Insight Toolbar, decide which site you want to move the panel to. If necessary,
create a new site.
2. Click on the panel you want to move, but do not release the mouse button.
3. Drag the panel onto the site you want to move it into. A special icon appears.
4. Release the mouse button. The panel is moved.
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Panel Connections
For communications to occur between a panel and Insight, it must be connected. Connections
occur over a configured connection path. Insight supports a number of different connection
paths. The following table is ranked in order of reliability and lowest line cost, best option first.
Path
Ethernet
Serial
1
Serial
Dial-up
Dial-up
GSM
1

Panel Hardware
Panel Ethernet UART
Panel UART
Panel UART→converter2→Ethernet
External modem
Internal modem
Panel UART→FE3000

Insight Hardware
TCP/IP
Serial port
TCP/IP
Modem
Modem
TCP/IP

Part of the link is Ethernet, however the end-to-end protocol is serial.

Suitable For
Permanent connections
Permanent connections
Permanent connections
Non-permanent
Non-permanent
Non-permanent
2

e.g. Lantronix

When a panel is not connected, you can do the following:
•
•
•
•
•
•

Make offline edits to panel programming with Insight Edit, which will be downloaded to
the panel later.
Manage card pools with Insight Card Pool (requires separate licence).
View archived review data with Insight Review or Insight Advanced Reports (requires
separate licence).
Generate reports on archived data with Insight Review (professional edition)
Backup your entire Insight database with Insight Archiver SQL (professional edition) or
Insight Archiver (lite edition)
Create and manage operators with Insight Operators (professional edition)

When a panel is connected, you can perform the following additional actions:
•
•
•
•
•
•
•
•

Transmit changes to panel programming (including user cards and PINs)
Control field equipment (such as doors, zone inputs and auxiliaries)
View live security logs (review) from the panel
Receive alarms (professional edition)
Monitor field equipment status with Insight Schematic (professional edition)
Update panel info in Insight.
Update LAN status in Insight.
Set the panel time.

Tip
A summary of panel connections is shown in the status bar at the bottom right of most Insight
modules. If no panels are connected, a blinking red square is shown.
Yellow means some panels are connected, and green means all panels are connected. Click
the red square to stop it flashing.
To configure an Ethernet connection:
1. In the panel, configure CT001 as Insight (page 155). Ensure Ethernet options are
configured including Insight IP, Panel IP, Router IP and Subnet Mask. Ensure Ethernet
options are set to ACE.
2. In Insight, right click the panel in the Insight Toolbar and choose “Properties…” in the
menu that appears.
3. Click Ports.
4. On the Ports tab, tick the TCP/IP option.
5. Click OK.
Note
This information applies to a panel with an Ethernet UART. If you are using a protocol converter
(such as Lantronix), configure a serial connection, then consult the documentation that came
with your converter.
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To configure a serial connection:
1. In the panel, configure CT001 as Insight (page 155). Ensure serial options are
configured including panel UART port and baud rate. Ensure serial options are set to
ACE.
2. In Insight, right click the panel in the Insight Toolbar and choose “Properties…” in the
menu that appears.
3. Click Ports.
4. On the Ports tab, tick the Direct Serial option.
5. On the Serial tab, set the PC serial port and baud rate. The baud rate must match the
baud rate you programmed in step 1.
6. Click OK.

To configure a dial-up connection:
1. In the panel, configure CT001 as Insight (page 155). Ensure serial options are
configured including panel UART port and baud rate. Ensure internal modem options
are set to ACE.
2. In the panel, configure CT002 as I-modem (page 156).
3. In Insight, right click the panel in the Insight Toolbar and choose “Properties…” in the
menu that appears.
4. Click Ports.
5. On the Ports tab, tick the Internal Modem option.
6. On the Internal Modem tab, set the dial-up number.
7. If you are using fax bypass, tick the fax bypass option.
8. Click OK.
Tip
In timed fax bypass mode, Insight calls the panel, hangs up after 2 rings, then re-dials the panel
60 seconds later. You must activate the timed fax bypass mode in the panel – see the callout
box on page 156.

Permanent Connections
If your panel is wired for Ethernet or direct serial connections, then you will generally want to
leave it permanently connected. Insight can be configured to always keep a connection open on
one of these paths – this is known as a permanent panel connection. On the other hand, for
dial-up connections, you generally want to choose when the panel is connected manually. This
is called a non-permanent connection.
To set up a panel to be permanently connected:
1. In the Insight comms task for the panel, ensure that Ethernet and/or direct serial paths
are configured and enabled.
2. In Insight, ensure that Ethernet and/or direct serial paths are configured and enabled
(pp. 33-34).
3. Right click the panel in the Insight Toolbar, and choose “Properties…” in the menu that
appears.
4. Click Protocol.
5. Select the Connection tab.
6. Select the Permanent Connection radio button.
7. Click OK. Insight will attempt to keep the panel connected via Ethernet or direct serial.
(Insight will not attempt to dial the panel if these paths are unavailable.)
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To set up a panel so that connections are managed manually by operators:
1. Right click the panel in the Insight Toolbar, and choose “Properties…” in the menu that
appears.
2. Click Protocol.
3. Select the Connection tab.
4. Select the Non-Permanent Connection radio button.
5. Click OK.
Panel Initiated Connections
You can configure your panel to automatically connect to Insight Server via dial-up if an alarm
occurs. The panel will connect in these circumstances:
1. An XMIT event occurs.
2. There is an IMODEM comms task configured in the panel with outgoing connections
enabled (page 156).
3. There is at least one Insight modem configured to receive incoming calls (page 38).
Scheduled Connections (Insight 3.2 or later)
You can configure Insight to automatically connect to a
panel on a periodic basis. The panel must be configured
for manual connections (see top of page) and a dial-up
connection must be configured (page 34). The
connection will be maintained until a condition you
specify is satisfied, such as all review being received.
Scheduled connections are configured independently for
each panel.
To schedule automatic connection:
1. In the Insight toolbar, right-click the panel you
want to configure and choose “Schedule Connection” in the menu that appears.
2. Tick the Schedule Panel Synchronisation check box.
3. Specify how often to connect, and on which days and at what time to establish the
connection.
4. Specify the connection duration. The options are:
Maximum Minutes. The connection will be maintained for the number of minutes you
specify.
Until Synchronised. Insight only connects to the panel if records are marked for
upload/download. Upon connection, Insight maintains communication with the panel
until the panel and Insight are synchronised.
Until No Review Received. The connection will be maintained until all review has been
downloaded from the panel.
Tip
If you want the connection to be maintained until you manually disconnect, set the Connection
Duration to “Maximum Minutes” then enter 0 in the minutes field.

Note
If Insight can’t establish a connection with the panel, it will retry periodically for the next twelve
hours.
Note
The ‘Until Synchronised’ connection duration should only be chosen if Insight is the sole means
panel programming is changed and if there is no requirement to retrieve new review data.
35

Operator Permissions
To configure connection scheduling, you must have the control permission for the panel.

Understanding Connection Status
The status of the panel is displayed graphically in the Insight Toolbar. Refer to the following
table:
Icon

Path

Status

Description

TCP/IP
Serial
Ext. modem
Int. modem

Disconnected

The panel is not connected. Programming changes
will be queued. Status information and live review
is not available. Hardware cannot be controlled.

TCP/IP
Serial
Ext. modem
Int. modem

Connected

The panel is connected. Live and queued
programming changes will be transmitted (provided
the panel isn’t locked – see page 47). Review and
status information is available. Hardware can be
controlled.

TCP/IP
Serial
Ext. modem
Int. modem

Connection error

The connection could not be established, or has
been lost. See ‘troubleshooting’ on page 30.

Tip
Connections can take up to twenty seconds to establish. While Insight is negotiating the
connection, the panel icon changes to .

Note
When a panel becomes connected, the following operations are performed automatically:
refresh LAN status (page 43), check for terminal edits (page 48), check memory configuration
(page 64), download review (page 84).
Tip
You can get more information about the current connection status of a panel. Right click the
panel and choose “properties” in the menu that appears, then click the “status” icon.

Tip
To get a quick overview of the status of all panels in an installation, click the status tab of the
Insight Toolbar. It lists all panels in a flat hierarchy, with all sub-sites removed from the tree.
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Manual Connections
You can manually connect a panel in Insight. Use this option to connect to a dial-up panel, or if
you have configured a panel to be non-permanently connected.
To connect a panel:
1. Right-click the panel in the Insight Toolbar, and choose “Auto
Connect” in the menu that appears.
Insight establishes a connection with the panel. The connection icon
turns green with a tick upon success, or red with a cross if the
connection could not be established.

Note
The connection will remain active, even if you close all Insight modules. The connection will only
be broken if you choose to disconnect, or if the Insight Server is stopped.

Tip
If the panel is configured with multiple connection types (for example, direct serial and dial-up),
Insight tries the ‘best’ path first. Insight always tries to connect in this order: TCP/IP, direct
serial, dial-up to external panel modem, dial-up to internal panel modem, GSM. Only configured
paths are tried – see page 39.
Tip
If you don’t want to use “auto connect” you can manually specify a connection method. After
right-clicking the panel, choose “connect” in the menu that appears, then specify the connection
method to try. You can only select paths that have been configured for that panel.
Operator Permissions
To connect to a panel, you must have the control permission for the panel.

To disconnect a panel:
1. Right-click the panel in the Insight Toolbar, and choose “Disconnect”.

Note
If you disconnect a panel and it is configured for permanent connection, Insight will immediately
attempt to reconnect with the panel. You should configure the panel with a non-permanent
connection first. See page 35.

Operator Permissions
To disconnect a panel, you must have the control permission for the panel.
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Modem Blocking
If you have multiple modems, you can choose which
modems can be used by Insight.
To prevent Insight from using a modem:
1. On the Insight Server computer, right click the
Insight Server tool in the system tray, and choose
“Settings→Modems…” in the menu that appears.
(On Windows XP, you may need to click the 3
button to display all icons.)
2. Select the modem you want to block.
3. Click the Disable button. Insight will not make or receive calls using that modem.

To allow Insight to use a modem for outgoing calls only:
1. On the Insight Server computer, right click the Insight Server tool in the system tray,
and choose “Settings→Modems…” in the menu that appears.
2. Select the modem you want to make available for outgoing calls.
3. Click the Enable button. Insight will use the modem for outgoing calls. Insight will not
receive calls using the modem.

To allow Insight to use a modem for receiving incoming calls only:
1. On the Insight Server computer, right click the Insight Server tool in the system tray,
and choose “Settings→Modems…” in the menu that appears.
2. Select the modem you want to make available for incoming calls.
3. Click the Listen button. Insight will receive incoming calls using the modem. Insight will
not use the modem for outgoing calls.
Note
You cannot configure a single modem for both incoming and outgoing calls. If you want to make
and receive calls, you will need two different modems.

Panel Properties
You can find out further information about
your panel by opening the panel properties
window. From here you can rename the
panel, change Insight protocol settings,
configure communications ports, set the
panel date and time, perform directory
maintenance and inspect other panel
properties such as firmware version and
PCB revision.
To open panel properties:
1. Right-click the panel in the Insight
Toolbar, and choose “Properties…” in the window that appears.
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To change protocol settings:
1. Open panel properties and click the “Protocol” icon.
2. Fields marked with a Control Module icon must match the corresponding settings in the
Insight comms task.
3. Click OK.
Tip
You can configure Insight to connect panels automatically under certain conditions. Open panel
properties, click the “Protocol” icon then click the Connection tab.

To change port settings:
1. Open panel properties and click the “Ports” icon.
2. Fields marked with a Control Module icon must match the corresponding settings in the
Insight comms task.
3. Click OK.
Tip
You can configure multiple paths (such as direct serial and dial-up) so that if one path fails,
additional paths can be tried.

To set the panel date and time:
1. Open panel properties and click the “Maintenance” icon.
2. Click the Date/Time button. (Panel must be online to enable this button)
3. To synchronise the panel time with the time on the workstation you are using, click the
“PC Time” button. To set the date and time manually, highlight each digit and click the
up and down buttons.
4. Click OK.
Note
The panel must be connected before you can set the date or time. If the panel is not connected,
the button is disabled.

Warning
Changing the panel date and time causes all time zones, diaries and holidays to be reevaluated, which in turn could alter the state of auxiliaries, calculated auxiliaries and other
system entities.
To automatically synchronise the panel date and time with Insight Server:
1.
2.
3.
4.
5.

Open panel properties and click the “Maintenance” icon.
Click the Schedule button.
Tick the “Schedule Panel Time Synchronisation” box.
Specify how often you wish to synchronise the panel with Insight Server.
Click OK.

Note
When synchronising, the panel date and time is changed to match the date and time of Insight
Server.

Note
For synchronisation to occur, Insight server must be running.
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Remote Control Field Hardware
You can control your Inner Range security system
remotely using Insight. You can control areas, area lists,
auxiliaries, auxiliary lists, doors, door lists, floors, floor
lists, home auxiliaries and inputs.
To control items remotely:
1. Click the Control tab of the Insight Toolbar.
2. Click the item type you want to control
3. A window appears containing the items of that
type, and after a moment the current state is
displayed.
4. Highlight the item(s) you want to control.
5. Click the appropriate control button to control the item.
Tip
You can select multiple items by holding down the SHIFT or CONTROL keys whilst clicking.

Tip
If an item changes state, the change will be reflected in the control window within five seconds.

Tip
The Insight Toolbar doesn’t have a Control tab in Insight Schematic. To control items in
Schematic, right click the item directly on the map and choose from the menu that appears.

Tip
You can control DVRs and cameras using Insight. See page 141.

Operator Permissions
To control an item you must have the control permission for that item.
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Insight Edit
Insight Edit lets you inspect and modify the programming of your Inner Range security system.
This includes initial configuration of all security parameters during site commissioning,
inspection and modification of programming as time progresses and ongoing site management
functions such as allocating user cards and PINs.
Use Insight Edit to:
•
•
•
•
•

Inspect panel programming
Program panels and modules
Manage user cards and PINs
Import extended user programming
Program virtual panels and virtual users
Browse Toolbar
Text Filter

Status Filters
= installed
= missing
= unexpected
= not installed

Insight Toolbar

= upload marker
= download marker

Double-Click
To Edit

•
•

Browse Pane

The Insight Toolbar lets you manage your sites and panels (page 23).
The browse pane displays items you can program (page 42).

Note
The following sections deal with panel programming. You can only program panels that have
been enrolled into Insight. To learn how to enrol panels, see ‘enrolling panels’ on page 27.
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Using the Browser
The most important part of Insight Edit is the browser pane. Once you have mastered the use of
this pane you can quickly and easily make programming changes to your panels.
Text Filter

Programmed Item (solid)

Status Filters

= upload marker
= download marker

= installed/secured
= missing/not responding
= unexpected/unsecured
= not installed

Unprogrammed Item (translucent)

Item Count

Navigation
The browser pane is driven from the Insight Toolbar. To program a particular item:
1. In the Insight Toolbar, click the browse tab.
2. Expand the tree for the panel you wish to program.
3. Click on the programming item you want.
Tip
You can change the layout of the Insight Toolbar by selecting “Preferences…” on the Edit menu,
then clicking the Interface tab. Installers who are used to the terminal menus will probably want
to use the “installer” layout.
Tip
By default, the browser pane is set to large icon view (pictured). You can
select different views with the Browse Toolbar. In particular, ‘detail’ view
allows you to sort the information by clicking on the column headings.
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Understanding Item Status
Various graphics and symbols are used in the browser to reflect the status of each programming
item.
Symbol

Applies To

Meaning

Description

All items

Programmed

Items that are ‘solid’ have been programmed.

All items

Blank

Items that are translucent are blank / have not
been programmed.

All items

Upload

This item has been marked for upload. The next
time the panel is connected, the item will be read
from the panel.

All items

Download

This item has been queued for download. The
next time the panel is connected, the item will be
written to the panel.

Hardware items

Secured

The module is present on the LAN and secured.

Hardware items

Unexpected

The module is present on the LAN, but not
secured.

Hardware items

Missing

The module should be on the LAN but isn’t.

Hardware items

Uninstalled

The module isn’t on the LAN.

All items

Shadow

This record has been created because the panel
memory configuration has changed, and there are
more items of this type than before.

All items

Surplus

The panel memory configuration has changed,
and this record no longer fits into the new
configuration.

Tip
The status of hardware modules (secured, missing etc.) is updated each time you connect with
a panel. You can also update this status manually. Right-click the panel in the Insight Toolbar
and choose “Entire Panel” in the menu that appears, then choose “refresh LAN status”.
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Using Filters
You can filter the browser so that only key items are displayed. There are a number of different
filtering methods available.
Using Filter Buttons
You can quickly show and hide items with the filter buttons.
Click show programmed to hide or show programmed items
Click show blank to hide or show blank / unprogrammed items
Click show normal to hide or show records that aren’t surplus, shadow or marked
Click show upload to hide or show items marked for upload from the panel
Click show download to hide or show items marked for download to the panel
Click show surplus to hide or show surplus records
Click show shadow to hide or show shadow records
Click installed to hide or show secured hardware
Click missing to hide or show missing hardware
Click unexpected to hide or show unexpected hardware
Click not installed to hide or show uninstalled hardware
To use the filter buttons:
1. Click the appropriate filter button. If the button is active (pressed in), then items
matching that type will be displayed.
Note
Filters are saved for each different item type, even when you exit Insight Edit. Always check the
item count (bottom right corner) to see if there are any items hidden in the current view.

Using Filter Text
You can filter based on text that you specify. Text filtering can be applied to the short or long
name, address or notes field of regular items, and also the site code, user type and extended
information fields of users.
To use filter text:
1. Select the field you want to filter on. “Name in panel” is the short name of the item.
“Name” is the full-length Insight name. “Address” is the notated address (such as DL015
for door list 15). ‘Notes’ is the notes field kept by Insight for each item.
2. Enter the text you want to filter by.
3. Press enter. Your filter is applied.
Using Wildcards
You can use special symbols called “wild cards” in your text filters. The ? symbol matches one
letter. The * symbol matches any number of letters.
Here are some example filters to get you started.
Field
Name
Notes
Address
Address
Address
Address
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Text
PIR
delay
C01
T03:Z05
T03:Z*
T*:Z*

Description
Only show items whose name includes the word “PIR”
Only show items whose notes includes the word “delay”
Only show control module items
Show the fifth zone input on the third LCD module
Show all zone inputs on the third LCD module
Show all zone inputs on all LCD modules

Address
Address
Address
Name
Name

*:Z*
?01:Z10
*:S?5
k*
*s

Show all zone inputs on all modules
Show the tenth zone input on the first module of each type
Shows all system inputs ending in “5” on every module
Shows all names starting with the letter K
Shows all names ending in the letter S

Editing Items
To edit an item, double click the item in the browser. This opens an edit window for that item.

Edit Toolbar
Navigation
Toolbar

Tabs

Name Lock
Slider
Hyperlink

Item Pickers

Using the Navigation Toolbar
Locate this item in the Insight Toolbar tree.
Go to the first record.
Go to the previous record.
Displays the current record number. You can enter a different number to jump to that
number.
Displays the name of the current record. Click on the arrow to select a different record
to jump to.
Go to the next record.
Go to the next blank / unprogrammed record.
Go to the last record.
Using the Edit Toolbar
Save changes to the current record. If the panel is offline, mark the record for
download the next time a connection is available.
Turn autosave on or off. With autosave enabled, changes to a record are saved
automatically as soon as the record is closed or you use the navigation buttons.
Discard changes you’ve made to this record without saving them. The record reverts
to the last saved version.
Erase the programming of this record. The record becomes blank / unprogrammed.
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Upload the current record from the panel. If the panel isn’t connected, the record is
marked for upload the next time a connection is available.
Places the current record into the Windows clipboard. When you select paste, the
original record is then made blank / unprogrammed.
Copies the current record into the Windows clipboard.
Pastes from the Windows clipboard over the current record.
Undo the last action. You can repeat this command to undo all changes made since
the record was opened.
Opens the find window.
Opens the cross-reference window for this item.
Opens context-sensitive help for this item.
Tip
If you are editing a lot of records, you should probably turn autosave on. As you finish each
record, using the navigation buttons save your changes automatically.

Operator Permissions
To open an item, you must have the inspect permission for the item. To save changes to an
item, you must have the change permission for the item.

Online and Offline Edit
If you save programming changes while the panel is connected, the changes are sent to the
panel immediately. This is called “online edit”. If you make changes while the panel is
disconnected, then the changes are queued to be written later on. This is called “offline edit”.
Insight uses different colours so you can quickly see if there are edits waiting to be sent to the
panel.
Icon

Colour
Green
Blue

Meaning
Panel is up to date
Panel synchronising

Red

Panel unsynchronised

There are no edits waiting to be sent to the panel.
Programming changes are being exchanged with the
panel. The number in brackets next to the panel
name indicates how many changes are remaining to
be sent / received.
Offline edits have been made. There are
programming changes waiting to be written to the
panel.

Tip
You can configure Insight to automatically connect to a panel when you make programming
changes. Go to Panel Properties→Protocol→Connection, and tick the boxes that say
“Automatically connect this panel” and “when programming changes are made”.
Tip
If your panel is red (unsynchronised), you can find all records that are queued for upload or
download by opening a new search, clicking the “only match records marked for upload or
download” and clicking “Find Now” (without entering any search text).
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PIN Discovered
Two user’s cannot have the same PIN in the same panel. Insight Edit will prevent you from
setting a duplicate PIN. In addition, the user whose PIN was discovered will be asked to change
their PIN the next time they use an Elite Terminal in the field.
Note
If the panel is offline, then the PIN discovered flag won’t be set until the panel is next connected.

Scheduled User Expiry
You can configure users to expire at a certain date and time. The expiry information is
downloaded into the Control Module, which takes care of expiring the user at the appropriate
time. Typically, the panel memory configuration means that only some users can be tagged to
expire. With Insight, you can specify an expiry date for any user.
To schedule expiry for any user:
1. Open the user you wish to tag for expiration.
2. Click the Options tab.
3. Set the Expiry Date and Expiry time. If the month or year fields are set to disable, then
“any month” and “any year” are assumed, respectively. If the day, hour or minute fields
are disabled (by right-clicking their “spinner” controls), then “today”, “any hour” and “any
minute” are assumed, respectively.
4. Specify the Disabled User Type. When the expiry date and time occurs, the user will be
assigned this user type.
Note
Insight Server must be running for the cardholders to expire. If Insight Server isn’t running, then
the users will be expired the next time Insight Server starts.

Note
If the panel is offline, then the users aren’t expired until the panel is next connected.

Tip
When a user expires, the original user type is displayed in the Primary User Type box.

Tip
You can set a common expiry date for a batch of users using the Copy Wizard. See page 55.

Write-Locking Panels
Sometimes you may wish to make offline edits, but you want the panel to be online (e.g. so that
alarms can be received). In this case, the panel can be write-locked. This means that the panel
is online, but any edits are not sent to the panel until it is unlocked.
To write-lock a panel:
1. Right-click the panel in the Insight Toolbar, and choose “locked” in the menu that
appears.
2. A padlock appears next to the panel, indicating that it is write-locked. Changes will not
be sent to the panel.
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To unlock a write-locked panel:
1. Right-click the locked panel in the Insight Toolbar, and choose “unlocked” in the menu
that appears.
2. If the panel is online, then any changes will be immediately written to the panel.

Detecting Keypad Edits
The Concept security system allows programming changes to be made by authorised users at
any Elite Terminal “in the field”. These edits are not automatically uploaded by Insight, but you
will be warned that changes have been made at a terminal the next time you connect to the
panel. You can then use the compare records feature (below) to determine what type of item
was edited.
Tip
If you leave Insight permanently connected to your panels, then you can manually check for
programming changes. Right click the panel, and choose “Entire Panel→Compare Records” in
the menu that appears.

Comparing Insight With A Panel
If you suspect that edits have been made at an Elite Terminal in the field, or if you just want to
satisfy yourself that Insight is correctly synchronised with a panel, you can perform a
comparison between Insight and the panel. You can choose to compare the entire panel, or
only a particular type of item such as doors or areas.
To compare a panel with Insight:
1. If the panel is offline, connect to the panel.
2. Right click the panel you wish to compare and choose “Entire Panel→Compare
Records” in the menu that appears.
3. A message is displayed indicating if any records are different.
Note
It can take up to 30 seconds to compare a 512k panel. You will receive a message when the
comparison is complete.

Note
Insight will not tell you which specific records are different, only that there are differences. For
example, the message “areas are different” could mean that 1, 2 or all areas are different
between Insight and the panel.
Tip
If you have established that there are differences and you want to synchronise (remove) them,
then you should mark the different items for upload (if you want to preserve what is in the panel)
or download (to preserve what is in Insight).

To compare part of a panel with Insight:
1. If the panel is offline, connect to the panel.
2. Expand the panel tree and locate the item type you want to compare.
3. Right click the item in the tree, and choose “Compare Records” in the menu that
appears.
4. A message is displayed indicating if any records are different.
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Long Names, Notes, Name Lock Slider, Item Picker, Quick Navigation
Long Name and Notes
Insight lets you enter long names for all items, and a notes field for recording miscellaneous
details.
Name Lock Slider
Although Insight allows for long names on all items, the Control Module only has limited space
for names. To spare operators from the chore of entering both long and short names, Insight
automatically links them together. If the name is too long to fit into the panel, a tilde (~) symbol
is used.
Names are locked (default behaviour).
Names are unlocked and may be edited separately.

Tip
If you enter a very long name with numbers at the end, Insight will preserve the numbers and
remove excess characters from the middle of the name instead of the end.

Item Picker
Wherever you see a button like this (
) you can click it to open the item picker. The item
picker is a window that lets you choose from a list of items.
Quick Navigation (Hyperlinks)
Hyperlinks are blue text labels that let you quickly navigate between related items, without using
the Insight Toolbar to manually locate them. To follow a hyperlink, click on it with the mouse
button. In the picture below, clicking the “Inside Area” hyperlink opens the area called “Office”.

Tip
You can click as many hyperlinks as you like. When you close the windows that have popped
up, you will return to the original record you were editing.

Tip
If you click a hyperlink on a field that is set to “none”, Insight changes the browser to view all of
the items that can be selected for that field.

¤

Previous Software
In WinDirect, quick navigation was performed with the F9 and F10 keys. On panel terminals,
quick navigation is performed with the HELP-9 / HELP-0 key combinations.
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Searching Panels
Insight Edit includes an extremely fast search
tool. You can choose between simple
searches, which look for matching text in the
locations that you specify, and advanced
searches, which let you specify complicated
searches such as “find everything with the
word door but not the word office”.
To perform a simple search:
1. On the Edit menu, choose “Power
Search…” (or press CTRL+F).
2. Enter the text you wish to search for.
3. Choose which panels and item types you wish to search by clicking the “Look In” field
(optional).
4. Un-tick match case if you want GREEN to match with Green.
5. Un-tick whole words if you want am to match with hammer.
6. Enter any settings you want on the “Modified” tab (optional).
7. Click “Find Now”, or press ENTER.
Items matching the search text are displayed.
Tip
All text fields are searched by default. To specify which fields are searched, click the
“Advanced” tab and select them in the “Filter” box.

Tip
If your panel is red (unsynchronised), you can find all records that are queued for upload or
download by opening a new search, clicking the “only match records marked for upload or
download” and clicking “Find Now” (without entering any search text).

Tip
You can open any matching item by double-clicking it with the mouse.

To perform an advanced search:
1.
2.
3.
4.
5.
6.

On the Edit menu, choose “Power Search…” (or press CTRL+F).
Click the “Advanced” tab.
Enter your search criterion (see below).
Choose the fields you wish to search (optional).
Enter any settings you want on the “Modified” tab (optional).
Click “Find Now”, or press ENTER.

You specify advanced criteria by entering text (enclosed in single or double quotes) separated
by special commands and, or, not and xor (“exclusive or”). Placing a text item in double
quotes means the text will match both upper and lower case. Placing a text item in single
quotes means the text will only match if the case is the same. Brackets are used like they are in
arithmetic.
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Examples
“door” (double quotes)
→ case-insensitive match with door (including trapdoor, doorstop, DOORMOUSE etc.)
‘door’ (single quotes)
→ case-sensitive match with door (including trapdoor but not TRAPDOOR)
exact(“door”)
→ case-insensitive match with the whole word door (including DOOR but not trapdoor)
exact(‘door’)
→ case-sensitive match with the whole word door (but not DOOR or trapdoor)
“door” or “window”
→ matches all items with either door or window or both, regardless of capitalisation
“door” and “window”
→ matches all items with both door and window
“door” and not “window”
→ matches all items with door, unless the item also has window
“door” or not “window”
→ matches all items with door, and also matches all items without the word window
not “door”
→ matches anything that doesn’t have the word door
“exit” and “door” or “window or “corridor”
→ matches anything with window or corridor, and also matches anything with both exit
and door
“exit” and (“door” or “window” or “corridor”)
→ matches anything that has exit as well as one or more of the words door, window,
corridor (note: bracketed terms are evaluated first)
“exit” or (“door” and “window” and “corridor”)
→ matches anything that has both door, window and corridor or it has exit
“door” xor “window”
→ matches everything with either door or window, but not both
Tip
If you have difficulty understanding advanced searches, try entering some of the examples
listed above, then modifying them to what you want.

Operator Permissions
You must have the see permission on an item for it to appear in the output window.
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Cross-Referencing Items
The cross-reference window is a very useful and powerful
tool for trouble-shooting an Inner Range installation. When
an item is cross-referenced, all programming relationships
between that item and the rest of the system are
displayed. For example, cross-referencing a calculated
auxiliary shows any auxiliaries, inputs, areas, lift cars, floor
lists and counters that might be altered by the calculated
auxiliary.
To cross-reference an item:
1. Select the item in the browser window, or open
the item for editing.
2. From the Edit menu, choose “cross-reference”; or
press F2; or click the “x-ref” toolbar button (editing
window only).
The cross-reference window appears.
Any items that this item refers to are shown in the refers to section.
If this item appears in the programming of a completely different item, then this
relationship is shown in the referred from section.
Tip
You can open an item from the cross-reference window by right-clicking and choosing “Edit” in
the menu that appears.

Warning
The cross-reference window will not show an item if you do not have the see permission for that
item. In this case, the cross-reference tree will be incomplete.

Using The Copy Wizard
You can use the Copy Wizard to copy, swap or move
items within a panel or between panels. You can also
use the copy wizard to batch program user names,
card numbers and other user fields.
You can replicate a record, which means a duplicate
of the record is made one or more times.
To replicate a record one or more times:
1. Press F7 to open the Copy Wizard, or select
the Edit menu and choose “Copy Wizard”.
2. Click “Copy, swap or move records”.
3. Click Next.
4. Click “Replicate the current record one or more times”.
5. Click Next.
6. Click the arrow in the Item Type field, and navigate to the panel and item type you want
to replicate. A list of programmed items is displayed. (Click the “show blanks” box to
show all items.)
7. Select the item you wish to replicate.
8. Click Next.
9. Click the arrow in the Item Type field, and navigate to the panel where you want to
save the replicated records. (This can be the same panel as step 6, or a different
panel.)
52

10. Choose which record(s) will be replaced. Hold down the CTRL key to select more than
one destination record. Hold down the SHIFT key to select a range of records to be
replaced.
11. Click Next.
12. Click Finish. The source record is written over the target record(s).
Warning
The contents of the target records are permanently replaced. This operation can’t be undone,
except by restoring to a previous backup.

Note
If you copy a record into a different panel, Insight leaves any programming references intact.
For example, copying a user type that points to “door list 15” into another panel will result in the
user type still using door list 15 in the new panel, even if it isn’t programmed or doesn’t exist.
You can block copy one or more records, which means a group of records are copied (either
into a different location in the same panel, or into a different panel).
To block copy select records:
1.
2.
3.
4.
5.
6.

7.

8.
9.

10.

11.
12.

Press F7 to open the Copy Wizard, or select the Edit menu and choose “Copy Wizard”.
Click “Copy, swap or move records”.
Click Next.
Click “Block copy selected records”.
Click Next.
Click the arrow in the Item Type field, and navigate to the panel and item type you want
to block copy. A list of programmed items is displayed. (Click the “show blanks” box to
show all items.)
Select the item(s) you wish to block copy. Hold down the CTRL key to select multiple
records. Hold down the SHIFT key to select a range of records. You must make a note
of how many records are selected, which is displayed in the bottom right corner.
Click Next.
Click the arrow in the Item Type field, and navigate to the panel where you want to
save the replicated records. (This can be the same panel as step 6, or a different
panel.)
Choose which record(s) will be replaced. Hold down the CTRL key to select more than
one destination record. Hold down the SHIFT key to select a range of records to be
replaced. You must select the same number of records as step 7.
Click Next.
Click Finish. The source records are copied over the target records.

Warning
The contents of the target records are permanently replaced. This operation can’t be undone,
except by restoring to a previous backup.

Warning
You shouldn’t specify source and target ranges that overlap. Doing so could result in records
being overwritten incorrectly.
Note
If you copy a record into a different panel, Insight leaves any programming references intact.
For example, copying a user type that points to “door list 15” into another panel will result in the
user type still using door list 15 in the new panel, even if it isn’t programmed or doesn’t exist.
You can swap one or more records, which means the selected records are exchanged.
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To swap a group of records:
1.
2.
3.
4.
5.

Press F7 to open the Copy Wizard, or select the Edit menu and choose “Copy Wizard”.
Click “Copy, swap or move records”.
Click Next.
Click “Swap selected block of records”.
Refer to the instructions for block copying records (previous page), starting at step 5.

You can move one or more records. This is the same as copying the records, except that the
original records are blanked after the copy.
To move a block of records:
1.
2.
3.
4.
5.

Press F7 to open the Copy Wizard, or select the Edit menu and choose “Copy Wizard”.
Click “Copy, swap or move records”.
Click Next.
Click “Block move selected records”.
Refer to the instructions for block copying records (previous page), starting at step 5.

You can clear one or more records to factory default values.
To clear a block of records:
1. Press F7 to open the Copy Wizard, or select the Edit menu and choose “Copy Wizard”.
2. Click “Clear records”.
3. Enter a value for the name, short name and notes fields, or leave the blank to accept
factory defaults. You can use the hash symbol (#) to specify an auto-number. The #
symbol is replaced by the auto-number settings you specify.
4. Click Next.
5. Click the arrow in the Item Type field, and navigate to the panel and item type you want
to clear. A list of programmed items is displayed. (Click the “show blanks” box to show
all items.)
6. Select the item(s) you wish to clear. Hold down the CTRL key to select multiple records.
Hold down the SHIFT key to select a range of records.
7. Click Next.
8. Click Finish. The selected records are erased to factory defaults.
Warning
The selected records are permanently erased. This operation can’t be undone, except by
restoring to a previous backup.
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You can batch program a block of users. This features lets you specify consecutive cards, user
names or notes; set card types; set a common user type; set a common expiry date; and
optionally select a ‘source record’ for duplication.
To batch program a block of users:
1. Press F7 to open the Copy Wizard, or select
the Edit menu and choose “Copy Wizard”.
2. Click “User programming”.
3. Select which options you wish to apply.
Replace card numbers. Tick this box if you
wish to specify the card type and assign
sequential card numbers to a block of users.
Replace user names. Tick this box if you
wish to specify a common name for the block
of users, including an optional auto-number.
Replace other fields. Tick this box if you
want to specify a common user type and expiry options.
Use selected record as template. Ticking this option duplicates a single user
(replacing the existing users in the block), then applies any other options that are ticked.
If this option isn’t selected, then the block of users are modified as-is.
4. Click Next.
5. Fill in any information requested by the wizard, which will depend on the options you
selected in step 3. In particular, when selecting which users to reprogram, you must
hold down the shift key to select a block of users; otherwise, your changes will only
apply to a single user. (You can use the ctrl key to select non-adjacent users.)
6. Click Finish. The batch programming is applied.
Warning
The selected records are permanently reprogrammed. In particular, if you selected the “use
selected record as template” option, then all fields in the target records are replaced. This
operation can’t be undone, except by restoring to a previous backup.
Tip
If you assigned new card numbers, you can automatically import them into Insight Card Pool. In
Card Pool, click the Panel Scan button on the Card Pool toolbar.

Card Pool Integration
Insight Card Pool is a separately licensed module that allows Operators to create and manage
card pools. Operators can quickly assign cards from a card pool, in addition to marking cards as
lost or suspended.
To assign a card from a card pool:
1.
2.
3.
4.
5.
6.
7.

In Insight Edit, open the user you wish to assign a card to.
Ensure that the “Use Cardpool” option is selected. (V3.3 or later)
Click the Card Pool button.
Click the Get Available Card button.
Select the card pool and card to assign to this user.
Click OK.
Click the Save icon in the toolbar.
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To mark a card as lost or suspended:
1.
2.
3.
4.
5.

Paid Feature
Card Pool is a separately licensed component of Insight.

Card Acquisition
Insight can enrol cards using a card reader attached to the Insight enrolment PC. Card
acquisition requires:
•
•

A compatible card reader unit.
A free serial port on the card enrolment computer.

Tip
If you don’t have any spare serial ports (or any serial ports at all), you can use a serial to USB
protocol converter and connect the card reader to a spare USB port.

Insight v3.2 supports the following models:
•
•
•

Inner Range Card Enrolment Station
ACS Smart Reader
HID PC Log-On

The Inner Range Card Enrolment Station (part number 994500) supports the widest range of
card types and formats. Refer to the tables below.
Insight hardware support for different card formats:

N-Bit

IR-Secure 40
IR-Secure 40

General 2640bit

40 Bit
40 Bit

37 Bit

36 Bit

35 Bit

34 Bit

32 Bit

30 Bit

27 Bit

26 Bit

Site Code Method

IR Card Enrolment Station
ACS Smart Reader
HID PC Log-On

IR Card Enrolment Station
ACS Smart Reader
HID PC Log-On
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General 2640bit
N-Bit

37 Bit

36 Bit

35 Bit

34 Bit

32 Bit

30 Bit

27 Bit

Direct Entry Method

26 Bit

s

Open the user whose card is lost or suspended.
Click the Card Pool button.
Click the Lost Card or Suspended Card button.
Click OK.
Click the Save icon on the toolbar.

To acquire a card directly in Insight:
1.
2.
3.
4.
5.
6.

Open the user you wish to assign a card to.
Click the Acquire button.
Select the reader type, card format and serial port.
Click the Read button.
Badge the card.
Click the Save icon in the toolbar.

If you are using Insight Card Pool at your site, then the method for direct card acquisition is
slightly different:
1.
2.
3.
4.
5.
6.
7.

Open the user you wish to assign a card to.
Click the Card Pool button.
Click the Badge Card button.
Specify the reader type, card format and serial port.
Click the Read button.
Badge the card.
Click the Save icon in the toolbar.

Tip
If the card you badge belongs to a card pool, the card is automatically marked as “issued” in the
card pool.

Tip
If the card you badge has a new site code, Insight creates a new card pool with that site code
and adds the card to that pool.

Tip
If the card you badge doesn't exist in a card pool, Insight Edit will remind you to run the Panel
Scan command in Insight Card Pool so it can be added to one.

Insight Edit Reports
You can generate a range of useful reports in Insight Edit. These reports summarise key areas
of panel programming including users, user types, areas and doors. Reports can be displayed
on-screen, sent directly to a printer, or saved to a file. The contents of the reports can be
streamlined with the use of a filter.
I want to view, print or save…
User programming
User type programming
Input programming
A list of areas in each area list
A list of doors in each door list
A list of lifts in each lift car list
A list of floors in each floor list
A list of sirens in each siren list
Doors accessible to each user type
Users for each user type
Areas accessible to each user type
Floors accessible to each user type
A list of inputs in each area
A list of reportable inputs per area
Users who can turn an area on
Users who can turn an area off

From the Reports menu, choose…
Programming→Users
Programming→User Types
Programming→Inputs
Programming→AreaList
Programming→DoorList
Programming→LiftCarList
Programming→FloorList
Programming→SirenList
References→User Type→Doors
References→User Type→Users
References→User Type→Areas
References→User Type→Floors
References→Area→Inputs
References→Area→Commissioning Inputs
References→ Area→User On
References→ Area→User Off
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Inputs + process groups in each area
Doors accessible to each user
Areas accessible to each user
Floors accessible to each user
A list of users with access per door
A list of users with access per floor
A list of users with access per Lift Car

References→ Area→Input – Proc Grp.
References→User To→Door
References→User To→Area
References→User To→Floor
References→User From→Door
References→User From→Floor
References→User From→Lift Car

To generate a report:
1. Select your desired report on the Reports menu.
2. To print the report, choose Print in the sub-menu that appears. To view the report,
choose View in the sub-menu that appears.
Tip
Reports saved to a file are written in CSV format, which can be opened by spreadsheet
applications such as Microsoft® Excel®.

To generate a filtered report:
1. Firstly, ensure that the “Use Filtering” item on the Reports menu is checked.
2. Select your desired report on the Reports menu.
3. To print the report, choose Print in the submenu that appears. To view the report,
choose View in the sub-menu that appears.
4. The Print Filtering dialog will appear. You
can filter on a combination of parameters, as
shown on the right:
- Item status
(programmed/defaulted/both)
- Name (of the item)
- Notes
5. When filtering, either Simple or Complex
filtering can be chosen. Simple filtering
allows filtering on a single item and/or Notes
entry.
6. Complex filtering allows filtering based on a
combination of search terms. For instance,
you are able to list areas except area names
containing ‘A0’ and ‘SYSTEM’ (illustrated on
the right) When Complex filtering is chosen,
the Print Filtering dialog changes to look like
what is shown on the right. (When using
Complex Search, you can only filter on Item
Name, not on notes).
7. Select OK once you have set the parameters
of interest to generate the report.

Tip
In both Simple and Complex Search, you can use ‘wildcard characters’ as described on page
44. In Complex Search, you can use the advanced criteria as used in the Advanced Search
function. Some examples start on page 51.

s

Paid Feature
Filtered Reports within Insight Edit are enabled when you enter a valid licence for the Insight
Advanced Reporting Module.
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Employees
Each panel contains information about users that have
access privileges for that panel. Depending on the
memory configuration in the panel, a name might also be
stored for some or all users.
It is often useful to store extended information about
each user such as full name, age, home and work
contact details, gender and even a photograph for
identity verification.
Insight calls this additional data extended user
information. Users with this additional information are
referred to as employees.

s

Insight Versions
Extended user information and user photographs are not available in Insight Lite.

To add extended information to a user:
1. In Insight edit, double-click the user in the browser pane. Or, right-click the user and
choose “Properties…” in the menu that appears.
2. Click the Employee tab.
3. Enter the person’s title, full name, birth date and gender.
4. Click the Profile tab.
5. Enter the person’s business profile and personal profile.
6. Click the Save Changes button to save your changes.
Note
If you edit the first name or surname field on the Employee tab, the Name field on the Access
tab becomes locked for editing. All future name edits must be carried out on the Employee tab.

Custom Fields
You may find that the default employee fields such as
name, age and address insufficient for the requirements
of your organisation. Insight lets you define up to 32
custom fields which will be associated with each user.
To define a custom field:
1. In Insight edit, double-click any user in the
browser pane. Or, right-click a user and choose
“Properties…” in the menu that appears.
2. Click the “Custom 1” or “Custom 2” tab.
3. Click an unused check box.
4. Enter a label for the new custom field. The
custom field is created and available for all
users.

59

To rename a custom field:
1. In Insight edit, double-click any user in the browser pane. Or, right-click a user and
choose “Properties…” in the menu that appears.
2. Click the “Custom 1” or “Custom 2” tab.
3. Double-click the custom field you wish to rename.
4. Enter a new name and click OK. The custom field is renamed.
To remove a custom field:
1. In Insight edit, double-click any user in the browser pane. Or, right-click a user and
choose “Properties…” in the menu that appears.
2. Click the “Custom 1” or “Custom 2” tab.
3. Clear the check box next to the custom field.
Note
Removing a custom field doesn’t delete any data. If you create a new custom field in the same
position, any existing data is restored.

Tip
You can search for data in custom fields. See “searching” on page 50.

Tip
You can import data into custom fields. See below.

Importing Extended User Information
You can import extended user information (such as age and contact details) from an external
file. The file must be in “Comma Separated Values” format (CSV), which means:
•
•
•

The file is a text document.
Each line of the file represents a single user record, with an End-Of-Line symbol
marking the beginning of the next record.
Each field is separated by a comma character.

Insight expects the data to be presented in a certain default order, although you can override
this behaviour by including a heading row with your data.
Tip
CSV is a common file format that can be exported by most software. Check the documentation
that came with your software.

If you don’t include a heading row, then Insight expects the data in the order shown overleaf. All
fields must be present although some can be empty on a particular row.
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Num

Field

Data

1
2
3

First Name
Second Name
Title

4
5

Gender
Date of birth

(any text)
(any text)
One of the following values: Mr, Mrs, Ms, Miss, Dr,
Professor, Sir, Lord, Lady
One of the following values: M, m, 0, F, f, 1
A date format matching the locale of this computer
(go to Control Panel→Regional & Language Options
for Windows® XP, or Control Panel→Regional
Options for Windows® 2000). e.g. for Australia, the
format is normally dd/mm/yyyy. You should specify a
4 digit year value for correct processing.
(any text)
(any text)
(any text)
(any text)
(any text)
(any text)
(any text)
(any text)
(any text)
(any text)
(any text)
(any text)
(any text)
(any text)
(any text)
(any text)
(any site code number)

6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22

Street
Suburb
City
State
Country
Post Code
Phone Number (Work)
Phone Number (Home)
Phone Number (Home Mobile)
Phone Number (Work Mobile)
Fax Number (Home)
Fax Number (Work)
Email (Home)
Email (Work)
Position
Department
Card Number

Note
Card Number is for site codes only and will set the user to site code and place the number into
the card number field. If it is left blank then it will not change what is currently programmed.

Tip
You can omit a field that you wish to leave blank. You must still include the comma after the
blank field, for example: John,Smith,,M (title is blank and skipped when importing)

Note
To import custom fields, you must use the “heading row” method described overleaf.

Sample CSV File: (line breaks added to fit onto the printed page; text should all be on one line)
Line 1:
Joe,Bloggs,Mr,M,10/05/1960,1 Millenium
Court,Knoxfield,Melbourne,Victoria,Australia,3180,555-WORK,555-HOME, 0400HOME,0400-WORK,FAX-HOME,FAX_WORK,
Joe.Bloggs@Australia.com,Joe.Bloggs@innerrange.com,Technician,R&D,1
Line 2:

Fred,Smith,Mr,M,10/05/1955,1 Millenium
Court,Knoxfield,Melbourne,Victoria,Australia,3180,555-WORK,554-HOME,0401HOME,0400-WORK,FAX2-HOME, FAX_WORK, (continued overleaf)
Fred.Smith@Australia.com,Fred.Smith@innerrange.com, Manager,R&D,2
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You can specify a custom import order by including a header row, which must be the first line of
the CSV file. The header row starts with three hash characters (###), followed by a list of field
names separated by commas. The following field names are defined:
secondname, title, gender, dob, street, suburb, city, state, country, postcode,
workphone, homephone, homemobile, workmobile, homefax, workfax,
homeemail, workemail, position, department, sitecardnumber, company,
directnumber, usertype, extraarea, extradoor, extradoorlist
Note
In the import file, “###” means “first name”. Because “###” must be the first entry in the header
row, this means “first name” must be the first field in each row.

Tip
In addition to the field names defined above, you can also use the name of any custom field
label.

Sample CSV File with header row: (assumes a custom field is defined called ‘favourite colour’)
Line 1:
Line 2:
Line 3:

###,secondname,sitecardnumber,company,favourite colour
Joe,Bloggs,150,Inner Range,Red
Fred,Smith,151,Inner Range,Blue

To import extended user information:
1. Right-click the panel that contains the users you want to import information for, and
choose “Import→Extended Employee Data” in the menu that appears.
2. Navigate to the CSV file that contains your extended
information and click Open. The Input Range dialog appears.
3. Specify the index of the first user you are importing data for.
Installer is index 0, master is index 1, U00003 is index 2, and
so forth.
4. Specify how many users you are importing from the CSV file.
If you enter 0, all records will be imported.
5. Click OK.

Tip
It’s a good idea to write-lock the panel (page 47), so that changes won’t be written to the panel
until the import is complete.

Operator Permissions
To import extended information, you must have the change permission on each user being
imported. If you do not have the change permission on a user, the user is skipped and the next
available record is used.

s

Insight Versions
Insight Lite only imports First Name, Second Name and Card Number. Although ignored, the
other fields must still exist if no header row is specified.
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User Photographs
You can attach a photograph to a user, either from an
existing picture file on your computer or by acquiring a
picture from a device like a scanner or digital camera. You
can configure Insight to automatically display the
photograph when the user badges at a door.
To attach an image from your hard disk to a user:
1.
2.
3.
4.
5.
6.

Open the user for editing.
Click the Employee tab.
Click the Attach Image button (
)
Browse to the image file you want to attach.
Click OK.
Click the Save Changes toolbar button to save your changes.

Tip
To save space, Insight stores a compressed “thumbnail” of the photograph, regardless of the
original size and image format. You don’t need to scale your photographs before importing.

To acquire a new photograph and attach it to a user:
1.
2.
3.
4.
5.
6.

Open the user for editing.
Click the Employee tab.
Click the Acquire Photo button (
)
Select the device you will be acquiring the image from (e.g. camera, scanner)
Follow the on-screen directions which will vary depending on the device.
Click the Save Changes toolbar button to save your changes.

Note
Direct image acquisition is available for devices that support the Windows Image Acquisition
®
(WIA) interface in Windows XP. For other devices and operating systems, capture the image to
your hard disk first, then attach the image.

To pop-up the photo automatically when the user badges their card:
See “working with alarm responses” on page 92.

To print an ID badge without starting Photo ID:
1.
2.
3.
4.
5.

s

Open the user for editing.
Click the Employee tab.
Click the Print Badge button (
)
If more than one card template is defined, you will be asked to choose a template.
In the print dialog that appears, click Print.

Paid Feature
To print ID badges you must have a licence for Insight Photo ID.
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To remove a photograph from a user:
1.
2.
3.
4.

Open the user for editing.
Click the Employee tab.
Click the Remove Photo button (
)
Click the Save Changes toolbar button to save your changes.

Panel Memory Configurations
Each Inner Range panel has a database for storing users and programming information. The
size of the database is determined by the size of the memory chip on the panel (32, 128 or 512
kilobytes). For each memory size, there are a number of memory configurations (such as
Standard, Alarms and Special) that determines how many items of each type are stored by the
panel. This count of items is known as the directory of the panel. For example, the 512k
Standard directory has 128 doors, 250 areas, 64 time zones and so on.
When you connect to a panel, Insight automatically checks the panel’s directory. Under normal
circumstances, the directory of the panel and the directory stored by Insight is the same. Under
certain circumstances, they can be different.
1. You have used a terminal to ‘default’ (change) the panel configuration since it was
enrolled; or
2. You created the panel in Insight from a template or by duplicating another panel, and
are now connecting to a panel with a different memory configuration.
Both situations cause a conflict in Insight, because the panel contains a different number of
records than you can see in Insight. Insight automatically resolves the conflict by creating
surplus and shadow items.
Surplus items are records that no longer fit in the new panel memory configuration. You can
edit them, but they cannot be saved to the panel unless the panel configuration is changed to
something else. If you know you will never do this, then the surplus records can be trimmed,
which deletes them permanently from Insight.
Shadow items are records that exist in the new panel configuration, but not in Insight. They are
like a ‘place holder’, telling you that the records exist in the panel but have not been uploaded
yet. If you know you will be sticking with the new memory configuration, then these records
should be expanded, which converts them into ‘real’ records by uploading them from the panel.
Below are some examples of surplus and shadow records and how they are created.
Example 1

Insight:

4 diaries

Panel:

2 diaries

Insight after connect:
Insight after ‘trim’ command:

4 diaries (2 normal, 2 surplus)
2 diaries

Note
If you edit a surplus record and click save, your panel will be permanently unsynchronised
(since Insight can never save your changes to the panel). To rectify this, you should trim the
surplus records.
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Example 2
Insight:

1 door

Panel:

4 doors

Insight after connect:
Insight after ‘expand’ command:

4 doors (1 normal, 3 shadow)
4 doors

Tip
If you make changes to a shadow record, it is automatically converted to a normal item and
queued for download to the panel.

Trimming and Expanding Records
Under normal circumstances, you should always trim (delete) surplus records, and expand
(upload) shadow records. Insight doesn’t do this automatically, because you might want to copy
the information out of surplus records before trimming, and because expanding shadow records
can be time consuming (they have to be uploaded into Insight).
To trim or expand records:
1. Right click on the panel in the
Insight Toolbar, and choose
“Properties…” from the menu that
appears.
2. Click the “Maintenance” icon.
3. Click the “Directory” tab.
4. Click “Compare”. The panel column
shows how many items are in the
current panel memory configuration.
The Insight column shows how
many items are being displayed by
Insight.
5. Select the items you want to expand or trim, or click “select all” to work on the entire
panel.
6. Click “Expand Insight” to convert shadow records into normal records. If you are
connected to the panel, the records are uploaded immediately; otherwise, they are
queued for upload the next time it is connected. Click “Trim Insight” to delete surplus
records from Insight. Click “Expand+Trim” to automatically expand or trim, depending
on which operation is appropriate.

Warning
You cannot undo the trim command - the surplus records are permanently deleted.

Note
Trimming and expanding has no effect on the panel. It only effects surplus and shadow records
in Insight.

Note
You cannot change the panel memory configuration with Insight. This can only be performed at
a panel terminal.
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Tip
You can trim or expand a particular item type by right-clicking the item in the Insight Toolbar,
then choosing “Trim Surplus Records” or “Expand Shadow Records” in the menu that appears.

Tip
You can quickly trim or expand the entire panel by right-clicking the panel in the Insight Toolbar,
then choosing “Entire Panel → Trim Surplus Records” or “Entire Panel → Expand Shadow
Records” in the menu that appears.
Operator Permissions
To trim records, you must have the change permission on the containing panel.
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Virtuality
Virtuality lets you program several physical panels as if they are a single “virtual” panel. In other
words, you program the information once and it is automatically saved to each panel.
Virtuality was introduced in Insight version 2. In its current implementation, virtuality is supported
for users. In other words, you program a user’s information once, and it is saved to multiple
panels. Future versions of Insight may extend virtuality to other item types.
A virtual panel is a collection of two or more physical panels. You create a virtual panel with
Insight Edit using a wizard. Creating a virtual panel is straightforward - you just select which
physical panels to include, and specify how you want to create your virtual users.
When a panel is added to a virtual panel, it is called a member panel.
A virtual user is like a regular user, except the user exists in all of the member panels and is
programmed from a single location.
Insight makes virtuality as simple as possible, by allowing you to edit users in a single location.
You can program all the fields you can normally program for a user such as name, PIN number,
user type, expiry and fob options. When you save your changes, they are sent to each member
panel in the virtual panel.
Although you may think of virtual users as existing in one place, in reality Insight has to convert
your changes into real users in real panels, and this introduces some complexity. For example,
the member panels may have different memory configurations. You may also want a user’s
access rights to be different in each member panel. Member panels will be connected to
different field hardware, and items such as “extra area” cannot be programmed from a single
location, since the extra area will almost certainly be different in each member panel.
Insight solves these problems using virtual links. Virtuality and virtual links will be explained in
more detail in the following pages.
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Virtual Users Explained
To understand virtual users, imagine you have two panels with the following programming. (For
simplicity, we are ignoring the fact that user 1 is normally INSTALLER and user 2 is normally
MASTER.)
Panel A

Panel B

U001 John

U001 John

U002 Peter

U002 Amy

U003 Bill

U003 Jo

U004 Frank

U004 (Blank)

Looking at the diagram, we can see that John exists in both panels, whereas the other users do
not. From now on, we want to program John in one place instead of two. To do this, we make a
new virtual panel and make John a virtual user in the virtual panel.
Virtual Panel

Panel A

Panel B

VU001 John

U001 John

U001 John

U002 Peter

U002 Amy

U003 Bill

U003 Jo

U004 Frank

U004 (Blank)

Now that a virtual panel has been created, the following rules apply:
John is now VU001 in the virtual panel. This is represented by a gold user icon (

).

Any programming changes made to VU001 will be saved to U001 in Panel A and U001
in Panel B.
John cannot be edited in Panel A and Panel B, because he is now a virtual user. This
is represented by a grey user icon ( ) in those panels.
You will note that the user numbers “line up” in each panel – VU001 is the same user as U001
in Panel A and U001 in Panel B. Now imagine that Peter has been granted access to Panel B.
He becomes U004 in that panel. How is this represented in the virtual panel?
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Virtual Panel

Panel A

Panel B

VU001 John

U001 John

U001 John

VU002 Peter

U002 Peter

U002 Amy

U003 Bill

U003 Jo

U004 Frank

U004 Peter

As you can see, the user numbers do not need to “line up”. Virtual user 10 might be physical
user 25 in Panel A and physical user 70 in Panel B.
You can control which physical user in each panel is
linked to the virtual user in the virtual panel.
To see or change which physical users are linked to
a virtual user:
1. Open the virtual user.
2. Click the Physical Panel Items tab. The Panel
Item column shows which physical user is linked
for each panel.
3. If you want to change the physical user in a
panel, click the entry with the mouse. A drop-box
appears, allowing you to set a new physical user.
4. Save your changes.

Tip
You can jump directly to a physical user from this screen. Right click the physical user, and
choose “Edit” in the menu that appears.

Note
If you change the physical user, the newly selected user will be erased and replaced with the
virtual user. The previous user will be unlinked, but retains all programming. You should erase
this programming to avoid user duplication.
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Virtual Links Explained
To understand virtual links, imagine you have two panels with the following programming. (For
simplicity, we are ignoring the normal default items INSTALLER, MASTER and OWNER.)
Panel A

Panel B

U001 John

U001 John

UT001 Guard

UT001 Clerk

UT002 Manager

UT002 Guard

As can be seen from the diagram, John exists in both panels and has User Type “Guard” in both
panels. Note that Guard is User Type 1 in the first panel and User Type 2 in the second panel.
When set up as a virtual panel, the diagram looks like this:
Virtual Panel

Panel A

Panel A

VU001 John

U001 John

U001 John

VUT001 Guard

UT001 Guard

UT001 Clerk

UT002 Manager

UT002 Guard

In the virtual panel:
John is a virtual user.
Guard is a virtual user type link. Guard is only a link – it cannot be edited in the
virtual panel.
In the physical panels:
John is a copy from the virtual panel and cannot be edited except in the virtual panel.
Guard is the user type that already existed in the panel. Guard is not copied from the
virtual panel.
Essentially, the “link” (VUT001) tells Insight which user type to use for John in each physical
panel. In Panel A, John is UT001 (Guard). In Panel B, John is UT002 (Guard). Editing VUT001
in Insight shows this information, but not the regular User Type programming fields. These must
be set up in each member panel.
Links apply to the following items: user types, areas, area lists, doors, door lists, inputs and
auxiliaries.
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Virtuality In Practice
The previous explanations may have made virtuality seem complicated. If you set up your
physical panels correctly, then it becomes much easier.
To set up virtuality in a new system:
1. Work out how many users will exist in every panel. This may equal the capacity of your
panels, or be a smaller number. Any leftover users can be programmed specifically on
that panel. Make sure to leave some “headroom” for future use – for example, if your
system currently has 100 users, you may wish to assign 200 virtual users.
2. Program all of the users into consecutive slots in one of the panels.
3. Set up the user types for the users you have created. Again, use consecutive slots.
4. Make sure that the corresponding slots in the other panels do not contain important
information. They will be erased in the creation process, so copy records to safe
locations if necessary (see “using the copy wizard” on page 52).
5. Create the virtual panel using the “Master Panel” method.
Master panel:
Starting record:

# of records:

select the panel you set up in steps 2 and 3.
select one less than the first user you set up
in step 2. So if you started programming your
users at U0010, enter 9 here.
enter the number you decided in step 1.

If you create your virtual panel using this method, then the virtual users and virtual user type
links will all be created for you by Insight. All you need to do is edit the virtual users as required.
Tip
Insight uses colours to differentiate between virtual and non-virtual items. Refer to the table
below.

Icon

Colour

Item

Gold

Virtual Item

Grey

Member Item

Regular

Normal item

Description
This is a virtual item. Programming changes will
automatically be saved to all member panels.
This is a virtual item in a member panel. You cannot
edit this item directly – edit the item in the virtual panel
instead.
This is a normal item in a panel. When you edit this
item, changes will be saved only to the panel
containing the item.
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Creating Virtual Panels
You create virtual panels in Insight Edit with the virtual panel wizard. Ideally, you should create
or enrol the physical panels first, although this isn’t strictly necessary since you can add
member panels later on. When you create a virtual panel, you will normally want Insight to
create virtual users at the same time. You can choose between four methods for this task.
For the following illustrations, imagine you start with two physical panels, A and B, with some
users programmed as shown.
Panel A

Panel B

U001 Installer

U001 Installer

U002 Master

U002 Master

U003 Peter

U003 Sue

U004 Bill

U004 Jane

U005 Frank

U005 Sarah

Method 1: Panel With Default Users
With this method, you specify a starting record and the number of users, and Insight creates the
requested number of blank virtual users. Any existing users in the range specified are erased in
each member panel.
Example
Starting record: 1, number of blank users: 3.
Virtual Panel

Panel A

Panel B

U001 Installer

U001 Installer

VU001 Blank

U002 Blank

U002 Blank

VU002 Blank

U003 Blank

U003 Blank

VU003 Blank

U004 Blank

U004 Blank

U005 Frank

U005 Sarah

Note
Insight considers the first user to be starting record 0, whereas the panel starts number users
with “U00001”. Hence, entering a starting record of 1 corresponds to U00002 in the panel.
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Method 2: Master Panel
With this method, you specify a starting record and the number of users, and Insight creates the
requested number of virtual users by reading them from a dominant panel. Any existing users in
the range specified are overwritten in the other panels.
Example
Dominant panel: Panel A, starting record: 2, number of users: 2.
Virtual Panel

Panel A

Panel B

U001 Installer

U001 Installer

U002 Master

U002 Master

VU001 Peter

U003 Peter

U003 Peter

VU002 Bill

U004 Bill

U004 Bill

U005 Frank

U005 Sarah

Note
Insight considers the first user to be starting record 0, whereas the panel starts number users
with “U00001”. Hence, entering a starting record of 2 corresponds to U00003 in the panel.

Method 3: Empty Panel
With this method, the virtual panel doesn’t contain any virtual users initially. You must add them
later. Any existing users in member panels are unaffected.
Virtual Panel

Panel A

Panel B

U001 Installer

U001 Installer

U002 Master

U002 Master

U003 Peter

U003 Sue

U004 Bill

U004 Jane

U005 Frank

U005 Sarah

Method 4: Generate From Like Records
This method will be implemented in a future version of Insight.
Tip
You can create any number of virtual panels, however each physical panel can only belong in
one virtual panel.
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To create a new virtual panel:
1. Enrol or create the panels that will be in the member panel. You must start with at least
one panel, you can add more later if required.
2. Right click the site that will contain the virtual panel, and choose “New Virtual Panel” in
the menu that appears.

The virtual panel wizard appears.

3. Click Next.
4. Enter a name for the virtual panel.
5. Tick the panels you want to add to the virtual panel. You can add panels from any site
or sub-site, provided they aren’t already a member of a virtual panel.

6.
7.
8.
9.

Click Next.
Choose a creation method for your virtual users (see previous pages).
Click Next.
Depending on the chosen creation method, you may be asked to specify a starting
record and number of virtual users to create. Fill in the required fields, consulting pages
72-73 if necessary. Users in the range specified will become virtual in your member
panels. If you specified “default users” as your creation method, they will be erased. If
you specified “master panel” as your creation method, they will be copied from the
designated panel into the other panels.
10. Click Finish. Your virtual panel is created.
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Note
If you selected a method that creates virtual users, then the virtual users will be written to the
member panels immediately. If any member panels are offline, they will turn red, indicating there
are pending programming changes in those panels.

Note
Virtual users are always created starting with VU00001, even when you specify a starting record
greater than one. See the previous examples for an illustration.

To add a panel to an existing virtual panel:
1. In the Insight Toolbar, right click the virtual panel and choose “Properties…” in the menu
that appears.
2. Tick the panels you wish to add to the virtual panel.
3. Click OK.
Note
Users in the virtual panel will not be linked to the newly added panel(s). You must link the users
manually. See pages 72 and 73 for examples.

To delete a virtual panel:
1. In the Insight Toolbar, right click the virtual panel you wish to delete and choose
“Delete” in the menu that appears.
2. Click Yes. The virtual panel is deleted.
Warning
Deleting a virtual panel cannot be undone, except by creating a new virtual panel and setting it
up again. Think carefully before deleting a virtual panel.

Tip
Deleting a virtual panel doesn’t delete the member panels, and their programming remains
unchanged. Future programming changes can only be made on the individual panels, unless
you create a new virtual panel.
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Insight Card Pool
Insight Card Pool lets you assign, manage and examine access control cards in an Inner Range
security system.
Use Insight Card Pool to:
•
•
•
•
•

Create direct entry and site code card pools
Assign cards to users
Mark cards as lost or suspended
Automatically create card pools based on panel programming
Detect unassigned cards and add them to card pools
Card Pool
Toolbar

Filter
Controls

Insight Toolbar

Browse
Toolbar

Browse Pane
•
•
•
•

The Insight Toolbar lets you navigate between card pools.
The Card Pool Toolbar lets you manage your card pools.
The browse pane displays cards in the selected card pool.
The filter controls let you filter what is displayed in the browse pane.

Using The Card Pool Toolbar
Create a new site code card pool.
Create a new direct entry card pool.
Create a new site code as direct entry card pool.
Special option that provides a special display format for direct entry cards.
Do not use unless recommended by Inner Range.
Perform a panel scan and add freshly allocated cards to a card pool.
Auto create card pools based on panel programming.
Get information about Card Pool Manager.
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About Card Pools
A card pool is a collection of access control cards which can be allocated to cardholders. Often,
the cards are “keyed” to a particular site and numbered sequentially – these cards are called
site code cards. Such cards store two pieces of information, the site code (which is generally
common between all cards on a site), and the card number which is unique for each card.
Usually, the card number is printed on the card for easy identification. Cards can be enrolled
without a card reader, because the site code and card number are readily identifiable.
Cards that don’t have a site code are called direct entry cards. These cards only have one
piece of information, the card number. Because there is no unique site information encoded on
the card, typically this number is quite long and therefore isn’t usually printed on the card. These
cards have to be physically enrolled at a card reader to be enrolled into the system.
Regardless of which method is used, data is encoded on the card using binary numbers (0’s
and 1’s). The length of this encoding (i.e. the number of binary digits or ‘bits’) determines the
“card format” (e.g. 26-bit, 34-bit etc.) The more bits, the more unique cards that can be
represented.
Card pools simplify the management of cards at a site by streamlining the allocation of cards to
users and introducing the ability to tag cards as lost or suspended. Cards can be returned to the
card pool, which makes them available for reallocation.
Note
You can only have one direct entry card pool. You can have any number of site code card
pools.

Warning
Insight Card Pool ignores tenancy rules. Operators will be able to see the names of cardholders
that don’t belong in their tenancy.

Migrating To Card Pool
If you’re migrating to card pool and already have cards programmed in your panels, you should
use Card Pool Manager to add these cards to a card pool.
To migrate to Card Pool in an existing installation:
1. Use the Auto Create Card Pools button to create card pools based on panel
programming (see “to automatically create a card pool based on panel programming”
on page 80).
2. Add any other card pools you require (for example, corresponding to unissued cards).
See “to manually create a card pool” on page 79.
3. Use the Panel Scan button to detect unassigned cards and add them to your card pools
(see “to allocate unassigned cards to card pools” on page 82).
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Working With Card Pools
You can create card pools in one of two ways. At any time, you can manually create a card
pool. When you manually create a card pool, you specify:
The type of card pool (direct entry or site code).
The number of cards initially in the pool.
The site code number and card range (for site card pools).
You can automatically create card pools based on panel programming. Insight Card Manager
looks at the site code programming of each panel, and creates corresponding site code card
pools if they don’t exist already. A direct entry card pool is also created if it doesn’t exist already.
To manually create a direct entry card pool:
1.
2.
3.
4.
5.

Click the Direct Entry button on the Card Pool toolbar ( ).
Select the card format.
Select the COM port of your card reader.
Click the Start Read button.
Badge one or more direct entry cards to add them to the direct entry card pool.

Note
You cannot have more than one direct entry card pool. If one already exists, then cards you
badge will be added to the existing pool.

Note
Card Pool Manager expects cards to be badged at an Inner Range Card Enrolment Station (part
number 994500) connected to a PC serial port.

To manually create a site code card pool:
1. Click the Site Code button on the Card Pool toolbar ( ).
2. Make sure the Create New Pool radio button is selected.
3. Enter a name, site code and site code offset for the card pool. The site code offset is
not normally required. However, you must specify an offset if the card number range
overlaps any other site code card number range in any given panel. For more
information, refer to your Concept system programming documentation.
4. Specify how you want the card pool to be created, as follows:
Enter range manually: enrols a sequential batch of cards without badging them.
st
Swipe range: enrols a sequential batch of cards, you swipe the 1 and last card.
Swipe cards: enrols cards one at a time as you badge them.
5. If you chose “swipe range” or “swipe cards”, specify the card format and COM port, then
click Start Read and badge your cards.
6. Click OK.
Tip
Insight expects the card number field to be entered in decimal. The Site Code may be entered in
the hexadecimal or decimal field depending on the card format. You can convert between
hexadecimal and decimal using the Windows calculator (Start→All Programs→
Accessories→Calculator). Just switch the calculator to scientific mode (View→Scientific).
Tip
If you change COM ports while Insight is waiting for you to badge a card, then badging is
aborted. Click the Start button to resume badging.

79

To automatically create card pools based on panel programming:
1. In Insight Edit, program the site codes for your panel.
2. In Card Pool Manager, click the Auto Create button on the Card Pool toolbar ( ). If a
site code is found in any panel with no corresponding card pool, the card pool is
created. A direct entry pool is also created, if one doesn’t exist already.
Tip
If you start Card Pool Manager and there aren’t any card pools defined, Card Pool Manager
carries out this action automatically

Tip
If you’ve already issued cards to cardholders, you should use the scan panel feature to update
the contents of your card pools. See page 82.
.
To add cards to an existing direct entry card pool:
The process is the same as creating a new direct entry card pool. See “creating a direct
entry card pool” on page 79.
To add cards to an existing site code card pool:
1.
2.
3.
4.

Press the Site Code toolbar button on the Card Pool toolbar ( ).
Make sure the “Add to Existing Pool” radio button is selected.
Use the Card Pool Name field to select a card pool.
Specify how you want the card pool to be extended, as follows:
Enter range manually: adds a sequential batch of cards without badging them.
st
Swipe range: adds a sequential batch of cards, you swipe the 1 and last card.
Swipe cards: adds cards one at a time as you badge them.

5. If you chose “swipe range” or “swipe cards”, specify the card format and COM port, then
click Start Read and badge your cards.
6. Click OK.

Using The Browser
The browser pane in Card Pool Manager shows the status of cards in a card pool, and also lets
you quickly tag cards as lost or suspended.

The browser pane shows the status of all cards in the currently selected Card Pool. The
meaning of each column is explained below.

80

Heading
Card Pool Name

Description
The name of the pool containing this card.

Card Number

The card number. For site code cards, this is the
decimal card number component without the site code.
For direct entry cards, this is the entire card number (in
hexadecimal).

Card Type

Either direct entry or site code. For site code cards, the
site code is also displayed (in decimal).

Card Status

Available: the card is waiting to be assigned.
In Use: the card has been assigned to a cardholder.
Lost: the card has been lost.
Suspended: the card has been suspended.

Card Assigned To

For cards that are in use or lost, indicates who the card
is assigned to.

Date/Time Last Updated

The date and time the status of this card most recently
changed.

Reactivate

For cards that are lost or suspended, indicates who the
card will be assigned to if it is reactivated.

Last Assigned To

For cards that are returned from the lost or suspended
states, this column indicates who the previous assignee
was.

Quick Note

Operators can enter general comments in this field.

You can filter the browser pane on a range of criteria. Only cards matching the criteria are
displayed.
To apply a filter to the browse pane:
1. Select a criterion in the Select Filter box.
2. Enter a text string in the Filter Text box. Insight hides cards that don’t match the filter
text.
Tip
To stop filtering, clear the contents of the Select Filter box.

Managing Cards
You manage cards by allocating them in Insight Edit, and by marking them in Card Pool
manager when they are lost, suspended, returned or reallocated.
To allocate cards from a card pool:
See “to assign a card from a card pool” on page 55.
To mark a card as lost:
1. In the Insight Toolbar, select the card pool that contains the lost card.
2. In the browse pane, right-click the lost card and choose “Lost” in the menu that appears.
The status of the card is changed to “lost”.
Tip
Changes you make in Card Pool are saved automatically.

Note
If your changes affect a cardholder in a panel and the panel is online, changes will be written to
the panel immediately. If the panel is offline, changes will be written the next time it is
connected.
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To suspend a card:
1. In the Insight Toolbar, select the card pool that contains the lost card.
2. In the browse pane, right-click the card and choose “Suspend” in the menu that
appears. The status of the card is changed to “suspended”.
To re-activate a lost or suspended card:
1. In the Insight Toolbar, select the card pool that contains the lost card.
2. In the browse pane, right-click the card and choose “Reactivate” in the menu that
appears. The card will be reassigned to the user listed in the “reactivate” column.
To return a lost or allocated card to the card pool:
1. In the Insight Toolbar, select the card pool that contains the lost card.
2. In the browse pane, right-click the card and choose “Return” in the menu that appears.
The status of the card will be changed to “available” and the identity of the previous
cardholder will be displayed in the “last issued to” column.

Unassigned Cards
Unassigned cards are cards that have
been assigned in Insight Edit to a
cardholder, but don’t exist in any card
pools. This will be the case if Card Pool
was licenced after the cards were
assigned. You can use Card Pool
Manager to scan for unassigned cards
and add them to your card pools.
To scan for unassigned cards:
1. Click the Panel Scan button on
the Card Pool toolbar ( ).
2. Insight scans panel
programming, then displays the
Assign Users To Card Pool
window. If any unassigned
cards are detected they’re displayed in the left hand pane.
To allocate unassigned cards to card pools:
1.
2.
3.
4.
5.

Select the cardholders whose cards you wish to assign to a card pool.
Select the card pool in the lower right corner.
Click the “assign to card pool” button (>>).
You can repeat steps 1-3 to assign cards to different card pools.
Click the Close button to commit your changes.

Tip
If you change your mind, you can cancel your changes by selecting all of the assigned
cardholders in the right hand pane and clicking the “remove from card pool” button (<<).
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Insight Review
Insight Review lets you search, filter and print security events from your Inner Range security
system. The Professional Edition also includes advanced alarm handling and report generation.
Use Insight Review to:
•
•
•
•
•

View live and archived review
Search and filter review data
Specify advanced alarm rules (professional edition)
Acknowledge alarms (professional edition)
Generate reports (professional edition)

Review Toolbars

Browse
Toolbar

Filter
Stacks
Insight
Toolbar

Review Windows

•
•

Review

The Insight Toolbar lets you manage your sites and panels (page 23).
Review Windows let you search, filter and display review (page 85).
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Underlying Concepts
Inner Range panels maintain an audit trail of access control and alarm events known as review.
Depending on the size and configuration of the panel, this can be up to 6500 entries. Once the
review log is full, it slowly begins overwriting itself.
Insight uploads review from panels whenever it is connected, and stores it in a permanent
archive. The archive can be examined in real time (as new events are added by panel activity)
or historically. Because Insight keeps a permanent archive, it does not matter when the panel
review log overwrites itself.
Warning
Insight only receives review from panels while they are connected. If events occur when a panel
is disconnected, they are queued and received by Insight the next time a connection occurs.
The number of events that can be queued varies depending on panel size, but is guaranteed to
be at least 300 events and will be at most 6,500 events.
Warning
Insight tracks review via the Insight comms task (menu 7-3-1 at any terminal). If this comms
task is stopped and started (manually or via the Control Module being reset) then Insight cannot
determine which review events are ‘unseen’. In this case, you must move the review pointer
manually. See page 88.

¤

Previous Software
In PCDirect and WinDirect, review was received automatically during online edit mode. With
Insight, panels might not be ‘connected’ even when Insight is running. To understand panel
connections, see page 33.
Tip
Insight uploads review from panels whenever they are connected, even if the Review module is
not running.

Insight Audit Events
Insight generates its own review entries called audit events. Audit events are generated when
operators log on and log off, when alarms are acknowledged and when items are edited in
Insight Edit.
Tip
You can filter specifically for audit events. Open a review window, add a new Thing filter, and
set the thing to “Insight Audit”.
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Review Windows
Review is examined in a window called the review window. You can have as many review
windows open at a time as you like, each with its own set of filters. To open a new review
window, select “New…” from the File menu, or press CTRL+N.

Review Toolbar

Period Filter
Thing Filter

Filter Toolbar

Filter Stack

Review

Using the Review Toolbar
Open a new review window.
Open a saved filter stack.
Save the current filter stack.
33

Show or hide the filter stack.
Add a new filter to the filter stack (and stops review processing).
Turn auto-scroll on or off.
Clear the current window. Disabled if review processing is enabled.
Starts and stops review processing for this window.
Create a filtered report.
Select review archive.

Using the Filter Toolbar
Open a saved filter.
Save the filter for use later.
Remove the filter from the filter stack.
Toggle and/or logic. If and is selected, review must match this filter as well as
previous filters. If or is selected, review only has to match this filter plus any
subsequent and filters.
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To Examine Review:
1. Open a new review window (CTRL+N)
2. Load or modify the filter stack to suit your requirements
3. If your filter stack includes the “all review”, “live review” or “last…” filters, and you want
review to appear as it happens at the panel, make sure the panel is connected in the
Insight Toolbar.
4. Click the “GO” button.
Filtering Review
Since Insight saves every single review event ever received, the number of events can grow to
a large number. Usually, you will only be interested in examining review from a particular time
period or from a specific panel. You can quickly isolate review of interest by applying filters.
About Filter Stacks
Each review window has a filter stack applied to it. A filter stack is a collection of one or more
filters which are “stacked” between the window title and the window contents. When you modify
the filter stack, you change what review events are displayed in the window.
Tip
You can hide the filter stack by clicking the show/hide filter stack button. The filters still apply
even when hidden.

Time Filters
Time filters let you filter for review that occurred at a certain time. There are five types of time
filters.
On:

Lets you specify a particular day. You can also specify a time interval on
the specified day, for example 18:30 to 19:15.

From / To:

Lets you specify an interval that spans more than one day. For example,
rd
midday on March 15 until 8pm on April 3 .

Last:

Live Review:
All Review:

Lets you specify review that occurred within a certain range of the current
time. For example, the last 45 minutes or the last 2 weeks. As time passes,
entries will disappear with this filter type.
This special filter type matches any review that is received live from a
connected panel.
This special filter type matches ALL review unconditionally, including live
review from connected panels.

Thing Filters
Thing filters let you filter for review that concerns a particular item. Refer to the table below.
I want to…

This is achieved by…

See review from a specific panel.

Select the panel thing filter.

Exclude review from a specific panel.

Select the panel thing filter, then set the
matching option box to “isn’t”.

See review that contains certain text.

Select the text compare thing filter.

Exclude review that contains certain text.

Select the text compare thing filter, then set
the matching option box to “isn’t”.

See review for a particular user, door, area,
time zone, function zone, calculated auxiliary,
diary, input or module.

Select the user, door, area, time zone,
function zone, calculated auxiliary, diary or
module thing filter.
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I want to…

This is achieved by…

Exclude review for a particular user, door,
area, time zone, function zone, calculated
auxiliary, diary, input or module.

Select the user, door, area, time zone,
function zone, calculated auxiliary, diary or
module thing filter, then set the matching
option box to “isn’t”.

See review that is a particular type (e.g. area
on/off, system messages, user access etc.)

Select the review type thing filter.

Exclude review that is a particular type.

Select the review type thing filter, then set the
matching option box to “isn’t”.

See XMIT entries.

Select the XMIT thing filter. (XMIT entries are
review messages flagged as ‘important’ by the
panel).

Select review for a particular XMIT message
type.

Select a thing filter that starts with an asterisk.

See all Insight audit events.

Select the Insight audit thing filter.

See edits made to panel programming, Insight
programming or Insight permissions.

Select the audit panel items, audit insight
items or audit permissions thing filter.

See operator log-ons and log-offs.

Select the audit operator log thing filter.

See panel enrolments.

Select the audit sync panel thing filter.

Paid Feature
Not all of these filters are available in Insight Lite.
You can combine any number of time and thing filters to create more complex rules. For
example, by adding three filters you could show only review from “Panel A” that occurred in the
last hour and contains the word “granted” in the message.
To add a filter to the filter stack:
1. Click the add filters button in the toolbar (

) and choose the appropriate type.

2. Modify the filter according to you requirements.
3. If this isn’t the only filter in the stack, click the and/or button to determine how this filter
interacts with the other filters in the stack.
4. Click the go button (

) to activate review processing for the window.

Tip
You can search for items in the review window. Choose “Find…” from the Edit menu, or press
CTRL+F.

To copy review to the clipboard:
1. Select the item(s) you want to copy.
2. Choose “Copy” from the Edit menu, or press CTRL+C.
Tip
You can select multiple rows by holding down the Shift or Control keys whilst clicking in the
review window.
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To save review to a text file:
1. (Optional) select the entries you want to save.
2. Choose “Save As…” from the File menu.
3. To save all events, click the All Entries radio button. To save the events you selected in
step 1, click the Selected Events radio button.
4. (Optional) enter a name for your file.
5. Click Save.

Moving The Review Pointer
If the Insight comms task is reset, then Insight cannot determine which review entries have not
been processed. In this case, it is possible to move the review pointer manually.
To move the review pointer:
1. Right click the panel in the Insight Toolbar and choose “Review” in the menu that
appears, then choose “Move Back…”.
2. Enter how far back you want to move the review pointer.
3. Click Close.
Warning
Moving the review pointer may cause duplicate review entries to be recorded. This feature is
recommended for experts only.

Basic Reports
Insight includes report templates for most common reporting activities, including user access,
door access and alarm reports. Refer to the table below.
I want to…
Create a report showing all review events.
Create a report showing all comms task triggers.
Create a report showing all XMIT events.
Create a report showing user activity.
Create a report showing door activity.
Create a report showing lift activity.
Create a time on site report.
Create a report showing events matching a
complex filter.

This is achieved by…
Use the all events report.
Use the all alarms report.
Use the XMIT alarms report.
Use the user access report.
Use the door access report.
Use the lift access report.
Use the time on site report.
Create a filter stack report.

To generate a basic report:
1. Select the desired report from the Reports menu.
2. Specify the criteria for your report.
3. Click OK. Insight generates the report.

Tip
You can copy all or part of the report into the Windows clipboard. Select the portion you want to
copy, then choose “Copy” from the Edit menu, or press CTRL+C. Formatting will be preserved if
you paste the report into a compatible application such as Microsoft® Word.
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To print a report:
1. Choose “Print…” from the edit menu.
Tip
If your report doesn’t paginate correctly, then regenerate the report and change the “records per
page” value to something else.

To save the report to disk:
1. Choose “Save As…” from the File menu, or press CTRL+S.
Tip
The report is saved in HTML format and can be opened by any web browser.

To find text in a report:
1. Choose “Find…” from the Edit menu, or press CTRL+F.

Custom Reports
You can generate a report based on complex rules and filters. Creating custom reports is a twostep process. First, a filter stack is created that specifies the criteria for the report. Then, the
report is generated.
To create a custom report:
1. If necessary, create a new review window (select “New…” from the File menu, or press
CTRL+N).
2. Add time filters and thing filters to your review window until it is filtering for the data you
want (see page 86).
3. Test your filter stack by pressing the Go button in the toolbar ( ).
4. Click the Filtered Report button in the toolbar ( ). A report is generated matching the
criteria in the filter stack.
Tip
If you save the filter stack with the Save Filter Stack button ( ), then you can quickly access
the report by choosing “Filter Stack” from the Reports menu, then selecting your saved filter
stack. Make sure you are saving the Filter Stack, and not an individual filter - the Save Filter
Stack button is next to the Hide Filter Stack button ( ) at the top of each review window.
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Time On Site Report
With Insight you can generate a Time On Site report.
The key features of the Time On Site report are:
1. Fully customisable report criteria including
flexible start and end times, multiple shift times,
cardholders, doors.
2. Selectable reporting fields.
3. Choice of detailed or exception reporting modes.
4. Customisable shift tolerance.
5. Provision for worker breaks of customisable
duration.
6. Option to export to CSV (Comma Separated
Values) file readable by Excel & other software.
7. Option to export to MYOB, Tenix or Custom file.
8. Six ‘report inaccuracy’ validation triggers.
9. Ability to load and save all report settings.

s

Paid Feature
Time On Site reporting is licensed separately as part of the Insight Advanced Reporting Licence
and requires Insight Professional to operate.

To generate a Time On Site report:
1.
2.
3.
4.
5.
6.

7.

8.
9.
10.

Choose “Time On Site” from the Reports menu.
On the Time/Date tab, specify the starting and ending date and time for the report.
Define one or more shifts for the report.
On the Panels/Users/Doors tab, select at least one cardholder and door. Any number of
additional doors and cardholders can be specified, across multiple Panels if required.
On the Fields tab, tick the fields you want included on the report.
On the Detailed/Exception tab, choose between a detailed report (which includes all
time on site information) and an exception report (which only includes entries that match
specified exception criteria, such as minimum or maximum hours per day/week/month).
If you want to export the data in addition to generating the report, tick the Generate
Export File box on the Export tab, and choose your Export Type (Custom, MYOB or
Tenix). Once you have chosen the export type, you can then choose your export
settings relevant to that type. If you choose the “Custom” type, you will need to setup
the file format. See “To setup a custom export type format” below.
Choose which review archive to run the report on. The default is “current”, which
contains review that hasn’t been archived.
If you want to save the report settings, click the Save Settings button.
Click OK to generate the report.

To setup a Custom export type format:
1. Choose “Custom” from the Export Type
drop-down list.
2. Select “Edit Custom Output Format”.
3. Define the content of the Header, User
Summary record, Ingress/Egress record
and Footer sections. The required data
fields, separators, format identifiers, etc.
are added by selecting an insertion point
and double-clicking on an item in the
“Substitution Fields” list. Normal text can
also be entered by typing.
4. Click OK to accept the settings for this
report.
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Note
Insight will automatically flag users whose report data may include inaccuracies. Users are
flagged who trigger any of the following events:
1.
2.
3.
4.
5.
6.

Two or more consecutive ‘Door Out’ events without an intervening ‘Door In’ event.
Two or more consecutive ‘Door In’ events without an intervening ‘Door Out’ event.
First event in shift is ‘Door Out’.
Last event in shift is ‘Door In’.
No ‘Door Out’ events in shift.
No User/Door Access review entries.

Tip
You can specify a shift tolerance when generating a time on site report. In and Out events
occurring within the specified tolerance will be included in the report.

Tip
You can specify customisable worker breaks. Time off site will be ignored if it is less than the
specified interval.

To generate a report using saved settings:
1.
2.
3.
4.
5.
6.

Choose “Time On Site” from the Reports menu.
Click the Load Settings button.
Navigate to your saved settings file.
Click Open.
(Optional) make any desired settings changes prior to running the report.
Click OK to run the report.

Alarms
Insight provides advanced, customisable alarm recognition and response. The key features of
Insight alarm handling are:
Four alarm levels: low, medium, high and critical.
Define any number of customisable alarm events with complex filters.
Customisable alarm reaction including sound effects and opening schematic maps.
Automatic user photograph pop-up.
Customisable help response messages.
Customisable operator responses.
What is an alarm?
For clarity, we define two different types of alarm:
- Panel alarms (also called XMIT entries) are security conditions detected in the field by a
Control Module and flagged as an alarm. Usually, you will want these alarms to be handled as
an alarm condition in Insight.
- Insight alarms are defined by Operators. They may or may not be based on an XMIT entry.
Insight Alarms are much more flexible than panel alarms, because you can choose exactly what
conditions must be satisfied for the alarm to be raised.
The way Insight reacts to an alarm is controlled by an alarm response. When Insight is first
installed, it has a single alarm response set up that handles all panel alarms. You can modify or
remove this alarm response, and you can add any number of additional alarm responses.
Alarms are displayed in the alarms window, and must be acknowledged. In any module, the
number of outstanding alarms is displayed in the lower right hand corner of the screen.
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Paid Feature
Alarm handling is not available in Insight Lite.

Acknowledging Alarms
When an alarm occurs, a number of things
will happen, depending on the rules
specified in the corresponding alarm
response. Typically, an alert sound is
played and the alarm count starts flashing.
To open the alarm handler window:
1. In any module, click the alarm count in the status bar (bottom right).

To acknowledge an alarm:
1. Open the alarm handler window.
2. Select the alarm you wish to acknowledge. (You can select multiple alarms with the shift
and control keys).
3. Click the Acknowledge Alarm button (
). Depending on the alarm response options
the Alarm Acknowledge screen appears.
4. If the alarm requires an acknowledgement message, then enter your acknowledgement
text. You can select from pre-defined operator
responses by clicking the down-arrow at the
right edge of the field.
5. Click OK. The alarm is removed from the alarm handler window.

Working With Alarm Responses
An alarm response defines what rules constitute an alarm and also specifies how Insight reacts
when it occurs. Alarms are defined using a filter stack. When incoming review matches the filter
stack, the alarm is triggered. A triggered alarm can be configured to attract the Operator’s
attention in a variety of ways. Triggered alarms are added to the alarms window and must be
acknowledged.
To create a new alarm response:
1. In any module, click the alarm counter (bottom right corner). The Alarm Handler window
opens.
2. On the Edit Alarms menu, choose “New
Alarm Response” and navigate to the
type of review event you want to base
the alarm response on. A new filter stack
is created matching your criteria, and the
Alarm Response window is displayed.
3. Enter the settings for this alarm response
(see below).
4. Click OK.
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Options Tab
This defines the basic properties of the Alarm Response.
Item

Description

Name

The name of the alarm response, used for identification only.

Alarm Level

Specifies the urgency of the alarm. Since the alarm window
can be filtered to only show a certain level and above, this
can be used to prioritise alarms.

Response Help

Specifies the help text that should be displayed when the
alarm is acknowledged.

Operator Response

If ticked, the operator must enter a text message when
acknowledging the alarm. If cleared, no text message is
required.

Enabled

If ticked, alarm processing occurs normally for this alarm
response. If cleared, the alarm response is ignored.

This Alarm will be
Acknowledged Automatically

If ticked, no operator action is required - Insight will
acknowledge the Alarm automatically and the Alarm will not
appear in the IR Alarm Handler window.

Message Tab
Controls the Message displayed to the Operator in the Alarm Response window.
Item

Description

Alarm Response Message

A description of the alarm. This text is displayed next to the
alarm in the alarm handler window.

Text Colour

When the alarm occurs, the text will be this colour in the
alarm handler window.

Background Colour

When the alarm occurs, this colour will be behind the alarm
in the alarm handler window.

Immediate Tab
Allows Insight to perform actions immediately upon receipt of this type of Alarm Insight Review.
Item

Description

Beep PC’s internal Speaker

When the alarm occurs, the internal PC speaker is beeped.

Play a Sound File

When the alarm occurs, the specified sound file is played. To
choose a custom sound, press the Custom radio button, then
browse to the sound file (must be in WAV format). Press the
Test button to hear the alarm sound.

Repeat Count

Indicates how many times to play the alarm sound. If set to
continuous, the sound repeats until the alarm is
acknowledged or the mute sounds button is pressed in the
toolbar (
).

Maximize Window

If Insight Review is running, then it will be maximised (in
other words, the window will be expanded to take up the
entire screen). If Insight Review isn’t running, this option is
ignored.

Flash Application Icon In
Taskbar

If Insight Review is running, then it will start flashing in the
Windows task bar. If Insight Review isn’t running, this option
is ignored.
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Display Photo-ID User
Verification screen

If the review entry that generated the event has a user
associated with it, then the Photo-ID User Verification screen
is displayed.

Start Insight Schematic

Launches Insight Schematic.

…when computer name is

If this field is used, a Windows machine name (without the
backslash characters) must be specified.

Map

In Insight Schematic, specifies which map to display when
the alarm occurs.

Show DVR Camera Live Video

Opens a new video window displaying live video from the
specified camera.

Run (immediate tab)

You can specify the path, name and command line options of
rd
a 3 -party software component, which will be executed when
the alarm occurs.

Note
Custom alarm sounds are not backed up by Insight Archiver. If you delete or rename the custom
sounds, then they will not be played by Insight.

s

Paid Feature
The Display Photo-ID User Verification screen requires a valid Photo-ID licence.

Using the Photo-ID User Verification
Screen
1. The Photo-ID User Verification
Screen will appear in response
to a user event when enabled.
2. The user associated with the
current user event is displayed
in the middle of the screen.
3. The associated review event is
displayed beneath the pictures.
4. Selecting the Previous or Next
button will show the
corresponding user event and
user photo. You can also click
on the previous or next photo to
go to the corresponding event
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Acknowledge Tab
Contains options pertaining to Alarm acknowledgement.
Item

Description

Display a Message Box

If this option is ticked, then double-clicking an alarm opens
the alarm acknowledgement window. If this option isn’t ticked
and response help is set to none and operator response isn’t
ticked, then double-clicking an alarm silently removes it
without showing the alarm acknowledgement window.

Display a dialog box showing
User Information

If the review entry that generated the event has a user
associated with it, then a User Information Window is
displayed when the alarm is acknowledged, unless the Auto
Pop-Up option is ticked. (This is a different window to the
Photo-ID Verification box in the Immediate tab)

Auto Pop-Up

If the review entry that generated the event has a user
associated with it, then the User Information Window is
displayed when the alarm occurs. The User Information
option must also be ticked.

Run (acknowledge tab)

You can specify the path, name and command line options of
rd
a 3 -party software component, which will be executed when
the alarm is acknowledged.

DVR Tab
Commands can be sent to cameras and DVRs when an Alarm is received.
Item

Description

Execute DVR Command

Sends the specified command to the selected camera or
DVR.

Additional Parameters

Some commands require additional parameters, which can
be specified in these fields.

Reports Tab
Advanced Reports can be triggered to run upon receipt of an Alarm.
Item

Description

Run Report

The checkbox runs the selected report when the alarm
occurs.

Additional Parameters

Allow you to select from Advanced Reports in the system.

Note
For reports to execute automatically, you must set a valid printer in the settings for the selected
report. If you need to print to a network printer, the IRDB service on the Insight server computer
must be set to run using an account that has access to the network printer(s). See your network
administrator if network printing is required.
Tip
Unlike the Actions in the other tabs, the Actions in the DVR and Reports tab aren’t dependent
on an Insight client module being open at the time the Alarm is received. These actions will
execute when the alarm is received by Insight as long as the Insight server is running.
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Paid Feature
To perform DVR commands on alarms, the Insight DVR Integration Module must be purchased.
Likewise, the Insight Advanced Reporting Module is required to trigger reports on alarms.

To customise which events trigger an existing alarm response:
1. Open the Alarm Handler window by clicking the alarm count.
)
2. Click the Alarm Responses button in the toolbar (
3. Select the alarm response you wish to modify, then click Edit. The alarm response filter
stack is displayed, then the alarm response window is opened.
4. Click Cancel to close the alarm response window. You will be left with the alarm
response filter stack.
5. Modify the filter stack to suit your requirements (page 86). Remember, any review
messages that satisfy your filter stack will generate an alarm.
6. Close the filter stack. Changes take effect immediately.

To modify how Insight reacts to an existing alarm response:
1. Open the Alarm Handler window by clicking the alarm count.
)
2. Click the Alarm Responses button in the toolbar (
3. Select the alarm response you wish to modify, then click Edit. The alarm response filter
stack is displayed, then the alarm response window is opened.
4. Make any changes to the alarm response.
5. Click OK.
Tip
If the filter stack for the alarm response is open, then you can modify the alarm response simply
by clicking the Alarm Response button on the toolbar ( ).
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Working With Help Responses
Help responses are displayed as part of the alarm acknowledgement window. You can create
different help responses for different alarms. You must first create the help response using the
help response editor. You can then attach the help response to an alarm so it will be displayed
during the acknowledgement procedure.
To create a new help response:
1. Open the Alarm Handler window
by clicking the alarm count
(bottom right corner).
2. Click the Help Responses button
).
in the toolbar (
3. Click New.
4. Enter the name and text of the
help response. You can use the
formatting tools at the bottom of
the window to control text
colour, size and formatting.
5. Click OK.
To modify an existing help response:
1. Open the Alarm Handler window
by clicking the alarm count.
2. Click the Help Responses button
3.
4.
5.
6.

).
in the toolbar (
Select the help response you wish to modify.
Click Edit.
Make any changes you require.
Click OK. The next time you acknowledge an alarm with this help response attached,
you will be shown the updated text.

To attach help response to an alarm:
1. Open the Alarm Handler window by clicking the alarm count.
)
2. Click the Alarm Responses button in the toolbar (
3. Select the alarm response you wish to modify, then click Edit. The alarm response filter
stack is displayed, then the alarm response window is opened.
4. Select the Options tab.
5. Click the Response Help field, and select the help response you want displayed.
6. Click OK. When operator’s acknowledge this type of alarm, the help text will be
displayed in the acknowledge window.
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Working With Operator Responses
Operators usually need to enter text when acknowledging alarms. Instead of entering free text,
you can provide “templates” dealing with common responses that the operator can quickly
select.
To create a new operator response:
1. Open the Alarm Handler window by clicking the alarm count.
2.
3.
4.
5.

Click the Operator Responses button in the toolbar (
Click New.
Enter the name and text of the operator response.
Click OK.

).

To modify an existing operator response:
1. Open the Alarm Handler window by clicking the alarm count.
2.
3.
4.
5.
6.

Click the Operator Responses button in the toolbar (
Select the operator response you wish to modify.
Click Edit.
Make any changes you require.
Click OK.

).

To apply an operator response when acknowledging an alarm:
1. Double-click the alarm to open the alarm acknowledgement screen
2. In the Operator Acknowledgement field, click the pull-down arrow and choose the
appropriate response. You can optionally modify the text if required.
3. Click OK.
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Insight Advanced Reports
Insight Advanced Reports lets you design and generate any number of complicated reports,
including muster reports.
Use Insight Advanced Reports to:
•
•
•
•
•

Generate muster reports
Generate extended user reports with photographs
Design your own reports based on existing templates or from scratch
Place coloured text and graphics, drawing shapes, charts, barcodes, tables, forms or
even data from external applications in your reports
Export reports in a myriad of formats including HTML, XML, RTF, JPEG and Text.

Reports
Toolbar

Preview
Toolbar

Insight Toolbar

Launch
Toolbar

Report
Preview

Report Templates
•
•
•
•
•

s

Report Thumbnail

The Insight Toolbar lets you select a report template or customised report.
The Reports Toolbar lets you run, edit, delete or view properties of a report.
The Preview Toolbar lets you print, email or view the report.
The Report Thumbnail lets you immediately jump to any page of a report.
The Report Preview displays the last report that you generated.

Paid Feature
Insight Advanced Reports is a separately licenced module.
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Underlying Concepts
Insight Advanced Reports lets you design your own reports using a flexible report designer. The
basis of every report is a report template. The report template dictates the physical
appearance of the report including the position of text and graphics, which Insight fields are
included, any grouping or sorting of the data in the report and any page headers or footers
included in the report. Think of the report template as the physical layout and appearance of the
report.
In addition to the report template, a report requires certain information that assists in preparing
the report. For example, a muster report needs to know which areas of interest should be
included in the report. Insight also needs to know where to send the report – to the screen, to a
printer, to an email contact or to a file. This information is collectively called the report settings.
A report is the combination of a report template and the report settings. Insight requests the
report settings every time you run a report. When you save a report, the report settings are
saved as well, and are used as the default values the next time you run the report.
Insight is pre-installed with a handful of reports. These are called built-in reports. If you change
the report settings, you can save the report under a new name. The saved report is called a
custom report.
Tip
A report template controls how a report looks. The report settings specify what data to feed to
the report, and also where the report is sent (screen, printer, export file etc.).

Working With The Insight Toolbar
The Insight Toolbar provides access to your custom reports
and built-in reports.
To view and manage your custom reports:
1. Make sure the Insight Toolbar is visible (View→
Insight Toolbar)
2. Click the Custom Reports tab
To view and manage your built-in reports:
1. Make sure the Insight Toolbar is visible (View→Insight Toolbar)
2. Click the Built-in Reports tab

Generating Reports
Generating a report requires up to three steps: selecting the report, specifying the report
options, and running the report.
To generate a report without changing report settings:
1. On the Insight Toolbar, click the Custom Reports tab (to generate a report you’ve saved
previously) or click the Built-in Reports tab (to generate a built-in report with default
settings).
2. Right-click the report, and choose “Run Report” in the menu that appears.
Tip
All Advanced Reports can be triggered in response to an Alarm. See the section Working With
Alarm Responses on page 92.
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To generate a report with the option to change report settings:
1. On the Insight Toolbar, click the Custom Reports tab (to generate a report you’ve saved
previously) or click the Built-in Reports tab (to generate a built-in report starting with
default settings).
2. Right-click the report and choose “Report Settings…” in the menu that appears.
3. Specify any data settings for the report (varies according to the report type).
4. Click More Options.
5. Specify the date range, print options and export options for the report as desired.
6. Click OK.
7. If you want to save your settings as a custom report, click Save As and enter a name
and group for the report. The group dictates where the report appears in the Custom
Reports tree.
8. Click Run Report.
Tip
You can create a new group when saving the report. Click the Create New Group button and
specify a name for the group.

Note
If you need to print to a network printer, the IRDB service on the Insight server computer must
be set to run using an account that has access to the network printer(s). See your network
administrator if network printing is required.
To export a report to a file:
1.
2.
3.
4.
5.
6.
7.
8.

Select the report you want to export.
Right-click the report and choose “Report Settings…” in the menu that appears.
Specify any data settings for the report (varies according to the report type).
Click More Options.
Click the Export Options tab.
Specify a name and format for the export file.
Click OK.
If you want to save your settings as a custom report, click Save As and enter a name
and group for the report. The group dictates where the report appears in the Custom
Reports tree.
9. Click Run Report. The report is exported then the normal report preview appears.
Tip
If you don’t specify a path, then Insight saves the report in the Advanced Reports folder in the
Insight directory (normally C:\Program Files\Insight\Advanced Reports).

Tip
If you want the exported report to be opened by Microsoft® Word®, then select “HTML” as the
export format, and call the export file “filename.doc”. Adding the .doc extension means the
document will be opened by Word, which can parse HTML files (from Word 2000 onwards).
Tip
If you want to export a report to PDF (Portable Document File) format, then generate the report
to screen, then click the email ( ) button in the Preview Toolbar and choose PDF as the
format.

101

Built-in Reports
Insight ships with a number of built-in reports. As of version 3.2.1.2., there are three main types
of built-in report: door access reports, extended user reports and muster reports.
The door access reports show when doors in the system have been accessed and by whom.
The extended user report shows the name, company and department of a specified set of
users including their photograph. The muster reports show user access within the last 24
hours, and are used to establish the location of all users currently on site at the time the report
is run.
To generate a door access report:
1.

On the Insight Toolbar, click the Built-in Reports
tab and select the type of door access report you
wish to generate. If you’ve created your own
custom door access report, then select it instead
(on the Custom Reports tab).
2. If you want to specify a date range, print or
export the report, right click the report and
choose “Report Settings…”. On the dialog that
appears, click More Options and specify those
settings.
3. Click Run Report.
To generate an extended user report:
1. Select the Extended User Report on the Built-in
Reports tab. If you’ve created your own custom
report based on this report, then select it instead
(on the Custom Reports tab).
2. Right click the report and choose “Report
Settings…”
3. Select the users that should be included in the
report. (Only users who have information in the
First Name, Last Name, Company, Department
or Photograph fields are displayed.)
4. If you want to specify a date range, print or export the report, click More Options and
specify those settings.
5. Click Run Report.

To generate a muster report:
1. On the Insight Toolbar, click the Built-in Reports
tab and select the type of muster report you
wish to generate. If you’ve created your own
custom muster report, then select it instead (on
the Custom Reports tab).
2. Right click the report and choose “Report
Settings…”
3. In the left pane, specify the areas you wish to
run the muster report against.
4. In the right pane, select any muster points you
want to highlight in the report.
5. If you want to specify a date range, print or
export the report, click More Options and specify
those settings.
6. Click Run Report.
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Custom Reports
A custom report contains all of the run-time settings of a report (such as input data and output
format), plus the name of the template that embodies the layout of the report. To change the
physical appearance of the report, you edit the report template. To change what data is fed to a
report and where its sent to, you edit the custom report settings.
To create a custom report:
1.
2.
3.
4.
5.
6.
7.
8.

On the Insight Toolbar, select a report which will form the basis of your custom report.
Right-click the report and choose “Report Settings…” in the menu that appears.
Specify any data settings for the report (varies according to the report type).
Click More Options.
Specify the date range, print options and export options for the report.
Click OK.
Click Save As and enter a name and group for the report
Click Cancel to close the report options window.

To modify a custom report:
1.
2.
3.
4.
5.
6.
7.
8.

On the Insight Toolbar, select a report which will form the basis of your custom report.
Right-click the report and choose “Report Settings…” in the menu that appears.
Specify any data settings for the report (varies according to the report type).
Click More Options.
Specify the print options and export options for the report.
Click OK.
Click Save.
Click Cancel to close the report options window.
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To switch a custom report to a different template:
1. Select the report you want to change.
2. Right-click the report and choose “Report
Settings…” in the menu that appears.
3. Click More Options.
4. Click Browse.
5. Navigate to the report template you want to use.
(Normally in C:\Program Files\Insight\Advanced
Reports).
6. Click Open.
7. Click OK.
8. Click Save.
9. Click OK.
10. Click Cancel to close the Report Options window.

Working With Report Previews
When you generate a report, a preview is displayed in the report preview pane of the Advanced
Reports main window. You can use the preview toolbar to perform additional operations such as
printing or emailing the report.

Using the Preview Toolbar
Go to the first page of the report.
Go to the previous page of the report.
Jump directly to a page of the report.
Go to the next page of the report.
Go to the last page of the report.
Print the current page of the report.
Print all pages of the report.
Send the report via email to a recipient.
Tip
When emailing a report, you can choose to email in a number of formats including PDF, TIFF,
EMF, JPG and text. The default type is a preview file, which can be opened on any computer
that has Insight installed.

Working With Templates
Every report is based on a report template. A report template can be shared between different
reports, and you can have many different report templates. Each report must use exactly one
template.
Insight Advanced Reports ships with a number of built-in report templates to get you started.
You can create your own templates by choosing an existing template, making a copy of it and
modifying it to suit your requirements. Or, you can create a new report template from scratch.
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To create your own report template:
1. Select a custom report (Insight Toolbar→Custom Reports tab) or built-in report (Insight
Toolbar→Built-in Reports tab) that most closely resembles the report you’re trying to
achieve. (If you intend to start a new report from scratch, then you can select any report
you like.)
2. Right-click the report, and choose “Edit Report Style…” in the menu that appears. The
report designer opens and shows the contents of the report template.
3. On the file menu, choose “Save As…” and enter a name for the new template.
4. Click Save.
5. If you’re creating a report from scratch, then select all the objects on the report (press
CTRL+A or choose Select→All from the Objects menu), then press the delete key (or
choose Delete from the Edit menu). Then choose Save from the File menu.
6. Make any changes you wish to your new report template.
7. Choose Save from the File menu.
8. Close the report designer.
Tip
Once you’ve created a new template, you’ll need to modify a custom report so that it uses the
new template. See “to switch a custom report to a different template” on page 104.

To modify an existing report template:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Select a report that uses the template you want to modify.
Right-click the report and choose “Report Settings…” in the menu that appears.
Click More Options.
Click Edit Style. The report designer opens and shows the contents of the report
template.
Make any necessary modifications to the report template.
Choose Save from the File menu.
Close the report designer.
Click OK.
To see a preview of your changed report, click Run Report. If you don’t want to preview
your changes, click Cancel (the changes to your template are preserved).

Note
The built-in templates are marked as “read only”. You cannot directly modify these templates.
To edit a built-in template, first save it with a different name.

Warning
Changes made to a template will affect all reports that use that template. If you want to make
changes to a report without affecting other reports, then save the template under a different
name before making changes, then assign the new template to the report (Report
Settings→More Options→Browse).
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Using The Report Designer
Insight Advanced Reports includes a fully featured report designer for modifying existing reports
or creating new reports. With the report designer you can:
•
•
•
•
•
•

Add formatted text and graphics to your report
Add tables of columnar data with coloured cells, gridlines and text
Add drawing shapes to your report
Add dynamic graphs to your report
Add HTML text to your report
Add Insight data fields to your report

Actions Toolbar

Variables Pane

Objects Toolbar

Preview Pane

Properties Pane
•
•
•
•
•
•

Workspace

The actions toolbar lets you open, save or print the report; cut, copy and paste
elements in the report; align items on the report; and perform other operations on the
report.
The objects toolbar lets you place text, graphics, shapes, graphs, barcodes and other
items on the report.
The variables pane lets you drag Insight data fields onto the report. When the report is
run, these fields are replaced with information from the Insight database.
The preview pane shows a thumbnail preview of the report.
The properties pane shows properties about the currently selected item.
The workspace is where you make changes to the report layout.

For more information on using the report designer, refer to the on-line help (click the help menu
and choose “Contents” in the report designer).
Tip
You can open the built-in report templates to see how they work or to adapt them to your
requirements.
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Insight Archiver (SQL Edition)
Insight Archiver provides a one-click backup solution for your Insight security database. All
database components (including review and panel programming) are archived into a single file
for convenient storage. Insight Archiver can also archive review to a separate file. Backups can
be scheduled to occur automatically or run manually.
Use Insight Archiver (SQL Edition) to:
•
•
•
•

s
s

Backup your database
Restore a previous backup
Move review to an archive
Schedule automatic backups

Insight Versions
Insight Archiver SQL is part of Insight Professional.

Insight Versions
A simpler version of Insight Archiver is part of Insight Lite. Insight Archiver Lite can back up your
entire database to a single file, but cannot schedule automatic backups or move review to a
separate archive.
Backing Up vs. Archiving
You can back up your Insight Database to a file. This creates a copy of all your data, which
can later be restored from the backup file. Your existing database isn’t modified when you make
a backup, and is completely replaced when you restore from a backup.
You can archive the Insight Review to an archive file. This moves review that occurred prior to
a date you specify, and places it in an archive file. If you choose to archive review, Insight
Archiver will create a new archive file for each calendar year. In busy systems, archiving review
is necessary to prevent the database growing too large.
Tip
You can create review filters that extract review from a yearly archive. Open a review window,
and click the Select Review Archive button ( ) in the toolbar.

Note
You cannot create a filter stack in Insight Review that can display review from multiple archives
simultaneously.

To manually create a backup:
1. Ensure the “Backup” radio button is selected.
2. Specify a location for the backup file to be saved. You can navigate to a different folder
easily by clicking the ellipsis (…) button.
3. Click Backup.
4. Your Insight database is archived to a file called “InsightBackup year month day
time.ibu”. For example: InsightBackup 2005 Oct 07 190133.ibu.
Note
If Insight Archiver is set to save or restore a back up to a location outside the Insight installation
folder, then the “NT AUTHORITY\Network Service” account on the Insight ‘server’ machine
needs to have full access to the selected location. See your Network Administrator for
assistance.
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To schedule an automatic database backup:
1.
2.
3.
4.

Click Schedule…
In the screen that appears, tick the “perform scheduled database backup” box.
If necessary, specify the location of the backup by clicking the ellipsis (…) button.
Specify how often to run the backup, and on which days and at what time to perform the
backup.
5. Click OK.
6. A new Insight database backup will be created each time the criteria you entered is
triggered.
Note
Insight Server must be running at the appointed time for a scheduled backup to be performed.

To schedule automatic review archiving:
1. Click Schedule…
2. In the screen that appears, specify the location of the backup by clicking the ellipsis (…)
button. Note that archived review and Insight database backups always occur to the
same directory.
3. Select the “review archive schedule” tab.
4. Tick the “perform scheduled database archive” box.
5. Specify how often to perform the archive, what review should be archived, and on which
days to perform the archive.
6. Click OK.
7. Review will be moved from the “live” database to the appropriate yearly review archive
each time the criteria you entered is triggered.
Note
Insight Server must be running at the appointed time for a scheduled archive to be performed.

To manually restore from a backup:
1. Ensure the “Restore” radio button is selected.
2. Specify the backup file you want to restore from. You can navigate to the file easily by
clicking the ellipses (…) button.
3. If you want to backup the existing database before its overwritten, tick the “Preserve
existing database” check box. The backup is saved into (Insight Directory)\Backups\
PreservedFiles.
4. Click Restore.
5. If Insight Server is running, you will be asked to wait while the Server is stopped.
6. Your Insight database is replaced with the backup.
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Warnings
I. When you restore from a backup, the existing Insight database is deleted and
replaced with the backup.
II. A backup taken with a newer version of Insight must never be restored to an older
version of Insight. I.e. A backup taken with Insight V3.3 must not be restored to
V3.2 or earlier.
III. A backup taken from newer versions of SQL Server cannot be restored to older
versions, regardless of the Insight versions involved. I.e. A backup taken from SQL
Express cannot be restored to any Insight version that is connected to MSDE or a
full-blown SQL Server 2000.

Note
Insight Archiver must be run on the Insight Server computer.
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Insight Licence Manager
Insight Professional requires licence keys to function. These licence keys are stored in the USB
hardware lock that was shipped with Insight Professional.
Use Insight Licence Manager to:
•
•

View installed licence keys
Install and remove licence keys

Serial Number

Licence Keys

Active Remote
Connection

•
•
•

s

The Serial Number identifies your Insight installation.
The Licence Keys determine which features of Insight are available.
The Allow TS and Deny TS buttons and the Allow TS Checkbox are used in
conjunction with “Allow Remote” licences. See the installation instructions supplied with
the Allow Remote license for more details.

Paid Feature
Insight Licence Manager is part of Insight Professional.

Registering Insight Professional
Insight Professional will operate in Professional mode for thirty days from the initial installation
date. During this time, you must contact Inner Range for a permanent Professional licence key.
To register Insight Professional:
1. Choose “About…” from the Help menu of any module.
2. Click the hyperlink that says Click to Register. A new window appears.
3. Click the hyperlink that says Click here for registration form.

Warning
If you fail to register in the 30-day period, Insight will revert to Lite operation. As soon as your
permanent Professional key is entered, Insight will return to Professional operation.

Tip
The Insight serial number is stored inside the hardware key. You can
quickly check the serial number by opening the About box in any module.
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Licenced Modules
Your Insight Professional licence provides unlimited access to the core Insight Professional
modules such as Insight Operators and Insight Schematic. The following features or functions
are licenced separately:
Insight Card Pool
Insight Photo ID
Insight Advanced Reports
Insight Time On Site Reporting
Insight DVR Integration
Insight Dynamic User Import Module
Insight COM Interface
Insight Communicator

Panel Licensing
Insight Professional includes a licence to enrol one panel. To enrol additional panels, additional
licences are required. Contact your Inner Range distributor.
Note: Up to 15 IP Door Controller Panels may be enrolled without additional licenses.

Workstation Licensing
Insight Professional includes a licence to log in from one workstation. To enrol additional
workstations, additional licences are required. Contact your Inner Range distributor.

About Fixed Workstation Licences
When you purchase workstation licences, they are initially “floating”. As soon as an operator
logs on from a new non-server workstation, the licence becomes locked to that workstation. You
can manually “unlock” a licence at the rate of one workstation per week.
To unlock a workstation licence:
1. In Licence Manager, select the workstation whose licence you want to release.
2. Click Remove.

To unlock all workstation licences without waiting one week per licence:
1. Contact Inner Range, who can issue a special key to release all workstation licences.
The key will function for 48 hours from the time of generation.

Remote (Terminal Services) Licensing
Insight Professional supports connections to Insight machines over Windows Remote Desktop
or Terminal Services.
•

The Insight Allow Remote Licence allows connection to an Insight computer on the
network from a remote computer in order to use Insight. The remote computer does not
need to have Insight installed on it.

A Client licence needs to be purchased for each remote connection. For more information,
contact your Inner Range distributor.
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Insight Operators
Insight Operators lets you manage who is allowed to login to Insight, and what privileges they
have within the Insight system.
Use Insight Operators to:
•
•
•
•
•

Create operators
Delete operators
Modify operator privileges
Create “locked down” workstations with reduced privileges
Manage tenancies in multi-tenant systems
Launch Toolbar
Browse Toolbar

Insight Toolbar

Browse Pane

•
•

s
s

The Insight Toolbar lets you select between operators, workstations, operator types
and tenants.
The browse pane displays items you can modify.

Paid Feature
Insight Operators is part of Insight Professional.

Demo Edition
Operator passwords are bypassed in the demonstration version of Insight.
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Working With Operators
Access to Insight modules is restricted to
authorised personnel called operators.
Operators have their own user name and
password. Operators can be assigned
different levels of privilege, which determine
what operations they can perform.
Administrators
Special operators can be created called
administrators. Administrators are like
normal operators, but with permanently
elevated privileges.
Installer
There is only one installer operator in any Insight installation. The installer has all the privileges
of an administrator, plus the ability to create and delete tenants. The installer is invisible to
everyone except the installer.
Task Manager
There is only one task manager operator in any Insight installation. The account is invisible to
everyone except the installer. The task manager is a special non-logon account which executes
any scheduled operation, including:
Scheduled panel time sync (page 39).
Scheduled user expiry (page 47).
Scheduled database archive (page 108).
Scheduled DVR time sync (page 144).
To create an Operator:
1. Click the Operators tab in the Insight Toolbar.
2. Click the “New” button; or press the
Insert key; or right click the browser
pane and select “New Operator…”
from the menu that appears.
3. Enter a unique name for the Operator.
4. Specify a password for the Operator
then retype the password in the
Confirm Password field.
5. Click the “Types” icon, and allocate
Operator Types to the Operator.
6. Click the “Access” icon, and configure
the Expiry and Availability parameters
for this Operator if required.
7. Click OK to save the new Operator.

To delete an Operator:
1. Click the Operators tab in the Insight Toolbar.
2. Right click the Operator and choose “Delete” in the menu that appears; or click the
Operator with the left mouse button, then press the Delete key.
3. Click Yes when asked if you really want to delete the Operator.
Tip
You cannot delete yourself.
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Operator Permissions
To create an Operator you need create permissions on operators. To delete an operator you
need delete permission on the operator.

To suspend an Operator:
You can suspend an operator without deleting them.
1. Open the Operator you wish to suspend.
2. Click the “Disabled” radio button.
3. Click OK. The Operator will not be able to login to any modules.
Tip
You cannot suspend yourself.

Operator Permissions
To suspend an Operator you must have the change permission on the Operator.

Working With Operator Types
Operator Types let you control which
items Operators can see, create,
delete, control and modify.
Once an Operator Type has been
created, you can assign it to Operators.

To create an Operator Type:
1. Click the Operator Types tab in the Insight Toolbar.
2. Click the “New” button; or press the Insert key; or right click the browser pane and
select “New Operator Type…” from the menu that appears.
3. Enter a unique name for the Operator Type.
4. Click the “Permissions” icon, and allocate privileges to the Operator Type.
5. Click the “Log On” icon, and specify which workstations Operators of this type are
permitted to log on from.
6. Click OK to save the new Operator Type.
To delete an Operator Type:
1. Click the Operator Types tab in the Insight Toolbar.
2. Right click the Operator Type and choose “Delete” in the menu that appears; or click the
Operator Type with the left mouse button, then press the Delete key.
3. Click Yes when asked if you really want to delete the Operator Type.
Note
Deleting an Operator Type might prevent Operators from logging in, since an Operator with no
Type cannot login to Insight modules.
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Tip
Operators who are Administrators automatically receive all privileges. You do not have to assign
them any Operator Types.

Operator Permissions
To create a new Operator Type, you must have the create permission for Operator Types. To
delete an Operator Type you must have the delete permission on the Operator Type.

Working With Permissions
Permissions are at the heart of Operator Types.
With permissions, you can precisely control what
an Operator can do in Insight.
There are three pages of permissions in each
Operator Type: sites and panels shows
permissions for all sites, panels, panel
programming and maps. Security shows
permissions for Operators, Operator Types and
Workstations (in other words, the items
manipulated by the Insight Operators module
itself). Defaults shows what permissions will apply to new items that are created in the future.
Insight lets you define what an Operator can do via nine permissions.
Permission
See

Description
The see permission means you can see the item in lists and browser panes.

Inspect

The inspect permission means you can open the item and see how it is
configured.

Change

The change permission means you can modify the item and save your
changes.

Create

The create permission means you can create new items of that type.
Permissions on the new item will be copied from the Defaults page.

Delete

The delete permission means you can delete the item. For panel items like
doors and user types, this permission lets you reset the record to the
unprogrammed state.

Control

The control permission means you can control the item via the Insight Toolbar.

Print

The print permission is not currently implemented.

Export

The export permission means you can export data to a file. It’s currently only
used by the “save panel as template” command in Insight Edit.

Set Perms

The set perms permission is not currently implemented.

Setting Permissions
You grant or deny permissions on a particular item by ticking or clearing the corresponding
checkbox for that item.
The privileges windows are deliberately organised in a tree structure. When you tick an item at
the top of the tree, the tick “ripples” down through the branches of the tree. Thus, ticking “see” at
the top-most site level grants the “see” privilege to all items in the site including sub-sites,
panels, programming items and maps.
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Tip
If you don’t want a tick to “ripple” down the tree, hold down the Control key when you click the
checkbox. The tick will not ripple more than one level down.

Tip
Sometimes, you may want to “ripple” a setting that only makes sense at the lower branches of
the permission tree. For example, you can control doors but not sites. In this case, Insight
provides a special check box with a black border. The purpose of this check box is to provide a
convenient means of turning the permission on and off at a lower level in the tree.

Operator Permissions
To set permissions on an item, you must have the set perms permission on that item. To set
some items, you must also be an administrator.

Working With Module Permissions
With Insight, you can grant or deny Operators access to Insight modules, and you can also
control what actions can be performed within modules. Module permissions are set at the
Operator Type level.
I want to…

Use this permission in the tree (see below)…

Control which alarms an operator
type can acknowledge

Alarm Handler→Alarm Acknowledgement→
(Critical/High/Medium/Low)

Specify whether an operator type can
create, edit and remove Alarm
Responses

Alarm Handler→Alarm Responses→
(Create/Edit/Remove)

Specify whether an operator type can
create, edit and remove Help
Responses

Alarm Handler→Help Responses→
(Create/Edit/Remove)

Specify which Insight modules are
available to an Operator Type

Run Modules→(module name)

To change the permissions for an Operator Type:
1. Double-click the Operator Type you wish to modify.
2. Click Modules.
3. Expand the tree on the right hand pane to locate the item you wish to modify. Ticking an
item grants the permission to all Operators with this Operator Type.
4. Click OK.
Tip
Operators with multiple Operator Types receive the combined permissions of each Operator
Type.
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Working With Workstations
Insight lets you use workstations in two ways.
1. You can specify that certain Operator
Types must log on from designated
workstations.
2. By applying an Operator Type to a
workstation, you can limit the
permissions that are available from
that workstation.
To create a workstation:
1. Click the workstation tab in the Insight
Toolbar.
2. Click the “New” button; or press the Insert key; or right click the browser pane and
select “New Workstation…” from the menu that appears.
3. Enter the name of the workstation, or click the Browse button and select the
workstation from the network.
4. Click OK to save the new workstation.

To delete a workstation:
1. Click the workstation tab in the Insight Toolbar.
2. Right click the workstation and choose “Delete” in the menu that appears; or click the
workstation with the left mouse button, then press the Delete key.
3. Click Yes when asked if you really want to delete the workstation.
To create a “locked down” workstation:
1. Create an Operator Type, and set up the maximum permissions that will be permitted
from your locked-down workstation.
2. Right-click the workstation and choose “Properties…” from the menu that appears.
3. Click the “Operator Type” icon.
4. Click the radio button labelled “Restrict permissions to this operator type”.
5. Select the Operator Type you created.
6. Click OK to save your changes.
Any permission that isn’t granted in the Operator Type will never be allowed on the lockeddown workstation. Any permission that is granted in the Operator Type may be allowed on the
locked-down workstation, depending on the Operator’s normal permissions.
Note
You cannot create or edit Operator Types from workstations that have been locked down.

Warning
It is possible to lock yourself out of Insight completely with this feature. Use it carefully, and
make sure you never lock down your system in such a way that you (the administrator) cannot
change permissions from any workstation.
Operator Permissions
To create a new workstation, you must have the create permission for workstations. To delete a
workstation, you must have the delete permission for that workstation.
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Working With Tenants
Tenants let you ‘divide’ your panel into multiple
groups, so that only parts of the panel are
visible to each group. For example, a shopping
centre might have ten retailers. Rather than
installing one panel per retailer, a single panel
can be used. To prevent retailer A from
tampering with retailer B’s security
configuration, tenants are created so that each
retailer can only ‘see’ their own users, doors,
areas and review.
Tenancy Rules Explained
•
•
•
•
•
•
•
•
•
•

Tenancy rules can be switched on or off. If tenancy rules are off, then all operators can
see all items, subject to the permission rules defined for each operator type (see page
116).
Only the installer operator can turn tenancy rules on or off.
Turning tenancy rules off erases any existing tenancies. All items and operators
become ‘untenanted’.
Only the installer operator can create or delete tenancies.
Only the installer and administrators can modify existing tenancies.
If an item (like a door or an area) isn’t placed in a tenancy, it is visible to all tenants
(subject to the permission rules for each operator type).
Once an item is assigned to a tenancy, it is only visible to installer, all administrators
and any operators in that tenancy.
An item can belong to more than one tenancy.
Operators can belong to multiple tenancies. Operators can ‘see’ any item that belongs
to any of their tenancies - provided, of course, that the operator has the appropriate
permissions (see page 116).
Operators cannot see review entries if any part of the review message is out of their
tenancy.

Warning
Insight Card Pool ignores tenancy rules. Operators will be able to see the names of cardholders
in other tenancies.

How Tenancy Affects Review
•
•

Review messages are visible to the tenants that are common to all items in the review
message. In other words, only operators who can see all of the items in a message can
see the message.
Changing an items tenancy after a review message has been created has no effect on
the review message.
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To enable Insight tenancy rules:
1. You must log in to Insight Operators as installer.
2. Click tenants.
3. Click the “turn tenancy on” button (above the browser
pane).
4. Click ‘Yes’ on the warning screen that appears.
5. Restart the server by logging on to any Insight module.

Warning
Turning on tenancy rules stops the Insight server. All operators will be disconnected.

To disable Insight tenancy rules:
1.
2.
3.
4.
5.

You must log in to Insight Operators as installer.
Click tenants.
Click the “turn tenancy off” button.
Click ‘Yes’ on the warning screen that appears.
Restart the server by logging on to any Insight module.

Warning
Turning off tenancy will remove all items from any tenancies, then delete the tenants. Turning
tenancy rules back on will not restore the deleted tenants.

Warning
Turning off tenancy rules stops the Insight server. All operators will be disconnected.

To create a new tenancy:
1.
2.
3.
4.
5.

You must log in to Insight Operators as installer.
Click tenants.
Click the “New” button.
Enter a name for the new tenant.
Click OK.

To delete an existing tenancy:
1.
2.
3.
4.
5.

You must log in to Insight Operators as installer.
Click tenants.
Select the tenant you want to delete.
Click the “Delete” button.
Click “Yes” on the warning screen that appears.

Note
When a tenant is deleted, any items belonging to that tenancy are removed from the tenancy. If
an item belonged only to that tenancy, then it becomes visible to all remaining tenants.
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To add an operator to a tenancy:
1.
2.
3.
4.
5.

You must log in to Insight Operators as installer or an administrator.
Click operators.
Double-click the operator you wish to modify.
Click tenancies.
Tick the tenancies you want the operator to be a member of.

To remove an operator from a tenancy:
1.
2.
3.
4.
6.

You must log in to Insight Operators as installer or an administrator.
Click operators.
Double-click the operator you wish to modify.
Click tenancies.
Uncheck the tenancies you want to remove the operator from.

To assign an item to one or more tenancies:
1. You must log in to Insight Operators as installer or an administrator.
2. Click tenant.
3. Double-click any tenancy in the browser pane. (If there aren’t any tenancies defined,
you will need to create one first.)
4. Click members.
5. Locate the item in the items tree. Panel items are in the sites branch. Review filters are
in the review branch. Operators and workstations are in the security branch.
6. Right-click the item, and choose “see all tenancies…” in the menu that appears.
7. Tick the tenancy or tenancies that the item should belong to.
8. Click OK. The item will become invisible except to operators sharing one or more
common tenancy.

To make an item visible to all tenancies:
1. You must log in to Insight Operators as installer or an administrator.
2. Click tenant.
3. Double-click any tenancy in the browser pane. (If there aren’t any tenancies defined,
then the item is already visible to all tenants, subject to Operator Type permissions.)
4. Click members.
5. Locate the item in the items tree. Panel items are in the sites branch. Review filters are
in the review branch. Operators and workstations are in the security branch.
6. Right-click the item, and choose “see all tenancies…” in the menu that appears.
7. Uncheck all the boxes in the “belongs to” window.
8. Click OK.
Note
This method always works if you are logged on as installer. It will work for administrators,
provided the administrator can ‘see’ all the tenancies that the item has. If there are additional
tenancies that the administrator cannot see, then the item will remain in those tenancies and
hence won’t become visible.
Tip
Items are visible to all tenancies by default. You only need follow this procedure to remove an
item from all tenancies if you had previously assigned it to one.
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To see which items belong to a tenancy:
1.
2.
3.
4.
5.

You must log in to Insight Operators as installer or an administrator.
Click tenant.
Double-click the tenancy in the browser pane.
Click members.
Items that are ticked in the tree belong to that tenancy.

Tip
The tenancy count shows how many tenancies an item belongs to. If the tenancy count is zero,
the item is visible to all tenancies.

122

Insight Schematic
Insight Schematic allows operators to monitor the status of an installation via an intuitive
interface based around graphical floor plans and site maps. Special icons can be placed on
each map that show the status of hardware items (such as inputs, areas and auxiliaries) in real
time.
Use Insight Schematic to:
•
•
•
•
•
•

Import site plans
Browse drill-downs
Add areas, auxiliaries, inputs, doors, floors and modules to plans
Monitor site activity in real time
View and acknowledge alarms
Control your Inner Range security system
Map Edit Toolbar

Alarm Group

Map
Insight Toolbar

Zone Area

Schematic Toolbar

•
•

Area

Map Item (Door)

The Insight Toolbar lets you manage your sites and panels (page 23).
The map lets you add elements to your map, and to monitor and control these elements
in real time (page 125).
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Working With Maps
To use Insight Schematic, you must first import a map of
your site or buildings.
Note
You cannot create map images with Insight Schematic.
You must create or scan your map with other software,
then import the image file into Schematic.
To import a map:
1. In the Insight Toolbar, click on the site that will
contain the new map. If necessary, create a new
master site or sub-site.
2. Choose “New...” (formerly ”Import Graphic…”) from the Map menu. Alternatively, right
click the site and select “New Schematic Map..” from the context menu.
3. Navigate to the image file you wish to import
4. Click Open.
The map is added to the selected site.
Tip
Several sample maps are installed with Insight, which can be used to familiarise yourself with
Schematic. Navigate to the location where you installed Insight, then look in the “Sample Maps”
directory.
Tip
You can change the scale of a map that you have imported. Select “Zoom…” from the Map
menu or use the Zoom combo box on the Edit toolbar.

Tip
Once a graphic is imported, you can delete or move the original file. Insight stores its own copy
of the image.

Tip
Schematic can open files in the following formats: BMP (Bitmap), JPEG (Joint Photographic
Expert Group), PNG (Portable Network Graphics) and TIF (Tagged Image Format). Pictures in
other formats (including AutoCAD DWG files) must be converted into one of these formats prior
to importing.
To edit a map.
From the Insight toolbar: Double-click the map in the Insight Toolbar to display it. Right-click on
the map to “Show” the map on the screen, “Delete” the map, or edit the map “Properties..”
including name, text format, grid resolution and icon size.
From the “Map” menu: Once a map is shown on the screen, the “Map” menu can be used to
“Delete” the map, “Zoom...” the map to the required size or edit the map “Properties..” including
name, text format, grid resolution and icon size.
e.g. To rename a map:
1. In the Insight Toolbar, right-click the map you wish to rename and choose
“Properties…” in the menu that appears.
2. Enter the new map name.
3. Click OK.
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Operator Permissions
To import a map, you must have the create permission for maps. To delete a map, you must
have the delete permission for that map. To rename a map, you must have the change
permission for that map.
Adding Labels
You can add text labels to your maps. To add labels:
1.
2.
3.
4.
5.

Ensure you are in Edit Mode (select “Edit Mode” from the File menu).
In the Insight Toolbar, click the map you want to add the Label to.
Select the Label tool ( ).
Click on the map where you want to place the label.
Enter the text of your label. The text format (font, style, size and alignment) can also be
edited by selecting the “Text Format” tab.
6. Click OK.
Note that a Label can also be used as a Map Link. See “Creating Drill-Downs” for details.

Adding Alarm Groups
Alarm Groups let you monitor alarms from many sources and display them at a single point on
your map.
To add an Alarm Group to your map:
1.
2.
3.
4.
5.
6.
7.

Ensure you are in Edit Mode (select “Edit Mode” from the File menu).
In the Insight Toolbar, click the map you want to add the Alarm Group to.
Select the Alarm Group tool ( ).
Click the map where you want to place the Alarm Group.
In the Alarm Group properties window, enter a name for the Alarm Group.
In the Site Tree, tick the inputs that you want to add to the Alarm Group.
You can use the “Text Format” tab to edit the font, style, size and alignment of the
Alarm Group name.
8. Click OK.

Working With Surveillance Items
Surveillance items correspond to hardware detectors and devices in your Inner Range system,
and fall into one of two categories.
Point items occupy a single point on the map. These items are usually doors,
auxiliaries, input devices such as door/window reed switches and the like.
Area items occupy shaped regions on the map. These items are usually Inner Range
areas, or input sensor devices such as motion detectors or perimeter beams.

Adding Surveillance Items
You can monitor the status of your installation by adding surveillance items to your maps.
To add point surveillance items:
1. Ensure you are in Edit Mode (select “Edit Mode” from the File menu).
2. In the Insight Toolbar, expand the Site Tree until you reach the item you wish to
monitor.
3. Click the item with the left mouse button, but do no release the button.
4. With the button held down, drag the item onto your map and release the button.
5. The Item Properties dialogue opens to allow the text format and other relevant
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parameters to be edited if required. Make any changes necessary, then click OK.
(While in edit mode, the item properties can be accessed at any time to view &/or edit
by right-clicking on the item.)
6. If necessary, you can fine-tune the placement of the item with the mouse or arrow keys;
and the size of the icon by dragging one of the resizing handles on the corners.
To add area surveillance items:
1. Ensure you are in Edit Mode (select “Edit Mode” from the File menu).
2. If you are placing an area, select the Area tool ( ). If you are placing a zone input,
select the Zone Area tool ( ).
3. Draw the area by clicking on the map. Hold the CTRL key down if you wish to draw
angled lines.
4. To finish the shape, either double-click the mouse button, or click on the first point of the
shape.
5. The Item Properties dialogue opens to allow the relevant item (e.g. Area, Zone Input) to
be assigned to the shape. You must select an item before you can proceed. The
Properties dialogue also allows the text format and other relevant parameters to be
edited if required. Make any changes necessary, then click OK. (While in edit mode,
the item properties can be accessed at any time to view &/or edit by right-clicking on the
shape.)
6. If necessary, you can fine-tune the shape by dragging the resizing handles on the
corners of the image. You can also fine-tune the placement of the shape with the
mouse or arrow keys. New corners can be added to the shape by clicking and dragging
the mouse from anywhere along an existing side of the shape. To remove a corner from
a shape, right-click the desired corner and select ‘Delete Vertex’ from the context menu.
Tip
You can place the same item more than once, either on the same map or different maps.

Tip
You can see which items have been placed on maps via the Map Items window. Select “Map
Items Window” from the View menu.

Tip
You can jump straight to a placed item on any map. Choose “Go To” from the Edit menu.

Tip
You can choose between the two default icon sizes. In the Insight Toolbar, right-click the map
and choose “Properties…” from the menu that appears. Click the Appearance tab, then choose
the icon size you prefer. All icons can also be sized individually.
Tip
When an item is placed, a text caption appears with the item. You can change the position of
the caption, or hide it completely. Right-click the item and choose “Caption” from the menu that
appears.
Tip
When you place items, they are aligned to a “snap” grid. You can change the size of the snap
grid - choose “Preferences…” from the Edit menu. You can disable grid snap - uncheck “Snap
To Grid” in the Edit Menu. You can hide the snap grid - click the “show/hide snap grid” button in
the Schematic Toolbar.
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Operator Permissions
To add, move or delete surveillance items from maps, you must have the change permission on
that map.

Working with Icons
The Insight Schematic image library contains a range of ready-made icons for use with point
items on the Schematic maps. For each category of items (Auxiliaries, Cameras, Doors, Lift
Floors, Inputs, Modules and PTZ Camera Presets) a range of icons are available to illustrate the
different types of item. e.g. The “Doors” category provides different icons for Boom Gates,
Roller Doors, Sliding Doors and Standard Doors.
In the relevant categories such as Auxiliaries, Doors and Inputs, a variation of each icon is
provided for each of the different item states. e.g. The Auxiliaries category has different icons
for Off and On for each type of Auxiliary.
New icons can be added, and existing icons can be edited, by opening the image library while in
edit mode. You cannot create icons with Insight Schematic. You must create or scan your icon
image with other software, then import the image file into Schematic as described below.

Changing an icon.
The icon for a specific point surveillance item can be changed by right-clicking on the item and
selecting “Icon Library” from the context menu.

Adding or editing an icon.
1. Open the image library by selecting “Image
Library” from the Edit menu , or by clicking on
the “Image Library” icon in the “Map Edit”
toolbar.
2. If adding a new icon, click in the
empty name cell in the bottom row.
This will create a new row in the
table for this icon. If editing the
name of an existing icon, click in the
name cell for the icon name you wish
to change.
3. Type in the new name or the
changes.
4. If adding a new icon, click in an
empty image cell for the icon state
you wish to add. If changing the
image for an existing icon, click on
the icon.
5. Click on the browse button that
appears and navigate to the image
file that you wish to use. The file
must have a gif, jpg, jpeg, bmp or
png extension. Select the file and
click “Open”.
6. Repeat step 5 for any additional icons that need to be added or changed.
7. From the “Actions” menu, select “Save Changes”, or if your editing session is complete,
select “Save Changes and Close”.
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Understanding Surveillance Item Status
Insight conveys the status of surveillance items through the use of colour.
Sample

Type

Colour

Meaning

Description

Input

Green

Sealed

The input is in a sealed state.

Input

Red

Alarm

The input is in an alarm state.

Input

Orange

Tamper

The input is in a tamper state.

Auxiliary

Blue

On

The auxiliary is on.

Auxiliary

Grey

Off

The auxiliary is off.

The following symbols may be drawn on top of surveillance items to convey additional
information.
Sample

Type

Meaning

Description

Input

Isolated

The input is isolated.

Auxiliary

Override

The auxiliary is in an override state, and cannot be turned
on or off until the override is ended.

Auxiliary

Not Present

The module containing the auxiliary is not present on the
LAN.

The status of areas and zone areas is displayed using different colours.

Assigned
Unassigned

Assigned
Unassigned

Panel Offline

Panel Offline

Subscription Error

Subscription Error

On
Off
Alarm
Tamper
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Edit Mode

Zone Areas

Surveillance Mode

Surveillance Mode

Edit Mode

Areas

Sealed
In Alarm

(fast flash)

In Tamper

(fast flash)

Had Alarm/Tamper

(slow flash)

Adding Cameras
You can drag a DVR camera onto your map.
To add a camera to a map:
1. Locate the camera in the Insight Toolbar by expanding the associated DVR.
2. Drag and drop the camera onto your floor plan.
Once a camera is placed on a map, you can view live video from the camera in schematic.
To view live video from a camera in schematic:
1. Switch to surveillance mode
2. Right-click the camera and choose “Show Video” in the menu that appears.
Tip
If the camera is a PTZ-enabled model, a PTZ toolbar will be incorporated into the video window.

Note
You can only view live video in schematic. To view historical footage, you must use Insight
Review. See page 146.

Adding Camera Presets
You can drag camera presets for PTZ cameras onto your map.
To add a PTZ camera preset to your map:
1. Locate the PTZ camera preset in the Insight Toolbar by expanding the associated
camera.
2. Drag and drop the preset onto your map. A link is shown to the associated camera.

To activate a preset on your map:
1. Double-click the preset. The PTZ camera will adjust its pan, tilt, zoom and iris to match
the preset.

s

Paid Feature
Adding cameras and camera presets requires a DVR integration licence. Contact your Inner
Range distributor for more information.
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Creating Drill-Downs
With drill downs, you can create maps that link to other maps. For example, a site diagram
could have clickable buildings that open more detailed interior schematics, or clicking a stairwell
could jump to the next floor in an office building. You can create drill-downs quickly and easily in
Insight Schematic.
To create a drill-down:
1. Ensure you are in Edit Mode (select “Edit Mode” from the File menu).
2. If you will be drilling to a different map, ensure that the map has already been imported
into Schematic.
3. Select the Map Link tool ( ).
4. Trace the outline of your drill-down by clicking on the map. The shape you draw will be
the shape that triggers the drill-down. Hold the CTRL key down if you wish to draw
angled lines.
5. To finish the shape, either double-click the mouse button, or click on the first point of the
shape.
6. The Map Link properties page allows the entry or selection of the target for a link. This
can be specified as map coordinates or as a map item. When a map item is selected
as the link target, the map link can reflect the status of the target item in surveillance
mode.

Tip
In Surveillance Mode, you can follow a drill-down by clicking twice. In Edit Mode, you can follow
a drill-down by right-clicking and choosing “Follow Link” in the menu that appears.

Working In Surveillance Mode
Insight Schematic starts monitoring the status of all surveillance items when you activate
Surveillance Mode. You can also control items directly from your floor plan.
To activate surveillance mode:
1. Select “Surveillance Mode” from the File menu.
In a few moments, the state of all surveillance items is updated.

Note
Insight Schematic cannot monitor the status of panels that are not connected. Schematic places
a cross over all point surveillance items that belong to offline panels, and draws all area
surveillance items a dim grey colour.
Alarm Processing
Schematic has a simple alarm reporting and clearing mechanism. Items that go into an alarm or
tamper state flash and change colour.
Point surveillance items go red for alarm and orange for tamper; in addition, the text “in
alarm” flashes while the alarm is active, and “had alarm” if the alarm condition has
passed.
Area surveillance items go red when in alarm, and orange when in tamper; in addition,
the flashing speed halves when the alarm condition has passed.

Alarms will continue to flash, even after the condition that caused the alarm ends. You must
clear alarms from Insight Schematic manually. Alternatively, an alarm or zone map item can be
configured to ‘Automatically Acknowledge’ alarm states and the map item will automatically
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return to the sealed state when the physical input is resealed.
To clear alarms:
1. Right click the item that is in alarm and choose “Clear” from the menu that appears.
The alarm is cleared.
Note
If Schematic is open on more than one workstation then the alarms must be cleared on each
workstation.

Note
Clearing alarms in Insight Schematic does not acknowledge the alarms at the panel. You must
still acknowledge alarms from a Terminal.

Note
Insight Schematic alarms are not related to advanced alarm management in Insight Review.
Clearing alarms in Insight Schematic does not acknowledge alarms in Insight Review.

Note
Insight Schematic must be running when Area alarm events occur, or they will not appear in
Schematic. All other alarm events will be displayed even if they occurred before Insight
Schematic was opened, provided the alarms are still active.
Tip
If a zone input exists in multiple areas, you can choose to only show alarms on the floor plan
when an alarm occurs in one designated area. Right click the zone or zone area and choose
“Area Monitored” in the menu that appears, then choose the area you want to monitor, or
choose “All Areas” to restore normal behaviour.

Controlling Items Within Schematic
You can control field hardware directly from your maps in Schematic including doors, areas,
auxiliaries, home auxiliaries and inputs.
To control an item on a floor plan:
1. Make sure you’re in surveillance mode (File→Surveillance Mode)
2. Right-click the item, and choose a command from the menu that appears.
Operator Permissions
To control an item, you must have the control permission on that item.
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Insight Server Tool
The Insight Server Tool lets you perform advanced server tasks.
Use the Insight Server Tool to:
•
•
•
•

Manually start or stop Insight Server
See who is connected to Insight Server
Disconnect clients who are connected
Configure your modem pool

Insight Server Tool

Starting and Stopping Insight Server
Insight Server normally starts automatically. Insight Lite starts its own internal server when the
operator logs on. Insight Professional starts the server as soon as Windows has loaded (but
before anyone has logged in).
Insight Server is running and accepting client connections.
Insight Server is running, but no connections will be accepted.
Insight Server is stopped. The server will start again if an operator tries to log
on.
To stop Insight Server:
1. Right click the Insight Server Tool and choose “Stop Database” in the menu that
appears.
Note
Stopping the server can take up to one minute.

Warning
If you stop Insight Server, all operators will be forcibly disconnected. All panels will also be
disconnected, and review and alarms will not be received until the panels are reconnected.

To start Insight Server:
1. Right-click the Insight Server Tool and choose “Start Database” in the menu that
appears.
Note
Starting the server can take up to one minute.
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Note
To start the Insight Professional server, the red lamp must be illuminating on the hardware lock,
which must be plugged into a USB port on the server computer.

Viewing Client Connections
You can see which operators are connected to
Insight Server. You can also block connections,
so operators can no longer log on.
To view client connections:
1. Right-click the Insight Server Tool, and
choose “Client Connections…” in the
menu that appears.

To disconnect an operator:
1. Right-click the Insight Server Tool, and choose “Client Connections…” in the menu that
appears.
2. Select the session that you wish to disconnect.
3. Click Stop.
4. In the Module Shutdown window, enter a message that will be displayed on the
Operator’s workstation and also specify how long the message will appear before the
session is terminated.
5. Click OK.

To block new connections:
1. Right-click the Insight Server Tool, and choose “Client Connections…” in the menu that
appears.
2. Tick the “Block new connections” checkbox.
New connections will not be accepted. Note that sessions that have already been established
are not affected.

Configuring Your Modem Pool
You can choose which modems on the server computer are available for incoming and outgoing
Insight connections. See Modem Blocking on page 38.
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Insight Photo ID
Insight Photo ID lets you design and print employee identification tags and badges.
Use Insight Photo ID to:
•
•

Design one or more ID badge layouts for your organisation
Print employee ID badges

Photo ID
Toolbars

Launch Toolbar

Database Fields

Photo Field

Image Field

Text Fields

•
•

s

The Photo ID Toolbars let you quickly customise and print ID badges.
The field elements define how your ID badge looks and prints.

Paid Feature
Photo ID is a separately licensed add-on to Insight Professional.

Using the Photo ID Toolbar
Open the template management window.
Save the current card template.
Print one or more ID badges based on the current template.
Open the template properties window.
Open the field management window.
Open the about window.
Selection tool.
Add an image field.
Add a photograph field.
Add a database field.
Add a text field.
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Underlying Concepts
Printing ID badges is a two step process. First, you must design a card template. The card
template lets you choose how the ID badge will look, including any graphics and text that will
appear on the card, and what fonts and colours will be used. You can create as many different
card templates as you like, each with a different layout.
Once a template has been created, it can be used to print a batch of ID cards. To print cards,
you first select the users who will be issued with badges, then issue the print command.
Working With Card Templates
With Insight Photo ID you can add, remove and modify card templates. A card template stores
the layout of an ID card including any text, images or watermarks that appear on the card.
To create a new a card template:
1. Choose “Open…” from the File menu, or press
CTRL+O, or press the Open button on the Photo
ID toolbar ( ).
2. Click the “Add New” button.
3. Specify a name for the template, and specify the
size of the card.
4. Edit and save the template.

Tip
To create a new template based on an existing card layout,
select the existing template and click “Copy” instead of
“Add New”.

To delete a card template:
1. Choose “Open…” from the File menu, or press CTRL+O, or press the Open button on
the Photo ID toolbar ( ).
2. Select the template you wish to delete.
3. Click “Delete”.

Warning
Deleting a template is permanent. You cannot restore a deleted template.

Tip
Deleting a template does not delete the employees that are using that ID badge.

To modify an existing template:
1. Choose “Open…” from the File menu, or press CTRL+O, or press the Open button on
the Photo ID toolbar ( ).
2. Select the template you wish to modify.
3. Click “Select”. You can now modify the template.
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To print ID badges based on a template:
1. Choose “Open…” from the File menu, or press CTRL+O, or press the Open button ( )
on the Photo ID toolbar.
2. Select the template you wish to modify.
3. Click “Select”.
4. Choose “Print Cards” from the File menu, or press the Print button ( ) on the Photo ID
toolbar.
5. Select the employees you want to print.
6. Click the print button.

Tip
To select a range of adjacent employees, click the first employee, hold down the shift key, then
click the second employee. To select non-adjacent employees, hold down the Ctrl key, then
click the employees you want.

Designing Card Templates
Card templates are made up of text, images, database fields and user photographs. Text and
images are the same on every card in a batch. They form the “layout” of the card. Database
fields and photographs are different for each employee. They form the “information” on the
card.
To add text to a template:
1.
2.
3.
4.
5.
6.
7.

Select the template you want to work with, or create a new template.
Click the “Add Text Field” button in the toolbar ( ).
Click and drag the mouse in a rectangle shape where you want the text to appear.
In the window that appears, enter the text that you want to place on your card.
Click the “Font” button, and specify a font (typeface), size and colour for the text.
Specify any other attributes for your text, such as alignment and orientation.
Click OK. When cards are printed, the text you entered will appear on every card.

Note
You must specify a font every time you add text to a card.

Tip
If the text is “chopped off”, then you need to increase the size of the text rectangle. With the
selection tool ( ), click the text on your card layout and drag the selection handles to make the
rectangle bigger.
Tip
To change the text, font or colour, double click the text with the selection tool ( ).

Tip
To create vertical text, tick the “Rotate text 90?” box in the text properties window.
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To add images to a template:
1. Select the template you want to work with, or create a new template.
2. Click the “Add Image Field” button in the toolbar ( ).
3. Click and drag the mouse in a rectangle shape where you want the image to appear.
You can resize the image later if you want.
) and navigate to the image.
4. In the window that appears, click the browse button (
5. Click OK. When cards are printed, the image you placed will appear on every card.

Tip
To change the size of an image, click on it once, then drag one of the selection handles that
appear around the image.

Tip
To rotate an image, tick the “Rotate Image 90?” box in the image properties window.

To add database fields to a template:
1.
2.
3.
4.
5.
6.
7.

Select the template you want to work with, or create a new template.
Click the “Add Database Field” button in the toolbar ( ).
Click and drag the mouse in a rectangle shape where you want the text to appear.
In the window that appears, choose the database field that you want.
Click the “Font” button, and specify a font (typeface), size and colour for the text.
Specify any other attributes for your text, such as alignment and orientation.
Click OK. When cards are printed, the information for each employee will replace the
field.

Note
You must specify a font every time you add a database field to a card.

Tip
To change the font or colour, double click the database field with the selection tool ( ).

Tip
To create vertical text, tick the “Rotate text 90?” box in the text properties window.

Tip
To place a barcode on your ID card, use a barcode font such as “3of9.ttf”. Remember that
barcode readers expect an asterisk as the first and last character in a barcode.

To add employee photographs to a template:
1. Select the template you want to work with, or create a new template.
2. Click the “Add Photograph Field” button in the toolbar ( ).
3. Click and drag the mouse in a rectangle shape where you want the photograph to
138

appear. You can resize the photograph later if you want.
4. If you want a border around the image, tick the “border around photograph” box.
5. If you want to rotate the photograph 90 degrees clockwise, tick the “rotate photograph
90” box.
6. Click OK. When the card is printed, the employee photograph will appear on the card.

Note
You must assign a photograph to an employee with Insight Edit before it will print on their ID
card. See page 63.

Tip
To quickly add text, images or database fields to a card layout, select “Manage Fields” from the
Define Photo ID menu, or click the field management button ( ) in the toolbar.

Editing Card Templates
You can make changes to existing card templates with Insight Photo ID.
To move text, images, database fields or photos:
1.
2.
3.
4.

Select the template you want to work with, or create a new template.
Make sure the selection tool ( ) is selected by clicking it in the toolbar.
Click the text, field or image you wish to move. Selection handles appear on the item.
Click the item again and drag it to a new location.

Tip
If you can’t select an item because it is ‘underneath’ another item, then move the top item out of
the way, or right click the top item and choose “make last” in the menu that appears.

Tip
You can make fine adjustments to the location of an item by tapping the arrow keys on your
keyboard while the item is selected.

To resize text, images, database fields or photos:
1. Select the template you want to work with, or create a new template.
2. Make sure the selection tool ( ) is selected by clicking it in the toolbar.
3. Click the text, field or image you wish to resize. Selection handles appear around the
item.
4. Click one of the selection handles and drag it to a new location.

To edit the properties of an item:
1. Select the template you want to work with, or create a new template.
2. Make sure the selection tool ( ) is selected by clicking it in the toolbar.
3. Double-click the text field or image you wish to edit.
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Insight DVR Integration
Insight DVR Integration allows operators to control Digital Video Recorders and cameras within
Insight, including the ability to view live and historical video feeds.
Use Insight DVR Integration to:
•
•
•
•
•

Attach DVRs and cameras to Insight
View live and historical video feeds directly in the Insight workspace
Remotely control PTZ cameras
Access recorded video information based on review events
Switch cameras and video feeds based on custom real-time triggers
Selected Camera Feed
(yellow border)

Camera
Feeds
Insight
Toolbar

DVR
Control Bar

Camera
Pan/Tilt

•
•
•
•
•

s

Camera
Zoom/Focus/Iris

Timeline
Controls

Playback
Controls

Layout
Controls

The Insight Toolbar lets you open video feeds and send control commands
The camera pan/tilt and zoom/focus/iris controls let you control PTZ cameras
The timeline controls let you locate previously recorded footage
The playback controls let you switch between live view and recorded playback modes
The layout controls let you arrange your video feeds and OSD (on-screen display)

Paid Feature
Insight DVR integration must be licensed separately. Insight DVR integration requires Insight
Professional.
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About Insight DVR Integration
Insight provides true integration with an ever expanding range of Digital Video Recorders. You
can choose to view live and recorded camera images directly within Insight. You can control
PTZ cameras including pan, tilt, zoom and iris. You can also issue commands directly to
cameras and DVRs.

DVR Plugins installer.
Insight DVR Integration is constantly being updated to add new DVR models to the range of
DVRs supported by Insight. New DVR models added since Insight version 3.2 release are no
longer automatically installed with an Insight installation or upgrade.
To add support for new DVR models, you need to run the Insight DVR Plugins installer program
separately on both the server and all client PCs requiring DVR services.
This installer first runs a setup wizard which lists the models available and allows you to select
the specific DVR model/s that your system is required to support.
To add a DVR (quick guide):
1. Check the list of supported DVRs on the Inner Range web page to make sure your
model is supported. If necessary, run the DVR Plugins installer to add DVRs that have
been added to the range of supported products since Insight V3.2.
2. Set up the DVR and cameras according to the documentation that came with your DVR.
3. Enrol the DVR into Insight (page 142).
4. If you are using Insight Schematic, you can drag cameras and camera presets onto
your building floor plans (page 129).
5. If you are using Insight to manage alarms, you can customise your alarm responses to
display camera footage (page 95).
6. If you are using a dedicated monitor or hardware multiplexer, you can use Insight to
remotely control the DVR whilst watching video feeds on your monitor (page 148).
7. You can view video feeds and remotely control cameras directly in Insight (page 143).

Enrolling A New DVR
You must enrol a new DVR into Insight before you can control cameras or view video feeds.
To enrol a new DVR:
1. Start any Insight module that uses the Insight Toolbar (Edit, Review or Schematic).
2. In the Insight Toolbar, make sure the Browser tab is selected.
3. Decide which site you want to attach the DVR to, or create a new site if necessary. (The
decision of which site is unimportant, since it has no affect on DVR integration.)
4. Right click the site that will contain the DVR, and choose “New Digital Video
Recorder…” in the menu that appears. (Note: requires a licence.) The DVR wizard
appears.
5. Follow the on-screen prompts. The enrolment procedure varies slightly between brands
and models. This is because there is no industry standard governing DVR design and
manufacture. You will probably need to refer to the documentation that came with your
DVR.
Note: the MCI interface is the interface used to issue commands to the DVR. The
video streaming interface is the interface used to view camera feeds in Insight. You
can choose not to configure the video streaming interface, but the MCI interface is
necessary to interface with the DVR.
6. On the Cameras page, specify the type and number of cameras connected to the DVR.
(For some models, this is populated automatically.)
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•
•
•

The name can be any name that meaningfully identifies the camera.
To set the camera type (Fixed or PTZ), click the entry twice.
The camera number should match the camera number assigned by the DVR
software.

7. On the DVR Associations page, specify the area and/or other panel item/s that you wish
to associate with each camera. Insight V3.3 or later now allows a camera to be linked
to multiple panel items, no longer just an area.
•

The camera can be associated with one or more panel items. e.g. Area, Doors,
Inputs, etc. Right-clicking a review event in Insight Review that contains the item,
allows you to jump directly to live footage from this camera.

To un-enrol a DVR:
1. Start any Insight module that uses the Insight Toolbar (Edit, Review or Schematic).
2. In the Insight Toolbar, make sure the Browser tab is selected.
3. Right click the DVR, and choose “Delete” in the menu that appears.
To edit DVR settings including configured cameras:
1. Start any Insight module that uses the Insight Toolbar (Edit, Review or Schematic).
2. In the Insight Toolbar, make sure the Browser tab is selected.
3. Right click the DVR, and choose “Properties…” in the menu that appears.
Note
If you add, remove or reassign cameras with your DVR software, you must update the DVR
properties in Insight.

Working With Video Windows
To see camera footage, you have to open a video window (also called a software video
multiplexer). When video windows are created, they show the footage from one camera (either
live or historical). You can change the layout of a video window to show more than one camera.
Regardless of how many cameras are being displayed, the time line of the video window is
always synchronised. This means that the view from each camera will always show images
from the same time period. If you rewind to a particular date and time, then the video window
will show what each camera recorded at that time. If you switch to live footage, then each
camera in the video window will show live footage.
You can open multiple video windows. Each video window can have multiple cameras. Each
video window has its own time line, so you can (for example) show live camera feeds in one
window and historical feeds (of the same or different cameras) in another window.
To open a new video window:
1. In Insight Review, select the Control tab of the
Insight Toolbar.
2. Right click a video camera in the tree, and
choose “Show Video” in the menu that appears.
A new video window is opened.
Tip
You can add additional cameras to the window. See working with layouts on page 147.
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Tip
You can switch to a different camera without creating a new video window. Simply drag the new
camera from the Insight Toolbar and drop it onto the video window.

To assign cameras to a video window:
1. Click the video window you want to add cameras to, and make sure the layout contains
the number of cameras you want to add (page 147).
2. In the Insight Toolbar, make sure the Control tab is selected.
3. Drag cameras from the Insight Toolbar and drop them onto the appropriate panels in
the video window. Video feeds are added and synchronised to the time line of the video
window.
Synchronising DVR Date/Time
You can synchronise the DVR date and time so that it’s the same as Insight Server.
Synchronisation can be performed manually, or scheduled to occur automatically at specified
intervals.
To manually synchronise the DVR date and time:
1. In the Insight Toolbar, right-click the DVR you want to synchronise and choose
“Properties…” in the menu that appears.
2. Click the DVR Time Zone tab.
3. Specify the time zone where the DVR is located.
4. Click Synchronise DVR Now.
To automatically synchronise the DVR date and time with Insight Server:
1. In the Insight Toolbar, right-click the DVR you want to synchronise and choose
“Properties…” in the menu that appears.
2. Click the DVR Time Zone tab.
3. Click the Schedule button.
4. Tick the “Schedule DVR Time Synchronisation” box.
5. Specify how often you wish to synchronise the DVR with Insight Server.
6. Click OK.
Note
When synchronising, the DVR date and time is changed to match the date and time of Insight
Server.

Note
For synchronisation to occur, Insight server must be running.

Working With The DVR Control Bar
The DVR Control Bar lets you manage your cameras. You can switch between live and archival
footage, change the time code of the video window and change the number of cameras
displayed. For PTZ cameras you can pan, tilt, zoom, iris and focus the camera by remote
control or activate a camera preset.
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Camera
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Playback
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Layout
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Controlling PTZ Cameras
You can remotely control compatible PTZ cameras from
the DVR Control Bar.
To control a PTZ camera:
1. In the video window, click the camera you want to control. The selected camera is
enclosed by a yellow rectangle.
2. Make sure the DVR Control Bar is visible (View→DVR Control Bar)
)
3. Make sure the video window is in live video mode (click
4. To pan the camera, click the left and right arrow controls ( and ).
5. To tilt the camera, click the up and down arrow controls ( and ).
6. To zoom the camera, click the zoom + and zoom – buttons.
7. To focus the camera, click the focus + and focus – buttons.
8. To adjust the iris of the camera, click the iris + and iris – buttons.
Some PTZ cameras support a “tour” mode, where the camera automatically tracks over a preset
path.
To put a PTZ camera into tour mode:
1. Click the video window containing the camera you want to control.
2. Make sure the DVR Control Bar is visible (View→DVR Control Bar)
)
3. Make sure the video window is in live video mode (click
4. Click the tour button (

). The camera enters tour mode.

Tip
To exit tour mode, click the tour button a second time, or click one of the pan/tilt/zoom/focus/iris
buttons.
Some cameras can be programmed with presets. Activating a preset sets the zoom, focus, iris,
tilt and zoom to a known position. Use your DVR software to program your camera presets.
To activate a PTZ camera preset:
1. Click the video window containing the camera you want to control.
2. Make sure the DVR Control Bar is visible (View→DVR Control Bar)
)
3. Make sure the video window is in live video mode (click
4. Click the preset button (
). The preset controls appear.
5. Enter the preset number you wish to activate.
6. Click Go. The camera moves to the selected preset.
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Tip
You can also activate camera presets in Insight Schematic. See page 129.

Working With The Video Timeline
Each video window maintains a video timeline. The
timeline applies to all cameras in the window. For
example, if you add 5 cameras to a video window, then set
the time line to March 15 at 10am, then each camera will
show archival footage from March 15 at 10am.
The time line is ignored if the video window is showing live
footage.

To view live footage:
1. Click the video window containing the cameras you want to switch to live feed.
2. Make sure the DVR Control Bar is visible (View→DVR Control Bar)
3. Click the live video button ( )
The live video button turns red, indicating you are watching live video.
Tip
This only applies to cameras in the active video window. Other video windows are unaffected.

To view archival footage:
1. Click the video window containing the cameras you want to see
archival footage for.
2. Make sure the DVR Control Bar is visible (View→DVR Control Bar)
3. In the Video Timeline box, enter the date and time in the Date/Time
box, or click the calendar button and select a date, then drag the
slider control to set the time.
The live video button turns blue, indicating you are watching archival video.
To set the time code to a review event:
1. Make sure the video window containing the cameras you want to see is open. If
necessary, create a new video window and assign cameras to it.
2. Open the review window containing the review message. Make sure the video window
isn’t completely obscured by the review window.
3. Drag the review event and drop it onto the video window. The time code is changed to
match the date and time of the review event.
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To control playback of archival footage:

1. Enter playback mode (see “to view archival footage”, above).
2. Use the video playback controls described below.
Play forward (normal speed)
Play backwards (normal speed)
Freeze current frame
Play forward (high speed)
Play backwards (high speed)
Advance forward one frame
Advance backwards one frame
Freeze current frame

Working With Layouts
You can show up to sixteen cameras in a single video
window. Each camera is synchronised with the time controls
for the video window.
To change the layout of a video window:
1.
2.
3.
4.
5.

Click the video window you want to change.
Make sure the DVR Control Bar is visible (View→DVR Control Bar)
Make sure the Layouts tab is selected.
Click a new layout.
Drag cameras from the Insight Toolbar onto the new layout.

Note
If you switch to a layout with fewer cameras than the current layout then Insight will discard any
leftover cameras. You can always add the cameras again by dragging them from the Insight
Toolbar and dropping them on the layout.
Insight can superimpose an On-Screen Display (OSD) for each camera in a video window. The
OSD shows the name of the camera.
To activate the OSD for a video window:
1. Click the video window you want to change.
2. Make sure the DVR Control Bar is visible (View→DVR
Control Bar)
3. Make sure the OSD tab is selected.
4. Tick or clear the Show Camera Name box.
Tip
Turning on the OSD effects all cameras in the current video window.
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Sending Commands To A DVR Or Camera
You can send a model-specific command to a DVR or camera. Right-click the DVR or camera,
and choose “Commands” in the menu that appears.
Note
The commands available will be specific to the make and model of your DVR and/or camera.
Consult the documentation that came with your equipment for more information.

Integration With Review
You can set the time code of a video window to the time and date of a review event. In other
words, if a particular review entry occurs on February 28 at 3pm, you can quickly see camera
footage from this date and time. See page 146.
You can associate cameras with areas. Right-clicking on a review event that contains the area
enables you to see live video from the associated camera.

Integration With Schematic
You can place cameras and camera presets directly onto your floor plans in Insight Schematic.
See page 129.

148

Insight Dynamic User Import Module
The Dynamic User Import Module (formerly the Hotel PMS Interface) enables automatic user
programming of a Concept panel based on an output file from a third party system. Whilst this
module was initially conceived for use with a Hotel's Property Management System, the Insight
Dynamic User Import Module can also be applied to Commercial and Industrial applications with
its ability to take output from other ERP/HR Systems and update user programming in Insight
and Concept panels accordingly.

s

Paid Feature
Insight Dynamic User Import Module is a separately licenced module and requires Insight
Professional to run.

The Dynamic User Import Module is an application that runs in conjunction with Insight. It must
be set up to work with the panel(s) in the system before it will run properly.

Setting up the Dynamic User Import Module
Before attempting to set up the Dynamic User Import Module, it is recommended that the panel
or panels have been programmed first. The key panel items relevant to this module are:
•
•
•
•

Panel Name(s)
Number of users to be serviced - this will determine the memory configuration in the
panel as well as the User Range specified in the Dynamic User Import Module
Type of cards used for access
User types - When importing .INI files from a Hotel PMS, a User Type must be set for
each floor the panel will service. When importing .CSV files from ERP/HR systems,
User Types in the panel must match User Types that will appear in the .CSV file.

To Set Up the Dynamic User Import
Module:
1. Run the User Import Application.
This is done by selecting “Dynamic
User Import” from Insight’s Start
menu (Start→All Programs→Inner
Range→Insight→Dynamic User
Import Module)
2. The Dynamic User Import Module
in the
should appear as , or
system tray.
3. Right click on the icon to bring up a
contextual menu. Choose ‘Setup’
from the menu.
4. You will be prompted to log in. Log
in as installer to enter setup.
5. Enter the settings required by the
Dynamic User Import Module (see below).

Operator Permissions
To access the Setup dialog, the Installer user must be the currently logged-in user in Insight!
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Login Tab
Item

Description

Operator Details

Sets the Insight Operator account which will be used to
process the data files.

Folder to Monitor

This is the folder where the Dynamic User Import Module will
monitor for data files from the third party system. The default
location is the “CMS Monitor files” folder within Insight.

Tip
The user specified in Operator Details should be set up specifically for use with the Dynamic
User Import Module only and limited to having SEE permissions on panel items and CHANGE
permissions on users. When the Dynamic User Import Module processes data and
adds/changes user details in Insight, this appears next to the corresponding item in Insight
Review.
Options Tab
Item
Import Type

Description
This tells the Dynamic User Import Module which kind of files to
look for.
Windows INI File: Version 1 of Hotel PMS Tool format (see
section on page 154). Use this format when interfacing with a
Hotel PMS and where Room Numbers are part of the User data.
CSV File: Version 2 of Hotel PMS Tool format. This CSV file
format follows the same rules as import of extended user
information in Insight edit (see page 60). Use this format when
interfacing with ERP and HR systems.

Card Type

Select a radio button to match the type of access cards
programmed in the panel.

Card Pool for Cards

When importing user programming via a CSV file, the card
numbers and/or card allocation can be automatically entered
into the Card Pool system, assuming the Insight installation has
a valid Card Pool licence.
The type of the card pool selected in this dialog must match the
type of card specified in the user programming in the CSV file.
No action is taken if the Card Pool specified does not match the
type of card specified in the user programming in the CSV file.
For example if the Card Pool specified is a Site Code Card Pool
and the user programming indicates a Direct Entry Card Pool,
then no cards are assigned.

Lookup

This sets the type of Lookup Key that is used in the floor Lookup
Table tab in this Setup dialog. Numeric values are used if this
option is unchecked.
When interfacing with a Hotel PMS and importing data using .INI
format, use numeric keys. This links a floor (derived from the
guest's room number) with a matching User Type in the panel.
When interfacing with a system using .CSV format, use
Alphabetical keys. In this case, a User Type defined in the
.CSV file is linked to a particular User Type in the panel.

Room Digits
(Not applicable when using
Alphabetical keys)
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The number of digits to remove from the room number to get the
floor number (key value). For example, if room 12 on the 4th
floor was designated Room 412, Room Digits should be set to
2.

Note
When using CSV files, specific items of programming for a user can be cleared by populating
the field(s) with the entry, <blank>. The <blank> entry cannot be used for the following fields:
PIN, First Name, Second Name, Gender, Date of Birth, Card Number.

Panels Tab
The Dynamic User Import Module needs to know which panel(s) is/(are) servicing the
installation.
Item

Description

Properties

Allows settings for the selected panel to be viewed and
changed in the Dynamic User Import Module setup file.

Remove Panel

Deletes the selected panel from the Dynamic User Import
Module setup.

Add Panel

Used to add panels to the list that the Dynamic User Import
Module will deal with. Selecting this button will bring up a
dialog which is explained below.

Adding Panels in the Panels Tab:
Panel Name: Type the panel name in this field.
(The panel must already exist in the system). The
Panel Name field must exactly match the name of
the Panel as shown within the Insight Edit module.
Virtual Panel: If this item is checked, the panel
shows up in the Select Panels pane as a virtual
panel (which must already exist in the system).
User Range: This setting refers to the range of user numbers to use in the panel. Each of the
"Card Only User" settings are in blocks of 8000 user numbers.
•
•
•
•
•
•

For up to 4000 Users with User Number in the range of U0001 to U4000, select
"Card/Pin Users(57)". This would be the typical setting on a 128k panel (where built-in
memory configurations allow a maximum of 2000 users).
For up to 8000 Card Only Users with User Number in the range of U0001 to U8000,
select "Card Only User(186)". This setting would normally only be selected for a 512k
panel or an IP Door Controller.
For up to 8000 Card Only Users with User Number in the range of U8001 to U16000,
select "Card Only User(187)". A 512k panel is required for this setting and beyond.
For up to 8000 Card Only Users with User Number in the range of U16001 to U24000,
select "Card Only User(188)".
For up to 8000 Card Only Users with User Number in the range of U24001 to U32000,
select "Card Only User(189)". This setting and beyond would require a 512k panel with
a custom memory configuration.
For each bank of 8000 User Numbers beyond U32000, select the appropriate "Card
Only User" option.

Warning
If the setting of User Range exceeds the amount of users available in the Panel (based on
memory size and configuration, for instance, choosing a "Card Only User" setting on a 128k
panels, which, by default do not support Card Only users), the Dynamic User Import Module
may successfully process the setup file, but will report an error when processing files to add
users.
User Index: This setting determines an index number from which the module starts adding users
in the panel. For instance, if the User Range is set to "Card Only User(187)" (which means that
User Numbers of 8000-16000 are used in the panel) and the User Index is set to 10, the first
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User Number that the Hotel PMS Tool will use in the panel is U8011.
Tip
Where the User Range includes U0001-U4000, it is recommended that User Index is set to at
least 3 to avoid inadvertently overwriting the user programming for the MASTER and
INSTALLER users.

Lookup Table Tab
Lookup tables are required for the Dynamic User Import Module to link a hotel floor in an .INI file
to a User Type in a panel (for Hotel PMS) or to match a User Type in a .CSV file (typically from
an ERP/HR system) to a User Type in a panel.
The Dynamic User Import Module Setup dialog will create a lookup table for each of the panels
defined in the Panels tab.
To see and edit properties in a lookup table, left-click the lookup table, then select the Edit…
button. This will open the Lookup Properties dialog for the selected lookup table. Alternatively,
double clicking a lookup table will also open the Lookup Properties dialog.
The Lookup Properties dialog shows the
existing lookup values for a panel. The values
display which User Type in a panel is
associated with a particular floor (for .INI files)
or external user type (for .CSV files).
Lookup Properties Item

Description

Key Value

The Hotel Floor or User Type found in the external data file

User Type

The User Type in the panel that corresponds to the Key
Value

Panel

The panel this User Type belongs to.

From this dialog, the user can add, edit, and delete lookup items for a panel.
When the Add or Edit buttons on the Lookup Properties dialog are pressed, the Lookup Item
dialog appears:
An explanation of the different Lookup Item dialog properties is shown below.
Item

Description

Filter Name

This field is displayed as the Key Value in the parent dialog.
When importing using .INI files and using room numbers, the
Key Value is typically the floor number.
When importing using .CSV files, the Key Value is usually
exactly the same as the User Type Name.
The Key Value must be unique within the lookup table!

User Type Name

In this field, enter the User Type defined in the panel that
corresponds to the Key Value in the Filter Name field.

Panel Name

Select the panel to which this User Type belongs to.
Remember that lookup tables are created for each panel in
the system, so all items within a lookup table should relate to
one panel only.

Note
Whilst Filter Name/Key Values must be unique within a table, many Key Values may
be associated with a single User Type in the panel.
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Note
Entering a single asterisk, "*" in the User Type Name field tells the Dynamic User Import Module
that there is no User Type associated to this Key Value. With the exception of, "*", the entry in
this field must have a matching entry in the panel.
Working with the Dynamic User Import Module
Once the Dynamic User Import Module is set up, it should be ready to work with. Immediately
after the Setup dialog for the PMS Interface has been closed, the Dynamic User Import Module
icon in the system tray will be displayed as a red , indicating the Interface is stopped. The
operator then needs to start the Dynamic User Import Module to get it to monitor for new data
by right clicking on the icon in the system tray and selecting Run from the contextual menu.
The icon in the system tray indicates the status of the Dynamic User Import Module. The
meanings of the different icons are shown below:
Icon

Colour

Meaning

Yellow

Ready

Green

Processing Records

Green

Checking Setup or
Incomplete Setup

This icon will appear briefly just after the Operator
starts the Dynamic User Import Module. If the setup
file is correctly processed, the icon will be replaced
with the “Ready” icon shortly after the Dynamic User
Import Module is started.
If the icon remains in this state, it means that the
Dynamic User Import Module couldn’t process the
setup file for some reason.

Red

Stopped

The Dynamic User Import Module has been stopped
and is not checking for new data files.

The Dynamic User Import Module is running and is
ready to process data from third party source.
The Dynamic User Import Module is processing
records from the third party data source and is
updating Insight with this new data.

Right clicking the Dynamic User Import Module icon in the system tray reveals a contextual
menu with a number of options:
Stop: Selecting Stop from the contextual menu will cause the PMS Interface to
stop. The system tray icon will change to red in colour , indicating that the
Dynamic User Import Module is not operating.
Run: When Run is checked, the system tray icon will change to yellow in colour ,
indicating that the Dynamic User Import Module is ready to use. It will then
monitor the folder nominated in the Setup for new files and process new files as it
sees them.
Test: Selecting this item opens a dialog where the Dynamic User Import Module can be quickly
tested. The operator can test the addition of a guest as well as test the removal of a guest. Test
should only be chosen after the panel(s) is/(are) setup in Insight, and the Dynamic User Import
Module has been configured accordingly using its setup dialog.
Note
The Test option will only be enabled if the Hotel PMS Tool is set to process .INI files. See the
online help for more information.
Setup: This item, when selected, opens a dialog which lets the operator setup the Dynamic User
Import Module with panels, virtual panels and lookup tables. To open the Setup dialog, Installer
must be the current logged in user.
About: If this item is selected, an About dialog appears with information about the Dynamic User
Import Module such as version details.
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Exit: Selecting this item stops and closes the Dynamic User Import Module and the icon is
removed from the system tray.
Sending data files to the Dynamic User Import Module
1. Ensure that the Dynamic User Import Module is running and ready to accept data.
2. The third party system should be set up to output data files in a format that matches the
settings applied to the Dynamic User Import Module.
3. The third party system should output files with incrementing file names each time a new
data file is created (e.g.: DATA0000001.csv, DATA0000002.csv, etc.).
4. The data files need to be dropped into the location nominated in the set up for the
Dynamic User Import Module.
5. When the Dynamic User Import Module is running and it sees a new data file, its icon in
to indicate that it is processing records. These records
the system tray will change to
are passed to Insight, which then passes the user programming changes to the
panel(s).
6. Once the Dynamic User Import Module has completed processing of the data file, its
icon will revert to . The Dynamic User Import Module will then remove the data file it
has just processed.

Hotel PMS INI File Format
When importing .INI files, the data must be in the following format:
Guest Name, Room Number, Site Code, Check-out
Each record is on a new line in the file.
Field

Data

Guest Name

any text, e.g.: "Rodrigo Rodriguez"

Room Number

any text, e.g.: "207"

Site Code

Site Code / Card number, e.g.: "6702FF0000"

Check-out

Date/Time in one of the following two formats:
dd mon yyyy hh:mm

e.g.: "27 jan 2007 10:59"

dd/mm/yyyy hh:mm

e.g.: "27/01/2007 10:59"

Note
In both date formats, a single space character separates the date from the time.

Note
In the first date format, a single space character separates date components.

Note
Additionally, in the first date format, the month component is alphabetical. The Dynamic User
Import Module will parse the first three letters of the month component.
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Appendix A: Comms Task Configuration
Insight communicates with panels via an Insight comms task. This comms task must be CT001
in the panel.
To configure the Insight comms task:
1. Using an elite terminal, log in with the Installer PIN and go to menu 7-3-1 (comms
tasks).
2. If your panel is using factory settings (or the panel has been defaulted) then CT001 will
be set to Insight. In this case, you will only need to adjust the settings in red.
3. Press help > 9, and change the panel ID to a unique, non-zero value. The first two digits
should be 00. The value you enter here must match the number assigned in the Insight
front-end software (see pages 28 and 39).
4. Leave all other settings on their defaults, which are listed below:
1

Panel ID = 00xxxxxx (*)
Port: 1
Baud: 9600 (*)
Opts NUIP = ....nnnn
Ethernet = ..…ACE

For direct serial connections: if you are using a
DTR/DSR comms cable, you can set opts to nYnn.
This stops phantom mouse detection on older
PC’s. Most cables do not have DTR/DSR
connected, and will not work with this option.
For Ethernet UART only. If you don’t intend to use
an Ethernet UART, set these flags to nnn.

RS232 = ..…ACE
FE3000 = ..…ACE
2
Ext. Mod = ..…nnn
Int. Mod = ..…nnn
Insight IP: see below
Insight Key1: 0
Insight Key2: 0
IPFast IP: 0.0.0.0
IPFast Key1: 0
IPFast Key2: 0
Panel IP: see below
Router IP: see below
Subnet Msk: see below
CT001 Announce Port: 17185
Max Attempts: 0

If you don’t intend to use this connection type, set
these flags to nnn.
If you are using the internal modem, set these
flags to ..…ACE and configure an I-modem task.
To secure your installation, set these to random
values. They must match the settings on page 37.

(*) Insight requires these settings to enrol the panel. Note them down.
Insight IP is the static IP address of the Insight Server computer. If you aren’t using the
Ethernet or FE3000 connection paths, leave this as zero.
Panel IP is the static IP address of the panel. If you aren’t using the Ethernet or FE3000
connection paths, or if you want the panel to obtain an IP address from a DHCP server,
leave this as zero.
Router IP is the static IP address of the local router or gateway. If you aren’t using the
Ethernet or FE3000 connection paths, leave this as zero.
Subnet Mask is the TCP/IP subnet mask for the local network. If you aren’t using the
Ethernet or FE3000 connection paths, leave this as zero.
1

Pick a random or sequential number for each panel. The number must be unique for all panels
in your Insight installation.
2
Control Module firmware prior to V6.0 doesn’t support an external modem connection with
Insight.
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5. Make CT001 idle then active.
To configure the I-modem comms task:
1. Change CT002 from active to idle
2. Change CT002 to I-modem
3. Press help > 9, and make sure the following settings are selected:
Rings to answer = 15
Ans. Options = nnnnnn..
Line Test Time = 0
Insight # = None
IPFast # = None
ISP Accnt =
ISP Passwd =
Dial = nnnnnnnn
PABX No. = None
Back No. = None
Cust No. = None
Seize Aux =
Single DTMF Tone =
Line Test Count = 0

For timed fax bypass, set these options to
nnnYnnn..
If you want the panel to dial Insight when there is
an alarm, set this to the phone number of the
Insight Server computer.

4. Make CT002 active.
5. In CT001, make sure Int. Mod = ..…ACE and restart CT001.
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Appendix B: Upgrading the Database to SQL Express 2005
This appendix applies to installations that are upgrading to Insight V3.2 or higher from a
previous version of Insight (V3.1x or earlier).
Prior to V3.2, Insight Professional used MSDE (Microsoft Server Desktop Engine) SQL as the
default database platform. This limited the maximum database size to 2 GB of data.
Commencing with V3.2, Insight ships with MS SQL Express 2005 which is used in new
installations. If upgrading from an earlier version of Insight, the installer will retain the previous
database (either MSDE or SQL Server).
Since MS SQL Express 2005 allows a database limit of 4 GB and is compatible with MS Vista,
some installations that are upgrading to Insight 3.2 may benefit from upgrading the database
platform to SQL Express 2005.
To Upgrade from Insight 3.1 (or earlier) to Insight 3.2 (or higher) and use SQL Express
2005:
1. Before installing Insight 3.2, use the Insight Archiver SQL module to back up the Insight
database
2. Remove MSDE (Microsoft SQL Server Desktop Engine) completely using Add or
Remove Programs from the Windows Control Panel (Start→Control Panel→Add or
Remove Programs)
3. Install the new version of Insight, following all the prompts
4. Restore the Insight database which was backed up in step 1

Note
The Insight installer will prompt the user that SQL Server 2005 will be installed to run under a
particular account (usually, “NT AUTHORITY\Network Service”) and that the account needs
access to the Insight installation folder. The user should answer “Yes” to the dialog.
Note
If the previous version of Insight was set up to have its database back ups stored to a location
outside the Insight installation folder, then the “NT AUTHORITY\Network Service” account on
the Insight ‘server’ machine needs to have full access to the location the Insight database back
ups are kept in
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